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Third Party Systems

The software is designed to run in an environment containing third party elements meeting
certain prerequisites. These may include operating systems, directory services, databases,
and other components or technologies. See the accompanying prerequisites list for details.

The software may require a minimum version of these elements in order to function. Further,
these elements may require appropriate configuration and resources such as computing,
memory, storage, or bandwidth in order for the software to be able to perform in a way that
meets the customer requirements. The download, installation, performance, upgrade, backup,
troubleshooting, and management of these elements is the responsibility of the customer
using the third party vendor’s documentation and guidance.

Third party systems emulating any these elements must fully adhere to and support the
appropriate APIs, standards, and protocols in order for the software to function. Support of the
software in conjunction with such emulating third party elements is determined on a case-by-
case basis and may change at any time.
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About This Guide

About This Guide

This administration guide is written to provide the conceptual and procedural information for
managing network-stored unstructured data using File Dynamics 26.2.

Audience

This guide is intended for network administrators who manage user and collaborative network
storage resources.






1 - Overview

1 - Overview

File Dynamics is a product designed to address the ever-changing definition and requirements
of network data management. With File Dynamics, you have the means to not only provision,
manage, and dispose of network storage, but also to rectify the location of sensitive files,
monitor and enforce file system permissions located on high-value targets within the network
file system, and much more.

File Dynamics performs network file system management tasks standard Microsoft network
components such as the Active Directory, along with added components. All of these are
summarized in the links below.

1.1 - The Directory Service

Microsoft Active Directory stores the identity information about the users and groups that File
Dynamics manages. When File Dynamics is installed it adds or modifies user and group
attributes so that they can be managed through File Dynamics.

1.2 - Directory Service Events

When a user in Active Directory is added, moved, renamed, or deleted, it is known as a
directory “event.”

1.3 - Identity-Driven Policies

Identity-Driven policies within File Dynamics indicate what user or group actions to enact when
an event in Active Directory takes place or a Management Action is invoked by an
administrator.

Automated actions include creating user or collaborative storage when a new user is added to
Active Directory, moving storage when a user is moved from one organizational unit or group
to another, and archiving or deleting storage when a user is removed.

Examples of invoked Management Actions include retroactively applying policies,
permissions, attributes, and quotas to existing user storage, or performing some
administrative corrective action or operation on a large set of users, groups, or containers.

File Dynamics lets you create the following types of Identity-Driven policies:

¢ User Home Folder: Manages the life cycle of the users’ home folder from the create,
rename (name change), move (change in departments), and delete (deprovisioning
with vaulting).

« User Profile Path: Manages the users’ Windows profile path.

+ User Remote Desktop Services Home Folder: Manages the users’ remote desktop
home folder.

+ User Remote Desktop Services Profile Path: Manages the users’ remote desktop
profile path.

» Container: Manages storage for all of the users in an Active Directory container.
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1.4

Group: Manages storage for an Active Directory group.

Auxiliary: Manages one or more additional storage locations in association with one of
the four user policy types.

Multi-Principal Group Storage: Allows for multiple groups to access a shared group
folder, with each group having different sets of permissions to the group folder.

- Target-Driven Policies

Through Target-Driven policies, File Dynamics performs management tasks through policies
associated directly with a network share or folder. Target-Driven policies include Data
Location policies, Content Control policies, and Workload policies.

Data Location Policies: These policies are the means of copying folders and their
contents to a target parent folder. There is an option to remove the files from the source
location after they have been copied. For example, if you were doing a server
consolidation or moving data from a server to a NAS device (or vice versa), you could
easily do so using Data Location policies.

Content Control Policies: Similar to Identity-Driven file grooming, Target-Driven
Content Control policies remove files according to file type, age, size, last accessed
date, and more. From any file path, you can either vault files to a new location or delete
the files altogether. For example, you could use this feature to easily delete temporary
files and, in the process, make much more disk space available on your storage
devices.

Workload Policies: These policies provide the ability to import externally-generated
files, such as security reports from OpenText File Reporter, and then rectify the location
of sensitive files for regulatory compliance or optimization.

Security Notification Policies: These policies enable administrators to be notified of
any changes in access permissions to high-value targets paths. These changes in
permissions include a user being given a new or updated permission to a specific
folder, or a user being granted access permissions to a folder by being added to a
group. Access permission updates are determined by the Phoenix Agent through a
scheduled scan. Notifications are sent to administrators via email or viewed through the
Data Owner client interface.

Lockdown Policies: Once you have established the proper access permissions for a
high-value target, you can establish the baseline of access permissions for the target
path that will be strictly enforced through a Lockdown policy. When unauthorized
access permission changes are made to the target path or any of its subfolders, the new
permissions are removed and the original permissions are restored.

Fencing Policies: These policies let you set limits on how access permissions may
change over time. Using a set of criteria to define a “fence,” the policy specifies Active
Directory containers, users, or groups that might conceivably be given permissions to a
high-value target path in the future without an issue or should never be given
permissions in the future.
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1.5 - Engine

The Engine performs actions based on events in Active Directory and the defined File
Dynamics policies. These actions include provisioning, moving, grooming, deleting, renaming,
and archiving and recovering files and permissions. There is only a single Engine per forest
and it can be installed on a domain controller or a member server. The Engine runs as a
service on Windows.

1.6 - Event Monitor

The Event Monitor monitors changes to Active Directory based on create, move, rename,
delete, add member to group, and delete user from group events. You install one Event
Monitor per domain, and it can run on a domain controller or a member server. If you install the
Event Monitor on a domain controller, the Event Monitor always monitors the local server for
changes in the domain. If the Event Monitor is installed on a member server, it identifies the
closest available domain controller and monitors it for changes in the domain. The Event
Monitor runs as a service on Windows.

1.7 - File System Agents

File System Agents perform copying, moving, grooming, deleting, and vaulting through
directives from the Engine. For optimum performance, Agents should be installed on all
servers with storage managed by File Dynamics. The File System Agent runs as a service on
Windows.

1.8 - Phoenix Agents

The Phoenix Agent is responsible for all security scanning and remediation required by the
Security Lockdown and Security Fencing policies. The Phoenix Agent runs as service on
Windows.
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2 - Using the Admin Client

The Admin Client is the administrative interface for File Dynamics. Most management tasks
run from this easy-to use Windows application. The Admin Client requires .NET 10.0 which is
installed automatically on the Windows workstation or server during the Admin Client
installation.

If you have not yet installed the Admin Client, install it before proceeding with this section. See
Installing the Admin Client in the File Dynamics 26.2 Installation Guide for instructions.

For detailed information on the interaction between the Admin Client and the database, review

2.1 - Launching the Admin Client

1. Double-click the File Dynamics 6 Adminicon from the Windows desktop.

2. An authentication dialog box appears.

opentext” | File Dynamics

Engine | | Port| 0 :|

User Name | |

Password | |

| Login | | Cancel

Use system proxy settings

3. Inthe Enginefield, specify the DNS name or IP address where the Engine service is
installed.

In the Portfield, specify the secure port number.
The default setting is 3009.
Specify the username and password.

The user must be a member of the File Dynamics Admins group to be able to log in.

©® N o o A

Click Login.

2.2 - Using the Admin Client Interface

The Admin Client interface has multiple tabs. Clicking each tab displays an associated toolbar
directly below the tabs. The toolbar is divided into sections based on the actions that are
available. Clicking a tool displays data or an interface for performing a management task.

The default display is the Status page from the Home tab, which is discussed in detail in the
Reference (page 151) chapter of this guide.
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i O

Status  Runtme  Path Analysis Scheduled
Config Report Tasks

Tools
EL status

General

Managed Forest:  sp.cctec.org

Current Engine Time: 3/24/2023 5:26:31PM
Engine Start Time:  3/24/2023 L:53:52PM
o LicenseType:  Production

License Expires: 2/24/2033

License Features:

- Core Product

- Epoch Data Protection
- Security

- Workload

Systems
1. Global Statistics Collector

Global Statistics collector has never been run

+ Storage Resources
Last Update Duration: 00:01:24
Last Update Time: 3/23/2023 11:58 AM
Next Update Time: 3/25/2023 12:00 AM

+ Work Log

Version: 6.6,0.22

D

Storage  Forest
Resources Trusts

Assets

[« @ © [

Agents  Event Event  Check
Monitors Scope  Updates.

Components

Event Monitors

Total Event Monitors: 1

+ Authorized: 1

Last Event Received: Not available
Unparsed Pending Events: 0

+ Accepting Events

+ Processing Events

O File System Agents
Total File System Agents: 1
+ Authorized: 1
Active Copy Jobs: 0
Active Delete Jobs: 0

Active Vault Jobs: 0

Queues

User: 5P\Administrator Engine Address: 172.17.3.103

Phoenix Agents

Total Phoenix Agents: 1
+ Authorized: 1

Active Epoch Cleanup Jobs: 0

Active Epoch In

Active Epoch Recovery Jobs: 0

Active Epoch Scan Jobs: 0

~

Engine Version: £.6.0.21

tegrity Check Jobs: 0

™\, Identity-Driven

Target-Driven

Identity-Driven

=y, Deferred

Target-Driven

" Complete

All other File Dynamics tools are covered in the other sections of this guide.



3 - Event Monitor Scoping

3 - Event Monitor Scoping

The Event Monitor scope identifies the portions of an Active Directory environment that are
relevant for event monitoring purposes. You can define a scope using Include and Exclude
lists to limit events only to appropriate containers and groups.

3.1 - Include and Exclude Scopes

You can define an Event Monitor scope by adding container and group objects to the Include
and Exclude lists. By default there are no entries in either list so each domain and all of its
objects are implicitly included where you have installed and configured an Event Monitor.

The following rules govern the behavior of items in the lists:

¢ Adding a container to a list affects all descendents of that container's subtree, not just
immediate child objects.

 If the scope is defined only by container Includes, the remainder of the AD domain is
implicitly excluded.

 If the scope is defined only by container Excludes, the remainder of the AD domain is
implicitly included.

e You can only add groups to the Exclude list.

¢ Rules only apply within the context of a single domain. You may need to add additional
rules for other domains to achieve the desired scope.

items in the Exclude list, but the Event Scope does not support the opposite.

Fﬁi NOTE: You can override entries in the Include list by specifying subordinate
You cannot override entries in the Exclude list.

3.1.1 - Include

The Include list provides a means for creating a whitelist for the specified objects. Anything not
contained within the Include list is implicitly excluded.

Containers

Add containers to the Include list to limit the scope to those containers and their subordinate
objects.

3.1.2 - Exclude

The Exclude list provides a means for creating a blacklist for specified objects. Anything not
contained within the Exclude list is implicitly included.

Containers

Add containers to the Exclude list to prevent event reporting for those containers and their
subordinate objects.
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Groups

Add groups to the Exclude list to prevent event reporting for those groups.

prevent monitoring of that groups membership. The same applies to group

|l:§ﬂr NOTE: Setting the Event Scope to exclude either a group or its members will
managers.

3.2 - Container Restrictions
3.2.1 - Allowed Container Types

Only the following container class types are permitted for Include and Exclude scopes:

e container

e country

¢ locality

e organization

e organizationalUnit

3.2.2 - Operational Containers

Certain operational portions of an AD domain are considered to be off-limits for event
monitoring activities. These portions of an AD domain will always be excluded from
consideration for event monitoring purposes regardless of the scope.

The Event Monitor never monitors activity in the following Active Directory containers:
e Builtin
¢ Foreign Security Principals
¢ Lostand Found
¢ Managed Service Accounts
e NTDS Quotas
e Program Data

e System



3.3 - Configuring the Event Monitor Scope

1. Inthe Admin Client, click the Home tab.

2. Click Scope.

Identity-Driven Target-D

s
Check
Updates

3 - Event Monitor Scoping

~

User: SP\Administrator Engine Address: 172,17.3.103
Engine Version: 6.6.0.22

18- on
E B O 8AHOA®
Status  Runtime Path Analysis Scheduled — Storage Forest Agents  Event Event
Config Report Tasks  Resources Trusts Monitors  Scope
Tools Assets Components
@ Event Scope
H save
v /A sp.ectecorg Include
> fa Builin
> T Computers == Remove
> g Domain Controllers ‘Obje:t
> Tg ForeianSecurityPrincipals T OU=5P,DC=sp,DC=cetec,DC=0rg
> T Keys
> g Managed Service Accounts
> T2 Program Data
» Tg Service Accounts
v T s
> g Atianta
» T HQ
> g London
» T Munich
» T NYC ude
> g sF0 = Remove
5 Tz Specil Groups Object
» Tz System
> g Users
Version: 6.5.0.28

3. Inthe Scope pane, click the arrow to view the Active Directory containers.

v /\ sp.cctecoorg

> Builtin
Computers
Domain Controllers
ForeignSecurityPrincipals
Keys
Managed Service Accounts
Program Data
Service Accounts

L

Atlanta

HQ

London
Munich

NYC

SFO

Spedial Groups
System

Users

BEDBRT v v v v v v v BED R 650 &RD gED o650 AR ge” gEP
B ° 60 GRS G0 gE0L

4. Drag to containers, subcontainers, and groups you want to include or exclude into the
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Include and Exclude panels respecitively.

Action Result

The Event Monitor will only report on the
Drag one or more containers to | selected containers and their subordinate
the Include pane. objects and ignore all other objects in the
domain.

The Event Monitor will ignore the selected
Drag one or more containers or | containers, their subordinate objects and
groups to the Exclude pane. selected groups, but continue to process events
for other objects in the domain.

5. Click Apply.

3.4 - Example Scenarios

The following are example scenarios of Event Monitor scoping that might help you configure
your Event Monitor scope.

3.4.1 - Include Scope

In the following example the Event Monitor will monitor only the events that belong to the
OU=SP container or any of its descendants.

10



Container Specified for Include

Identity-Driven Target-Driven Configuration
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IE-
B O L4 Q@ @
B D —— 0 a‘ I o |
Status Runtime Path Analysis Scheduled Storage Forest  Agents Event  Ewvent Check
Config Report Tasks Resources Trusts Monitors Scope  Updates
Tools Assets Components -
User: SP\Administrator Engine Address: 172,17.3,103
@ Event Scope
Engine Version: 5.5.0.22
I save
v /\ sp.cctec.org Include
> g Builtin
N 'fg Computers == Remove
» g Domain Contrallers |Ohjett a
> g ForeignsecurityPrincpals = | DU=5P,DC=sp,DC=cctec,DC=0rg
> Ta Keys
» g Managed Service Accounts
» T2 Program Data
> g Service Accounts
v g isp
> g Atanta
> s HQ
> T London
> Tg Munich
> g nNrC
> g sFo == Remove
> g Spedal Groups Object "
» Tg System
¥ ntg Users
Version: 6.6.0.28

3.4.2 - Exclude Scope

In the following example the Event Monitor will monitor all containers except for the
OU=London,OU=SP subcontainer and its descendants.

11
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Container Specified for Exclude

IE- v arg ver C
g r
B REB B O 240 Q@ [
Status Runtime Path Analysis Scheduled Storage Forest  Agents Event  Ewvent Check
Config Report Tasks Resources Trusts Monitors Scope  Updates
Tools Assets Components -~
User: SP\Administrator Engine Address: 172,17.3,103
@ Event Scope B B
Engine Version: 5.5.0.22
I save
v /\ sp.cctec.org Include
> g Builtin
N 'fg Computers == Remove
» T3 Domain Contrallers Object a
3 'fg ForeignSecurityPrincipals
> Ta Keys
» g Managed Service Accounts
» T2 Program Data
> g Service Accounts
v g s
> g Atanta
> B H
> e lLondon
> Tg Munich Exclude
> g nrc
> B sFo == Remove
> g Spedal Groups |ObjE:t "
> ntg System Tg 0OU=London,0U =5P,DC=sp,DC =cctec,DC=o0rg
¥ ntg Users
Version: 6.6.0.28

3.4.3 - Include and Exclude Scope

In the following example the Event Monitor will only monitor the CN=Users and OU=SP
containers and their descendants except for descendants of the
OU=Groups,OU=Munich,OU=SP subcontainer.

12



Containers Specified for Include and Exclude

o B & O

Status Runtime Path Analysis Scheduled

24404 00 E

Storage Forest  Agents Event  Ewvent Check

3 - Event Monitor Scoping

~

v.,
B v v v
H
g
3

Users

Config Report Tasks Resources Trusts Monitors Scope  Updates
Tools Assets Components
User: SP\Administrator Engine Address: 172,17.3,103
@ Event Scope
Engine Version: 5.5.0.22
I save
> A sp.cctec.org Include
> g Builtin
N 'fg Computers == Remove
» g Domain Contrallers |Ohjett a
» g ForeignsecurityPrincipals Tz | CN=Users,DC=sp,DC=cctec,DC=org
> o Keys T | OU=5P,DC=5p,DC=cctec,DC=o0rg
» g Managed Service Accounts
» T2 Program Data
> g Service Accounts
M-
> g Atanta
> ko
> T London
~ g Munich
5> Tz Employees
> g |Groups == Remove
Ty e [ object -
= sFo
Tg 0U=Groups,0U=Munich,0U=5P,DC=sp,DC=cctec,0C=org
= Spedal Groups

Version: 6.6.0.28
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4 - Managing Existing User Storage

Because File Dynamics is deployed into an existing Microsoft network with users, groups,
containers, and domains already established in Active Directory, your principle focus should
be to start managing the storage that is assigned to these users. This process involves several
tasks:

¢ Running reports to determine the status of your user storage
¢ Creating policies that standardize the storage allocation, quota, rights, and more
¢ Testing these policies to verify that they are working as desired

¢ Running Management Actions to invoke the policies settings on the existing users

By completing this section, you not only put your existing users’ storage into a managed state
and set it up for ongoing management through File Dynamics, but you also learn the basic
procedures for reporting and for setting user policies. After completing the procedures in this
chapter, refer to the remainder of the File Dynamics 26.2 Administration Guide for more
detailed content on these tasks as well as many others.

4.1 - Running Consistency Check Reports on Existing
Storage

When File Dynamics is installed, you need to analyze and correct any issues that might exist
in the current user storage environment. Issues might include missing storage quotas,
inconsistent home folder attributes, inconsistent home folder permissions, missing home
folders, and inconsistent file paths. Storage analysis begins by running consistency check
reports on existing user storage prior to creating and implementing storage policies.

In addition to reporting on storage issues, consistency check reports let you review current
quota assignments and can help you in designing and planning storage policies.

1. Inthe Admin Client, click the Identity Driven tab.
2. Click Identity Objects.

In the left pane, browse through the domain so that an organizational unit with the users
you want to generate the consistency check report is displayed in the right pane.

In the left pane, right-click the container and select User> Consistency Check.
Click Execute and view the results in the bottom panel.

Click the * to expand the view.

N o o A

Because none of the users are currently managed through File Dynamics, each user
has a Management status of Not Managed. Additionally, there are no established
storage quotas and there might be inconsistent directory attributes, permissions, flags,
and file paths, along with various warnings or errors that you can mouse over to view
the specifics.

8. To export a consistency check report for printing, see Consistency Check (page 189).
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4.2 - Assigning Missing Home Folder Attributes

The consistency check report’s DS Path column indicates the path (also referred to as
“attributes”) of the user’s assigned home folder. If no path is indicated, it is because the home
folder attribute is not set in Active Directory.

File Dynamics allows you to populate any missing home folder attributes or correct attributes
that are not configured correctly. You do this by selecting a path and looking for a match on
each user’s ID. You also have the option to overwrite an existing attribute based on a match
found.

If no home folder exists for the user, File Dynamics can create one automatically once the
target path for the home folder is indicated in the policy. For more information, see
Standardizing User Home Folder Attributes (page 17).

1. Inthe Admin Client, click the /dentity Driven tab.
Click Identity Objects.

In the left pane, browse through the domain so that an organizational unit with users
that need home folder attributes appears in the right pane.

In the right pane, select the desired container.

5. Click User> Assign Managed Path.

Management Action - User Mode = O K
Q Preview P Execute & User Mode ~ Consistency Check F‘; Management Action = G Refresh Results

Assign Managed Path Targets (1)

P —— = = Add == Remove | [+] Select Al

| | FDN

(®) Assign if associated path attribute not st ?g OU=Employees, Ol=Atlanta,0U=SP,DC=sp,DC...
(_ Assign if associated path attribute not set or specified location not found on disk
() Always overwrite assodated path attribute

Explicit Path Assignment

D Explicit Assignment {only warks with single object)

Target Path
Parent Path | | Browse | | Clear | E
Path Types
(#) Home Folder () Remote Desktop Services Home Folder ﬁ
(_ Profile Path (1 Remote Desktop Services Profile Path
Process Subcontainers Mask | |

Add to Targets | Selected ltems: 0

I:‘ | Name - | Path Type | Action Status
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In the Matched Path Assignment region of the window, make sure the Assign if
associated path attribute not set option is selected.

Click Browse, use the Path Browser dialog box to browse to the path where you want all
home folders in the selected organizational unit to reside, then click OK.

8. The selected path appears in the Parent Path field.

9. Inthe Targets region, click Add.

10.

11.
12.
13.
14.
15.
16.
17.

18.

Use the Directory Services Browser to locate and specify the container where the users
who will be assigned a managed path are located.

Click Preview.

Preview allows you to view the results of the action, without actually making changes.
Click * to expand the view.

File Dynamics summarizes any problems it can resolve in the Action column.

Click Vv to collapse the view.

If you approve of the actions File Dynamics took in Preview mode, click Execute.

Run a new consistency check report by selecting the organizational unit you selected in
Step 4, clicking Consistency Check, then clicking Execute.

Observe that all users now have home folder attributes listed in the DS Path column.

4.3 - Standardizing User Home Folder Attributes

As a best practice, you should have all of your user home folder attributes set to a path that
ends with the user’s home folder name, rather than the parent path. For example, instead of
user EBROWN having a home folder attribute of \\ SERVER-DNS-NAME\ SHARE -
NAME\HOME\USERS, it should be set to \ \ SERVER-DNS-NAME\ SHARE -
NAME\HOME\USERS \EBROWN.

File Dynamics lets you easily standardize home folder attributes by overwriting attributes
linked to the parent path.

1.

In the Admin Client, click the Identity Driven tab.

2. Click Identity Objects.

3. Inthe left pane, browse through the domain so that a container with users that need

standard home folder attributes appears in the right pane.

In the right pane, right-click the desired organizational unit and select User> Assign
Managed Path.

5. Select the Always overwrite associated path attribute option.

6. Click Browse, use the Path Browser dialog box to browse to the path where you want all

home folders in the selected container to reside, then click OK.

7. Click Preview.

8. Click A to expand the view.
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9. File Dynamics summarizes any problems it can resolve in the Action column. Resulting
home folder attributes that are created will be displayed as “Match found. Managed
Path would be set.”

10. Click v to collapse the view.
11. If you approve of the actions File Dynamics took in Preview mode, click Execute.

12. Run a new consistency check by selecting the organizational unit you selected in Step
4, clicking Consistency Check, then clicking Execute.

13. Observe that all users who did not previously have proper home folder attributes, now
do.

4.4 - Creating a Blocking Policy

File Dynamics provides the ability to create “Blocking policies” that block other File Dynamics
policies from affecting members of organizational units, members of groups, or even individual
users. For example, you might have proxy users such as a BACKUP PROXY or VIRUS SCAN
PROXY who do not need a home folder. Or, you might have an organizational unit within an
organizational unit whose members you do not want to be assigned home folders.

Creating a Blocking policy is as easy as creating a group, adding the users you want to block
from a policy to the group, and then using the Admin Client to create the Blocking policy and
associate it to the group.

Blocking policies can be assigned to users, groups or containers.
1. Inthe Admin Client, click the Identity Driven tab.
2. Click Policies.
3. Inthe Manage menu, select New > User Home Folder.
4

. The following dialog box appears:

Create New Policy

MName | | |

Paolicy Type | User - |

Managed Path Type |Home Folder - |

5. Specify a descriptive name in the Name field, such as “Block Policy,” leave the User
and Home Folder options selected, then click OK.
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The Policy Options page appears.

Identity Policy Editor - Blocking Policy = O K
Opti
General G i
|| Process Events for Associated Managed Storage G This policy is now a Blocking Policy.
v Policy Options
<§’ Assodations
Policy Inheritance

== Auiliary Polices
Policy applies to subcontainers
SEtup Policy applies to nested group members

« Provisioning Opti Palicy Weight

_: Target Path Opti
Descripti
m Quota Options =

G) Move Schedule Policy created at 3/24/2023 5:41 PM by SP\Administrator

Cleanup

[Tj Cleanup Options
@ Vault

3 Groom Characters Allowed: 1023 Characters Remaining: 968
Other
Motes

E’bo Summary
E“ Copy Policy Data

oK ‘ ‘ Cancel | | Apply

1. Changes to this policy have not been saved.

Deselect the Process Events for Associated Managed Storage check box.

8. A description at the right of the check box indicates that the policy is now a Blocking

10.
11.

12.
13.

policy.
In the left pane, click Associations.
Click Add.

Browse down and locate the user, group, or container that you want to block from the
effects of File Dynamics Identity-Driven policies, then drag it to the Selected Iltems
pane.

Click OKto select the objects.
Click OKto save the Blocking policy.

4.5 - Creating a User Home Folder Policy

A policy in File Dynamics is the means by which the product provisions, manages, deletes,
and archives storage. The parameters within an Identity-Driven policy dictate where user
storage is created, what permissions are granted, what quota to assign, what to do when a
user is deleted, and much more.

Only one Identity-Driven policy of the same type can be associated with an organizational unit,
group, or user.

19



4 - Managing Existing User Storage
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o bh =

In the Admin Client, click the Identity Driven tab.
Click Policies.
In the Manage menu, select New > User Home Folder.

The following dialog box appears:

Create New Policy

Name | | |

Policy Type | User 4 |

Managed Path Type |Home Folder - |

Specify a descriptive name for the policy, such as “London Users,” then click OK.

The Policy Options page appears.

Identity Policy Editor - London Users = O *

General Policy Options

Process Events for Associated Managed Storage
“ Policy Options

6’ Assodations
Policy Inheritance
== Auxiliary Polices

Policy applies to subcontainers
SEtup Policy applies to nested group members

4 Provisioning Opti Palicy Weight

T TargetPath Opti
m Quota Options

G—) Maove Schedule Policy created at 3/24/2023 5:43 PM by SP\Administrator

Cleanup

ﬁ Cleanup Options

@ Vault

¥ Groom Characters Allowed: 1023 Characters Remaining: 968

Other

Motes
E‘ho Summary
E Copy Policy Data

-

Set the Policy Options specifications for the policy:

a. If you want the container’s subcontainers to inherit the policy settings, leave the
Policy applies to subcontainers check box selected. Otherwise, deselect it.

b. If you will have users that are members of multiple groups, which means they
could be affected by multiple policies, use the Policy Weight field to indicate a
weight for this policy.



C.

d.

4 - Managing Existing User Storage

When multiple policies pertain to a user, File Dynamics uses the highest weight
number to determine which policy to apply.

Click Apply to save your settings.

8. Set the associations:

a.
b.

C.

d.

In the left pane, click Associations.
Click Add.

Browse to and locate the organizational unit, group object, or user object you
want the policy applied to, then drag it to the Selected Object pane.

Click Apply to save the settings.

9. Set the provisioning specifications:

a.
b.

f.

Click Provisioning Options.

In the Folder Properties region, specify the settings to be for the permissions you
want applied to network home folders that are created through this policy.

In the Template Folderregion, click the Browse button to locate and place a path
to a template directory that can be copied into each home folder.

For more information on templates, see Setting Provisioning Options (page 32).

In the Home Folder Options region, indicate the network drive letter to assign to
your users.

Click Apply to save the settings.

10. Set the target paths:

a.
b.

In the left pane, click Target Path Options.

Click Add, browse to the share where you want your home folders to reside, right-
click and choose Selectto add the target path to the Selected Paths pane.

-OR-

Drag and drop the target path to the Selected paths pane.

If you want to set the location of home folders among different paths, repeat Step
8b to include all the paths you want.

If you have multiple paths listed, select a distribution method from the Distribution
drop-down list.

For an explanation of storage distribution, see Setting Target Paths (page 34).

Leave the other fields as they are currently set.

Click Apply to save your settings.
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11.

22

Set the quota options:

a.

b.

b.

In the left pane, click Quota Options.

Identity Policy Editor - London Users = u] X

Quota
General
Enabled

¥ Policy Options O

& Assodations T

= Ausdliary Polices Quota ]
Setu|

p ‘Quota Management

& BETIETLIER [ Enable Guota Manager j Ouot Preservation for this poiicyl

7 TargetPath Opt.. -

- ‘Quota Maximum Quota Increment

m Quota Options
(D Move Schedule No Maximum Quota Set Quota Increment Manually
Maximum Quota II| VB Increment Quota by VB

Cleanup

T Cleanup Options Quota Managers

& vault

Add == Remove

¥ Groom
Other

Notes

[ summary

E\ Copy Palicy Data

oK || Cancel || Apply |

i, Changes to this policy have not been saved.

In the Quotaregion, click Enabled and specify the amount of initial storage space
to be allocated to all users associated with this policy.

In the Quota Management region, click the Enable Quota Manager / Quota
Preservation for this Policy check box, to display additional options.

Select one of the following Quota Maximum options:

Use the No Maximum Quota option to specify that the users managed by this
policy will be granted additional storage quota when they need more.

Use the Maximum Quota field to specify the maximum amount of storage that is
allocated to a user. This allocation comes through the quota increment settings
below.

Select one of the following Quota Increment options:

Select the Set Quota Increment Manually option to allow users who are
designated as quota managers to set quotas manually.

Select the Increment quota by option to indicate the size in MB for each new
allocation of additional storage quota.

In the Quota Managers region, click Add and specify users who will serve as
quota managers.

Click Apply to save your settings.
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12. Setthe move schedule:
a. Inthe left pane, click Move Schedule.
b. Specify the hours when File Dynamics can perform data migrations.

c. Formore information on movement of data between multiple policy paths, see
Setting the Move Schedule (page 38).

d. Click Applyto save the settings.

13. Set the cleanup options:

a. Inthe left pane, click Cleanup Options.

Identity Policy Editor - London Users [m] X
Storage Cleanuy
General "
|:| Enable 1, No deanup rules are currently set for this policy.
‘f Policy Options
Cleanup storage 7 after a deanup event,
& rsocatons - = :
o 1@ # value of zero (0) days will deanup immediately. Vault on Delete will not take place.
Audliary Policies
Setup Vault On Delete
+ Provisioning Opti [ Enable
T Target Path Opti... Vault Path
m Quota Options
I Browse Clear
(©) Mave Schedule
) Groom and Vault rules share the same vault path.
Cleanup
T Cleanup Options
& vault
¥ Groom
Other
Notes
[ summary
Efy Copy Policy Data
0K | | Cancel | | Apply
I, Changes to this policy have not been saved.

b. Inthe Storage Cleanup region, select the Enable check box to indicate if you
want user storage associated with this policy deleted when a user is removed
from Active Directory.

c. Ifyou select the check box, you can specify the number of days a user home
folder and its contents will remain before it is deleted.

d. If you want user storage associated with this policy vaulted, in the Vault on Delete
region, select the Enable check box and use the Browse button to indicate a path
to the vault location.

e. Click Applyto save your settings.

If you have both Storage Cleanup and Vault on Delete enabled, File Dynamics
vaults the data and then deletes it after the specified period of time. If you have
Vault on Delete but not Storage Cleanup enabled, File Dynamics vaults the data
immediately and never cleans it up.
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14. Setthe vault rules:

a.

In the left pane, click Vault.

b. Click Addto create vault rules.

C.

d.

Rule Editor X

Description | Vault

Action (e Files () Folders

Masks | = tmp]

* Only one Mask per line

Comparative Criteria Numeric Criteria Unit
File Size Filter | Disabled] - Any Size - | |[ " Reset |
Create Time Filter | [Disabled] - Any Size -1 E| || Reset |
Madify Time Filter | [Disabled] - Any Size -1 E| || Reset |
Access Time Filter | [Disabled] - Any Size -1 E| || meset |
[ o | | Cancel |

For example, in the rule above, all . tmp files are deleted prior to their home
folder being vaulted. When the specified number of days in the Cleanup storage
afterfield has passed, the home folder is deleted from the specified vault
location.

Click Apply to save your settings.

15. Setthe groom rules:

24

a.

b
C.
d

In the left pane, click Groom.
Click Add.
This brings up the Rule Editor dialog box.

Select either Vault, Delete, or Ignore from the Action drop-down menu to specify
whether to vault, delete, or ignore files or folders.

In the File Name Mask field, indicate the type of file or the name of a folder for
which this groom rule will take action. For example, * .mp3 and * .mp4.
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f. If you choose to vault files, you must have a specified vault path in the Vault Path
field of the Vault Rules page.

Rule Editor X

Description |Music Grooming Rule

Action () Files () Folders

Masks | =mp3
=mp4|

* Only one Mask per line

Comparative Criteria Mumeric Criteria Unit

File Size Fiter | [Disabled] - Any Size -1 E| || Reset

Create Time Filter | [Disabled] - Any Size - | | | | | | Reset

0
Madify Time Filter | [Disabled] - Any Size -1 E| || Reset
0

Access Time Filter | [Disabled] - Any Size - | | | | | | Reset

| oK | | Cancel |

g. To narrow the scope of the groom rule, you can use the filter settings in the lower
portion of the dialog box.

h. Forexample, if you select Greater than from the File Size Filter drop-down menu,
enter 2 as the Numeric Criteria, and select MBs as the Unit setting, the groom
rule in this example vaults all MP3 and MP4 files greater than 2 MB. Setting
additional filters narrows the scope of the grooming action even more.

i. Click OKto save the groom rule.
j. Repeat Step 13a through Step 13e to create additional groom rules.
k. Click Apply to apply the groom rules.

16. Click OKto save the policy settings.

4.6 - Removing a Preexisting Process for Creating User
Home Folders

When you create and configure a policy, it is important to understand that File Dynamics is set
up to provision and manage all new users that are created in the associated container.

If you have a network tool such as Microsoft Active Directory Users and Computers creating
home folders, when a new user is added to the organizational unit or group associated with a
policy, you need to remove the setting that creates the home folder.

4.7 - Testing the User Home Folder Policy

You should now create a test user to confirm that File Dynamics will provision and deprovision
the test user’'s home folder according to the policy rules that you created.
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10.
1.

]

12.

. Use Active Directory Users and Computers to create a new user such as TESTUSER in

the organizational unit associated with the policy you configured in Creating a User
Home Folder Policy (page 19).

2. Inthe Admin Client, click the Engine tab.
3. Click Path Analysis.
4. Inthe left pane, browse down to the location where the new home folder for the new

TESTUSER is located.

5. Select the TESTUSER home folder, then select Permissions.
6. This displays the View Permissions page.
7. Verify that the permissions that you set in Step 7a under Creating a User Home Folder

Policy (page 19) are those that you set in the policy.

Close the View Permissions page.
Right-click and select Quota.
This displays the View Quota dialog box.

Verify that the quota specifications that you set in Step 9 under Creating a User Home
Folder Policy (page 19) are those that you set in the policy.

Click OKto close the View Quota dialog box.

4.8 - Performing a Consistency Check

Performing a follow-up consistency check allows you to verify that other policy specifications
that you established in the user home folder policy are being enacted.

1.
2. Click Opjects.

3. Inthe left pane, browse to select the organizational unit associated with the policy that

In the Admin Client, click the Identity Driven tab.

you created earlier.

4. Select the Users check box.

5. Intheright pane, locate and right-click TESTUSER, then select User> Consistency

Check.

6. The Take Action - User Mode page appears.
7. Click Execute.
8. Verify that the settings for the home folder attribute (DS Path), Flags, Rights, and Quota

are what you established when you configured the policy. Additionally, verify that the
Management status is set to Managed and that the Mgmt Path and DS Path match (a
check mark in the Paths Match column indicates a match).

4.9 - Running Management Actions

This procedure does the cataloging that enables the existing storage to be managed by File
Dynamics.
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. Inthe Admin Client, click the Identity Driven tab.

2. Click Opjects.

3. Inthe left pane, browse to select the organizational unit associated with the policy that

you created earlier.

4. Right-click the organizational unit and select User> Manage.

5. Verify that the selected organizational unit is listed in the Targets region of the Take

© ©® N

10.

Action page.

From the Management Action menu, select Manage.
Click Previewto view what actions will be taken.
Click Execute to initiate the Management Actions.

(Conditional) If you have other policy settings to apply, including quota, permissions,
and a template, do so using the Apply Quota, Apply Permissions, and Apply Template
menu options respectively.

For more information on these, and other Management Actions, see Management
Actions (page 182).

4.10 - Testing a Rename Event

This procedure lets you verify that a user’'s home folder attribute is updated following a rename

event.

1.

Use Active Directory Users and Computers to rename the user from the suggested
TESTUSER name to a name such as TESTUSERZ2.

. When renaming a user object, you must rename the sAMAccountName attribute,

whose value is used to create managed storage.

In the Admin Client, while you are still displaying the users through the Objects form,
click Refreshto refresh the screen and see the renamed user.

4. Right-click the renamed user and select User> Consistency Check.

5. Click Execute.

6. Verify that the home folder and the directory attribute have been updated in the DS Path

and Mgmt Path columns.

4.11 - Testing a Cleanup Rule

This procedure lets you verify that File Dynamics cleans up a user’s storage according to the
user home folder policy that you created earlier.

1.
2.

Use Active Directory Users and Computers to delete TESTUSER2.

If you chose to delay the cleanup of user storage for a set amount of days in Step 11b
under Creating a User Home Folder Policy (page 19), open the Admin Client, click the
Identity Driven tab and then click Events to view any information indicating the deferred
number of days for the storage cleanup.

Click the Engine tab.
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4. Click Path Analysis.

5. Inthe left pane, browse to the location where the TESTUSERZ2 resided and verify that
the folder has been deleted.

6. (Conditional) If you set your policy to vault deleted storage, browse to the location in the
left pane where you chose to vault deleted storage in Step 11c under Creating a User
Home Folder Policy (page 19) and verify that TESTUSERZ2 was vaulted:

a. If you set your policy to delay the cleanup of user storage for a set amount of
days in Step 11b under Creating a User Home Folder Policy (page 19), click
Events and then from the View Events drop-down menu, select Deferred Only to
view details on deferred action.

b. Right-click the listed deferred action, and select Properties. In the Properties
dialog box, then verify that the Next Process Time displays a date that
corresponds to the number of days you set in your policy for the deleted storage
to be cleaned up.

c. Close the dialog box.

7. Because this is a test user, perform the storage cleanup immediately by once again
right-clicking the listed deferred action and selecting Make Eligible.

8. Click the Engine tab.

9. Click Path Analysis and browse to the location in the left pane where you viewed the
vaulted storage, then verify that the storage has been cleaned up.

4.12 - What’s Next

Now that you have created and tested a User Home Folder policy, you can create User Home
Folder policies for the users in other organizational units or groups. You can do so based on
the overview and procedures you were given in this chapter, or you can reviewManaging User

Home Folders (page 29), which provides a more comprehensive discussion of performing
user-based storage tasks in the Admin Client.

When you have a better understanding of the user-based storage capabilities in File
Dynamics, you can proceed to have File Dynamics manage your collaborative-based storage.
Refer to Managing Collaborative Storage (page 65) for a comprehensive discussion and
procedures for performing collaborative storage tasks. Finally, you can refer to Creating
Target-Driven Policies (page 105) to create Target Driven policies.
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5 - Managing User Home Folders

This chapter provides you the information you need to understand and create policies for
managing:

¢ User Home Folders

e User Profile Paths

¢ User Remote Desktop Services Home Folders
¢ User Remote Desktop Services Profile Paths

¢ |nactive Users

Additionally, this chapter provides information for setting up a vault location, enabling your
network for quota management, importing and exporting policy information, and more.

5.1 - Home Folder Management Overview

In Managing Existing User Storage (page 15), you created and configured a Blocking policy
and a User Home Folder policy to put your existing storage in a managed state. In this section
you will learn in greater detail about how to create and configure User Home Folder policies,
along with other policies associated with user storage. These include:

e User policies

¢ Auxiliary storage policies

 Profile path policies

* Remote Desktop Services policies that include
¢ Remote desktop home folder

¢ Remote desktop policy path

5.2 - User Policies

User policies automate the provisioning, ongoing management, and disposal of network user
home folders. A user policy can be associated with the following Active Directory objects:

¢ Organizational Unit
e Container
e Security Group

e User

If you associate a user policy to a organizational unit object, the policy affects all users that
reside in those areas of the directory, unless it is specifically blocked through a Blocking
policy. If you associate the policy to a group, it affects all members of the group.

Although creating a user policy for an individual User object is possible, it is somewhat
impractical and should only be done in rare circumstances.

User policies, as well as all other policy types, are stored in the database.
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5.3 - Setting Up a Vault Location

Vaulting is the process of saving the contents of a user's home folder after the user’'s User

object has been removed from Active Directory. If your user storage policies are to include

vaulting rules, you must first set up a storage location (share) where the policy will vault the
storage.

Ensure that the vault location has Full Control permission and Full Control security rights for
the Proxy Rights group.

5.4 - Enabling Your Network for Quota Management

File Dynamics leverages the disk quota capabilities of Windows Server 2008 and later that are
exposed via File Server Resource Manager (FSRM).

File Dynamics cannot manage quotas on home folders, collaborative storage folders, or
auxiliary storage hosted on Windows Server 2003 machines. Furthermore, File Dynamics
cannot manage quotas on NAS devices.

For all Windows Server 2008 and later servers hosting home, collaborative, or auxiliary
storage managed by File Dynamics with quota management enabled, you must have the File
Server Resource Manager (FSRM) role installed. Additionally, if the Windows Firewall is
enabled, then you must set an exception rule on each server that permits remote FSRM
management. FSRM management is needed because the Engine is managing the quota
remotely. FSRM must also be installed on the server hosting the Engine.

For more information, see Firewall Requirements (page 239).

The process for setting an exception rule differs among the various offerings of Windows
Server.

5.5 - Creating a User Home Folder Policy

Prior to creating the user policy, you must determine if the policy should pertain to the
members of an organizational unit or a group.

Launch the Admin Client.
Click the Identity Driven tab.
Click Policies.

> L bh o=

In the Manage menu, select New > User Home Folder.
The following dialog box appears:

Create New Policy

MName | | |

Paolicy Type | User - |

Managed Path Type |Home Folder - |

ox

5. Specify a descriptive name in the Name field and click OK.
The Policy Options page appears.
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5.5.1 - Setting Policy Options

Settings within Policy Options let you indicate how to apply the policy, set policy inheritance
and policy weight, and write an expanded policy description.

1.

4.
5.

In the Policy Options region, fill in the following fields:

Process Events for Associated Managed Storage: Select this check box to apply the
settings in this policy to all users within the organizational unit where this policy is
assigned. Deselect this check box to create a Blocking policy that can be applied to a
specific user, group, or container. For more information on blocking policies, see
Creating a Blocking Policy (page 18)

In the Policy Inheritance region, fill in the following fields:

Policy applies to subcontainers: Select this check box to have this policy inherited for
all organizational units that reside within the organizational unit where this policy is
assigned.

Policy applies to nested group members: When the policy applies to or is effective for
groups, this option determines if nested group members will also be affected.

Policy Weight: When a user is a member of multiple groups and each group has a
separate effective policy, File Dynamics uses this setting to determine which policy to
apply. File Dynamics applies the policy with the largest numerical weight.

In the case where multiple policies have the same weight, the event will go into a
pending state indicating that multiple polices have the same weight and one must be
changed in order for the event to process.

In the text field in the Description region, specify a description of the policy you are
creating.

Click Apply to save your settings.

Proceed with Setting Associations (page 31).

5.5.2 - Setting Associations

Associations is where you assign the policy you are creating to an organizational unit, group,
or user object.

1.

In the left pane, click Associations.

2. Click Addto bring up the Directory Services Browser.

3. If you plan to assign the policy to a User object, select the Users check box as a Filter

option in the Directory Services Browser.
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4. Browse through the directory structure and select the organizational unit, group object,
or user object you want to associate the policy to.

Directory Services Browser x
SO search 'T5 Refresh | Filter: [ | Users Groups = Add == Remove
v /\ sp.ccteciorg Z Selected Object

» Builtin

Computers

Domain Controllers
ForeignSecurityPrincipals
Keys

Managed Service Accounts
Program Data

sandbox

Service Accounts

5P

Atlanta

HQ

London

Munich

Ts {Employees

'fg Groups

NYC

SFQ

Spedial Groups

L
¢ v v o gl EED AT EET AR AE AED aEC aRD AT

6B GE GRT v v GAC GED 6E GET

System L

Test |z|

w
Pa? v v oW

o

5. Drag the object to the Selected Object pane, then click OK.
The Directory Services Browser is closed and the object is displayed in fully qualified
name format in the right pane of the window. For example,
OU=Employees, DC=Munich, DC=SP, DC=cctec, DC=org.

6. Click OKto close the Directory Services Browser.
7. Click Apply to save your settings.
8. Proceed with Setting Provisioning Options (page 32).

5.5.3 - Setting Provisioning Options

The Provisioning Options page is where you indicate home folder permissions, the network
drive letter for the home folder, the location of a template for provisioning folder structure and
content in a home folder when it is created, and more.

1. Inthe left pane, click Provisioning Options.
The following page appears:
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Identity Palicy Editor - Atlanta Users = O X

General Folder Properties

Default Permissions DOS Attributes
Y Policy Options
<§> Assodiations D Eull Control List D Set Attributes on Target Folder
== Auxiliary Polices Modify Read Archive System Hidden
SEtLIp Read and Execute Write

4" Provisioning Opti

: Target Path Opti TS

W Quota Options Drive Letter
G—) Move Schedule
Path Owner
Cleanup

() Builtin Administrators
ﬁ Cleanup Options 3

@ Vault

¥ Groom

Browse Clear

Other

Motes
E‘ho Summary
E Copy Palicy Data

Template Folder

| | Browse ‘ | Clear

oK H Cancel || Apply |

1, Changes to this policy have not been saved.

In the Folder Properties region, specify the following settings:

Default Permissions: By default, File Dynamics grants the user all file permissions to
the home folder except for Full Control. Granting Full Control is not recommended
because it provides administrator rights to the home folder and enables the user to
rename and delete the folder.

Set Attributes on Target Folder: Select this check box to enable the Archive, System,
and Hidden check boxes. If you wanted home folders to be hidden from view, you could
enable the Hidden attribute by selecting the Hidden check box.

By default, File Dynamics assigns the user for whom a home folder is created as the
home folder owner. Because this essentially provides the owner administrative rights to
the home folder, you might want to provide ownership to a network administrator
instead. To override the ownership and indicate a new owner, click the Override Path
Owner check box, then browse to and select the User object you want to establish as
the owner.

The home folder user still has all permissions—with the exception of administrative
permissions—to the home folder.

(Optional) To have subfolders and documents provisioned in the home folder when it is
created, use an existing file path as a template.

For example, if you wanted each home folder to have an HR subfolder with some HR
documents inside, click Browse to locate and select the HR folder in the file system.
Everything beneath the selected folder is copied into the user’'s home folder.

In the Home Folder Options region, indicate the network drive letter that users
associated with this policy will use to access their home folders.
You can select an empty drive letter. In this scenario, the user's home drive property will
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not be set. This results in Windows clients not mounting the network home folder when
a user logs in.

5. Inthe Path Ownerregion, select one of the following options:

¢ Built-in Administrator: If you want the owner of the storage to be the Built-in
Administrator, select this option.

e Associated User: The associated user is the user whose home folder you are
creating. If you want the associated user to own their own home folder, select this
option.

» Selected Identity: If you want another owner to be the owner of the home folder,
browse and select the user or group object.

6. Click Apply to save your settings.
7. Proceed with Setting Target Paths (page 34).

5.5.4 - Setting Target Paths

The Target Path Options page is where you select the naming attribute for the managed path,
as well as set the paths to the shares where user home folders will be hosted.

1. Inthe left pane, click Target Path Options.
2. Inthe Managed Path Naming Attribute region, do one of the following:

¢ From the drop-down menu, select the single-value Active Directory attribute you
want as the means of naming your home folders.

 Click Link Action Block and select a previously saved Action Block for the naming
attribute.

For some organizations, having the default sAMAccountName attribute as the means
of naming home folders is not desirable. A school that generates student accounts
using an account provisioning system for example, might generate a student account
and sAMAccountName such as SA74556, rather than a more descriptive name such as
William Sanders. To allow File Dynamics to create a home folder with a name like
WSanders, rather than SA74556, you can select a different attribute from the drop-
down list.

sAMAccountMame) -

comment

company
department
desktopProfile

division

employeelD L4

Once you have saved the policy, you can use an account provisioning system such as
NetlQ Identity Manager to automatically populate the selected attribute with the desired
folder name and then File Dynamics will automatically provision the home folder based
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on this attribute setting. Using the example above, the home folder name would be
WSanders rather than SA74556.

For existing users whose home folders you would like to change to a new attribute
value, you would follow the same procedures, followed by performing an Enforce Policy
Path Management Action.

For specifications pertaining to Managed Path Naming Attribute, see Managed Path
Naming Attribute Specifications (page 259).

3. Inthe Target Placement region, fill in the following fields:

Distribution: If you create more than one target path for a policy, you can indicate any of
the following options:

¢ Random: Distributes storage randomly among the number of target paths.

e Actual Free Space: Distributes the creation of user home folders according to
shares with the largest amount of absolute free space. For example, if you have
two target paths listed, target path 1 has 15 GB of free space, and target path 2
has 10 GB, the home folders are created using target path 1.

» Percentage Free Space: Distributes the creation of user home folders to shares
with the largest percentage of free space. For example, if you have two target
paths listed, target path 1 is to a 10 TB share that has 30 percent free space and
target path 2 is to a 500 GB share with 40 percent free space, the home folders
are created using target path 2, even though target path 1 has more absolute
available disk space. You should be cautious when using this option with target
paths to shares of different sizes.

Leveling Algorithm: Use this option to structure the home folders so that they are
categorized by the first or last letter of a username through a subordinate folder. For
example, if you choose First Letter, and the Leveling Length field is set to 1, a user
named BSMITH has a home folder located in a path such as \ \SERVER1-DNS-

NAME \HOME\B\BSMITH.

If you choose Last Letter, and the Leveling Length field is setto 7, the same user has a
home folder located in a path such as \ \SERVER1-DNS-NAME\ HOME \H\BSMITH.
The Last Letter means the last character of the attribute File Dynamics uses to create
storage. Once again, File Dynamics uses the SAM, not the character of the last name.
The Leveling Length field allows you to enter up to 4 characters. This makes it so that
you can organize home folders by year. For example, if your Leveling Algorithm setting
is Last Letter, and the Leveling Length setting is 4, a user named BMITH2014 has a
home folder located in a path such as \\ SERVER-DNS-
NAME\HOME\2014\BSMITH2014.

Maximum Unreachable Paths: If you have a substantial number of target paths listed
on this page, this field lets you indicate the number of target paths File Dynamics
accesses to attempt to create a home folder before it suspends the attempt.

For example, suppose you have 100 target paths and you're using Random Distribution
and the Maximum Unreachable Paths setting is 20. File Dynamics will try 20 of those
100 paths before the event will become a pending event. A path can be unreachable for
any error condition. For example, the server is down or the share is not available.

4. For each target path that you want to establish, click Add to access the Path Browser.

35



5 - Managing User Home Folders

5. Browse to the location of the target path you want and click Add to add the target path to
the Selected Paths pane.

File System Path Browser x

= MNew Folder ‘/' Rename Folder _Fb Update Resources - G Refresh o= Add == Remove

Selected Paths

|Enter text to search... | | Find

v /\ sp.cctecoorg
w sp.cctec.org
~ : Atlanta

| Data

i Home

*
» 5 Managed Storage

» [ Managed Storage Template
¥ srs-m1l.sp.cctec.org

» srs-m2.sp.cctec.org

b srs-m3.sp.cctec.org

oK | | Cancel

\\sp.cctec.org\shares\Atlanta\Home

6. Click Apply to save your settings.
7. Proceed to Setting Quota Options (page 36).

5.5.5 - Setting Quota Options

This page lets you establish user storage quotas. Until quota management is established,
users have unlimited storage disk space for their home folders.

Quota management on NAS devices needs to be managed by the NAS vendor software.

This page is also where you establish quota management settings for quota managers. A
quota manager is a specified user or group who is granted the ability to increase a user’s
quota, without having rights to the file system. Quota management actions are performed
through Quota Manager, which is a separate web browser-based management interface. For
more information on Quota Manager, see Using Quota Manager (page 101).

1. Inthe left pane, click Quota Options.
The following page appears:
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Identity Palicy Editor - Atlanta Users = O X

General Quota

Enabled
Y Policy Options .

<§> Assodations () Unlimited
= Auxiiary Polices (®) Quota T
Setup

Quota Management
+ Provisioning Opt Enable Quota Manager [ Quota Preservation for this policy
: Target Path Opti

Quota Maximum Quota Increment
m Quots Options
G—) Move Schedule () No Maximum Quota () Set Quota Increment Manually
(®) Maximum Quota 20480 1| B (®)Increment Quota by; 02 me

Cleanup

ﬁ Cleanup Options Quota Managers

Vault
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Motes

E‘ho Summary

E Copy Palicy Data

oK H Cancel || Apply |

1, Changes to this policy have not been saved.

2. Select the Enabled check box to enable an initial storage quota for users to whom this

policy will apply.
Leaving this check box deselected gives users unlimited user home folder storage.

In the MB field, specify the initial storage quota for the user home folders.

Set up quota managers and enable the Quota Manager web interface for this policy by
filling in the following fields:

Enable Quota Manager / Quota Preservation for this policy: Select this check box to
enable the Quota Management region of the page and to allow the Quota Manager web
interface to apply to this policy.

Quota preservation preserves the home folder quota settings for users that are moved.
For example, if a user is moved from the Sales organizational unit to the Marketing
organizational unit, if the user’s quota allocation for the policy that applies to Sales were
higher than the quota allocation for the policy that applies to Marketing, the quota
allocations from the policy associated with the Sales policy are preserved for the user.

Quota Maximum: Indicate whether the user home folders associated with this policy
will have a maximum quota setting. If so, indicate the maximum quota.

Quota Increment: Indicate whether quota managers will set the quota manually or in
set increments. If you use manual increments, the quota manager can increase the
quota in any increment until it meets the maximum quota setting. If you establish set
increments, the quota manager can only increase the quota by the increment setting.
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5.
6.

Quota Managers: Click Add and use the Directory Services Browser to browse to and
select a user or group you want to serve as a quota manager by dragging the User or
Group object over to the right pane. Repeat this for each user or group you want to
establish as a quota manager.

If you do not specify a user or group as a quota manager, only members of the File
Dynamics Admins group will be able to use the Quota Manager web interface.

Click Apply to save your settings.
Proceed with Setting the Move Schedule (page 38).

5.5.6 - Setting the Move Schedule

This page lets you use a grid to specify when data can be moved during data movement
operations.

By default, all days and times are available for data movement. If data movement during
regular business hours creates unacceptable network performance, you can choose to move
data after regular business hours.

1.
2.

3.
4.

In the left pane, click Move Schedule.

In the Data Move Schedule grid, click the squares for the day and hour you want to
disable for data movement.

Click Apply to save your settings.
Proceed with Setting Cleanup Options (page 38).

5.5.7 - Setting Cleanup Options

This page lets you enable and specify cleanup rules for the user home folder policy. Options
for cleanup include deleting a home folder after a set number of days following the removal of
a User object from Active Directory, or vaulting (rather than deleting) the home folder.

1.
2.

In the left pane, click Cleanup Options.

Enable storage cleanup by filling in the following fields:

Enable: Select this check box to enable storage cleanup rules.

Cleanup storage: Specify the number of days a user home folder remains after the
associated User object is removed from Active Directory.

Enable Vault on Delete by filling in the following fields:

Enable: Select this check box to enable Vault on Delete. If this is checked and storage
cleanup is not enabled, the managed path will be immediately vaulted to the vault
location based on the specified vault rules. If there are no vault rules, the managed path
will be immediately vaulted to the vault location and removed from the source.

Vault Path: Click Browse to browse and select the path where you want the managed
storage vaulted after cleanup.

When you indicate this path, it also appears in the Vault Path field of the Groom page
because groom and vault rules share the same path.

4. Click Applyto save the settings.

5. Proceed with Setting Vault Rules (page 39).
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5.5.8 - Setting Vault Rules

When a User object is removed from Active Directory, you can have File Dynamics vault the
contents of the user’'s home folder from primary storage to less expensive secondary storage.
File Dynamics lets you specify what to vault or delete through vault rules. For example, before
vaulting a user’s home folder, you might want to remove all . tmp files. Or, you might want to
vault only the user's My Documents folder and nothing else in the home folder. You
accomplish all of this through settings in the Rule Editor.

1.

3.

In the left pane, click Vault.
The Vault Path field displays the vault path that you established when you set up
cleanup rules.

Click Addto open the Rule Editor.

Rule Editor b4
Description ||
Action I:I () Files () Folders
Masks
* Only one Mask per line
Comparative Criteria MNumeric Criteria Unit

File Size Filter | [Disabled] - Any Size -] o || Reset |
Create Time Filter | [Disabled] - Any Size - | | 0 | | | | Reset |
Madify Time Filter | [Disabled] - Any Size -1 0 || Reset |
Access Time Filter | [Disabled] - Any Size - | | 0 | | | | Reset |
| 0K | | Cancel |

In the Description field, specify a description of the vault rule.
For example, “Files to delete before vaulting,” or “Files to vault.”

From the Action menu, select an action.
Select whether the rule will vault files or folders, delete files or folders, or ignore a vault
rule.

There is only one action for each vault rule. For example, if you wanted to delete some
files and vault others, you would need to establish two different vault rules.
Vault: Moves all of the files or folders that meet the criteria specified in the vault rule to a
location specified in the policy.

Delete: Deletes all of the files or folders that meet the criteria specified in the vault rule.
Ignore: Ignores the conditions that would normally vault or delete a file or folder, based
on specifications you provide in the Mask field.

For example, if you wanted to vault all . MOV files, with the exception of approved
training videos located in a folder named Training Videos, you could set an
individual rule to vault . MOV files, and another rule to ignore vaulting the Training
Videos folder.

Selecting Folders disables the filter settings in the lower portion of the Rule Editor.
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File or folder names can contain an asterisk.

Specify whether the rule will apply to files or folders.

Files: If the vault rule you are creating will vault, delete, or ignore content at the file
level, leave the File option selected.

Folders: If the vault rule you are creating will vault, delete, or ignore content at the folder
level, select the Folders option.

Specify the masks for the rule.

Masks: List the files or folders you want to be vaulted or deleted, according to what is
indicated in the Action drop-down menu. For example, if you wanted to delete all
temporary files, you could list * . TMP in the Masks field.

Be aware that if you select Vault, only the files or folders that you list in the Masks text
box are vaulted and the remainder of the managed path content is deleted. Conversely,
if you select Delete, only the files or folders that you list in the Masks text box are
deleted, and everything else is vaulted.

(Conditional) If the rule you are creating is specific to files, complete the applicable filter
settings.

Leaving the setting as [Disabled]-Any Size, vaults or deletes all file types listed in the
Masks text box according to what is indicated in the Action drop-down menu. Choosing
any of the other options from the drop-down menu lets you indicate files to delete or
vault according to size, when created, when last modified, and when last accessed.

ghghgh

8. Click OK'to save the vault rule.

10.

11.

If necessary, create any needed additional vault rules by repeating the procedures
above.

(Conditional) If you have set any rules designed to ignore a vault or delete action, in the
Vault on Delete region of the Vault page, use the Promote arrow to move the rule to the
top. This protects files or folders specified in the Masks field from being vaulted or
deleted.

Vault on Delete Rules E=#Vault on Delete Rules
P
Add == Delete /" Edit | AN Promote \Js Demote & Link Action Block ¢ Unlink Action Block
Description | Action | Masks File Size Create Time | Modify Time | Access Time
approved Video Fol... | Ignore Folders \Training Videos
*.mov
Vault non-approved | Vault Files = aui Any Any Any Any
Delete old temp files | Delete Files =tmp Any Any == 2 weeks Any

Proceed with Setting Groom Rules (page 40).

5.5.9 - Setting Groom Rules

Groom rules in File Dynamics specify the file types that you want to be removed from
managed primary storage. Examples of these might be MP3 and MP4 files, MOV files, and
many others. You specify in a groom rule whether to delete or vault a file based on the rule’s
criteria.
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Grooming takes place as a Management Action that is run by the administrator. A
Management Action is a manual action that is enacted through the Admin Client. For more
information, see Management Actions (page 182).

1.

In the left pane, click Groom.
The Vault Path field displays the vault path that you established when you set up
cleanup rules.

2. Click Addto bring up the Rule Editor.

3. Inthe Description field, enter a description of the groom rule.

6.
7.

For example, “Files to groom in Henderson OU.”

Fill in the following fields:

Action: Select whether this groom rule will delete or vault groomed files.

Files: If the groom rule you are creating will vault or delete content at the file level, leave
the File option selected.

Folders: If the groom rule you are creating will vault or delete content at the folder level,
select the Folders option.

Selecting Folders disables the filter settings in the lower portion of the Rule Editor.
Masks: List the files or folders you want to be vaulted or deleted, according to what is
indicated in the Action drop-down menu.

File or folder names can contain an asterisk.

(Conditional) If the groom rule you are creating is specific to files, complete the
applicable filter settings.

Leaving the setting as [Disabled]-Any Size, vaults or deletes all file types listed in the
Masks text box according to what is indicated in the Action drop-down menu. Choosing
any of the other options from the drop-down menu lets you indicate files to delete or
vault according to size, when created, when last modified, and when last accessed.

Click OKto save the groom rule.

Proceed with Notes (page 41).

5.5.10 - Notes

The Notes page lets you enter up to 64,000 characters of notes for the policy you are creating.
A practical use of this page is to provide a better description of the policy.

5.5.11 - Summary

The Summary page displays a summary of the policy settings in HTML format. The Summary
page provides an easy way to view all of the policy settings in a single page.

5.6 - Creating a User Profile Path Policy

For users in Active Directory who access the network through Remote Desktop Services, File
Dynamics can provision and manage a user’s profile path, quota, grooming, and vaulting by
setting and managing the profile path attribute.

Microsoft stores a user’s profile path as follows: \\ server-name\ share-
name\users\user\profile.
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In managing the user’s roaming profile path, File Dynamics creates two separate profile paths
in the UNC network path. For Windows workstations running Windows Vista, Windows 7, or
Windows 8, the path is similar to the following: \\ server-dns-name\ share-
name\users\user\profile.V2.

For Windows workstations running Windows XP and earlier, the path is similar to the following:
\\server-dns-name\share-name\users\user\profile.

Support for Windows XP and earlier has been kept for backwards compatibility and will be
deprecated in a future release.

When a profile is specified for the policy, the profile is created in both of these locations.
Additionally, when quota and vault paths are specified, the specifications also apply to both of
the paths.

When File Dynamics has provisioned a profile path for the Remote Desktop Services user, it
enters settings in the Profile path field of the User object’s Profile property.

The Windows Full Control NTFS permission is established and cannot be modified.

5.6.1 - Create the Policy
1. Inthe Admin Client, click the /dentity Driven tab.
2. Click Policies.

3. Inthe Manage menu, select New > User Profile Path.
The following dialog box appears:

Create New Policy

Name | |

Policy Type | User - |

Managed Path Type |§Proﬁle Path [ |

ox

4. Specify a name in the Name field and click OK.
The Policy Options page appears.

5. Select the options and settings that you want the policy to use.
Policy Options: The fields presented on the Policy Options page are identical to those

presented when you create a User Home Folder policy. For an explanation of the page, along
with procedures for setting policy options, see Setting Policy Options (page 31).

Associations: The Associations page is identical to the Associations page presented when
you create a User Home Folder policy. For an explanation of the page, along with procedures
for setting associations, see Setting Associations (page 31).

Auxiliary Policies: Lets you link an Aukxiliary policy to the profile path. For more information on
Aukxiliary policies, see Using a Policy to Manage Auxiliary Storage (page 49).

Provisioning Options: The Provisioning Options page provides only the Path Owner and
Template Folder settings that are described in detail in Setting Provisioning Options (page 32).
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When you create a User Profile Path policy, the Folder Properties and Home Folder Options
settings are included in the Provisioning Options page for User Home Folder policies are not
included because you are only setting the profile path and not the user home folder storage.

Target Path Options: The fields presented on the Target Path Options page are identical to
those presented when you create a User Home Folder policy. For an explanation of the page,
along with procedures for setting target paths, see Setting Target Paths (page 34).

Quota Options: The fields presented on the Quota Options page are identical to those
presented when you create a User Home Folder policy. For an explanation of the page, along
with procedures for setting quota options, see Setting Quota Options (page 36).

Move Schedule: The fields presented on the Move Schedule page are identical to those
presented when you create a User Home Folder policy. For an explanation of the page, along
with procedures for setting the move schedule, see Setting the Move Schedule (page 38).

Cleanup Options: The fields presented on the Cleanup Options page are identical to those
presented when you create a User Home Folder policy. For an explanation of the page, along
with procedures for setting cleanup options, see Setting Cleanup Options (page 38).

Vault: The fields presented on the Vault Rules page are identical to those presented when you
create a User Home Folder policy. For an explanation of the page, along with procedures for
setting vault rules, see Setting Vault Rules (page 39).

Groom: The fields presented in the Groom Rules page are identical to those presented when
you create a User Home Folder policy. For an explanation of the page, along with procedures
for setting grooming rules, see Setting Groom Rules (page 40).

5.7 - Creating a User Remote Desktop Services Home Folder
Policy
Remote Desktop Services provides users network access from remote client machines. File

Dynamics provisions and manages these users’ home folders through User Remote Desktop
Services Home Folder policies.

5.7.1 - Create the Policy

1. Inthe Admin Client, click the Identity Driven tab.
2. Click Policies.

3. Inthe Manage menu, select New > User Remote Desktop Services Home Folder.
The following dialog box appears:

Create New Policy

Name | |

Policy Type | User 4 |

Managed Path Type |§Remohe Desktop Services Home Falder i |

4. Specify a name in the Name field and click OK.
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The Policy Options page appears.
5. Select the options and setting that you want the policy to use:
Policy Options: The fields presented on the Policy Options page are identical to those

presented when you create a User Home Folder policy. For an explanation of the page, along
with procedures for setting policy options, see Setting Policy Options (page 31).

Associations: The Associations page is identical to the Associations page presented when
you create a User Home Folder policy. For an explanation of the page, along with procedures
for setting associations, see Setting Associations (page 31)

Provisioning Options: The fields presented on the Provisioning Options page are identical to
those presented when you create a User Home Folder policy. For an explanation of the page,
along with procedures for setting provisioning options, see Setting Provisioning Options (page

32).

Target Path Options: The fields presented on the Target Path Options page are identical to
those presented when you create a User Home Folder policy. For an explanation of the page,
along with procedures for setting target paths, see Setting Target Paths (page 34)

Quota Options: The fields presented on the Quota Options page are identical to those
presented when you create a User Home Folder policy. For an explanation of the page, along
with procedures for setting quota options, see Setting Quota Options (page 36)

Move Schedule: The fields presented on the Move Schedule page are identical to those
presented when you create a User Home Folder policy. For an explanation of the page, along
with procedures for setting the move schedule, see Setting the Move Schedule (page 38).

Cleanup Options: The fields presented on the Cleanup Options page are identical to those
presented when you create a User Home Folder policy. For an explanation of the page, along
with procedures for setting cleanup options, see Setting Cleanup Options (page 38).

Vault: The fields presented on the Vault Rules page are identical to those presented when you
create a User Home Folder policy. For an explanation of the page, along with procedures for
setting vault rules, see Setting Vault Rules (page 39).

Groom: The fields presented on the Groom Rules page are identical to those presented when
you create a User Home Folder policy. For an explanation of the page, along with procedures
for setting grooming rules, see Setting Groom Rules (page 40).

5.8 - Creating a User Remote Desktop Services Profile Path
Policy

File Dynamics provisions and manages Remote Desktop Services profile policy paths through
Remote Desktop Services profile path policies.

For users in Active Directory who access the network through Remote Desktop Services, File
Dynamics can provision and manage a user’s profile path, quota, grooming, and vaulting by
setting and managing the profile path attribute.

Microsoft stores a user’s profile path as follows: \\ server-dns-name\ share-
name\users\user\profile.
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In managing the user’s roaming profile path, File Dynamics creates two separate profile paths
in the UNC network path. For Windows workstations running Windows Vista, Windows 7, or
Windows 8, the path is similar to: \\ server-dns-name\ share-
name\users\user\profile.V2.

For Windows workstations running Windows XP and earlier, the path is similar to: \\ server-
dns-name\share-name\users\user\profile.

Support for Windows XP and earlier has been kept for backwards compatibility and will be
deprecated in a future release.

When a profile is specified for the policy, the profile is created in both of the locations above.
Additionally, when quota and vault paths are specified, the specifications apply to both of the
paths as well.

When File Dynamics has provisioned a profile path for the Remote Desktop Services user, it
enters settings in the Profile path field of the User object’'s Remote Desktop Services Profile

property.
The Windows Full Control NTFS permission is established and cannot be modified.

5.8.1 - Create the Policy

1. Inthe Admin Client, click the Identity Driven tab.
2. Click Policies.

3. Inthe Manage menu, select New > User Remote Desktop Services Profile Path.
The following dialog box appears:

Create New Policy

MName | |

Policy Type | User - |

Managed Path Type |§Remote Desktop Services Profile Path [ |

4. Specify a name in the Name field and Click OK.
The Policy Options page appears.

5. Select the options and settings that you want the policy to use:
Policy Options: The fields presented on the Policy Options page are identical to those

presented when you create a User Home Folder policy. For an explanation of the page, along
with procedures for setting policy options, see Setting Policy Options (page 31).

Associations: The Associations page is identical to the Associations page presented when
you create a User Home Folder policy. For an explanation of the page, along with procedures
for setting associations, see Setting Associations (page 31)

Provisioning Options: The Provisioning Options page provides only the Path Owner and
Template Folder settings that are described in detail in Setting Provisioning Options (page 32).

When you create a User Remote Desktop Services Profile Path policy, the Folder Properties
and Home Folder Options settings that are included in the Provisioning Options page for User
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Home Folder policies are not included because you are only setting the profile path and not
the user home folder storage.

Target Path Options: The fields presented on the Target Path Options page are identical to
those presented when you create a User Home Folder policy. For an explanation of the page,
along with procedures for setting target paths, see Setting Target Paths (page 34).

Quota Options: The fields presented on the Quota Options page are identical to those
presented when you create a User Home Folder policy. For an explanation of the page, along
with procedures for setting quota options, see Setting Quota Options (page 36).

Move Schedule: The fields presented on the Move Schedule page are identical to those
presented when you create a User Home Folder policy. For an explanation of the page, along
with procedures for setting the move schedule, see Setting the Move Schedule (page 38).

Cleanup Options: The fields presented on the Cleanup Options page are identical to those
presented when you create a User Home Folder policy. For an explanation of the page, along
with procedures for setting cleanup options, see Setting Cleanup Options (page 38)

Vault: The fields presented on the Vault Rules page are identical to those presented when you
create a User Home Folder policy. For an explanation of the page, along with procedures for
setting vault rules, see Setting Vault Rules (page 39).

Groom: The fields presented on the Groom Rules page are identical to those presented when
you create a User Home Folder policy. For an explanation of the page, along with procedures
for setting grooming rules, see Setting Groom Rules (page 40)

5.9 - Using a Policy to Manage Inactive Users

When a user leaves an organization, many organizations choose to make the User object
inactive, rather than immediately delete the User object. This provides the organization an
indefinite amount of time to review and determine what to do with the contents of the user’s
home folder before finally deleting the User object.

With File Dynamics, you can easily create an Inactive Users policy that has all home folder
property rights removed and apply it to an organizational unit set up specifically for inactive
users. When the User object is moved to the inactive users organizational unit, the access
rights for that user are immediately removed.

5.9.1 - Creating an Inactive Users Organizational Unit

1. Inthe Admin Client, click the /dentity Driven tab.
2. Click Objects.

3. Inthe left pane, browse to where you want to create an inactive users organizational
unit.

Right-click and select Create OU.
Give the object a descriptive name, such as “Inactive Users” and click OK.

Click Refreshto view the new organizational unit.

N o o A

Continue with Creating an Inactive Users Folder (page 47)
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2 - Creating an Inactive Users Folder

. Launch Windows Explorer.
. On a network share, create a folder to store inactive user home folders.

. Give the folder a descriptive name, such as “Inactive Users.”

Continue with Creating an Inactive Users Policy (page 47)

3 - Creating an Inactive Users Policy

In the Admin Client, click the Identity Driven tab.

2. Click Policies.

3. Inthe Manage menu, select New > User Home Folder.

5.

The following dialog box appears:

Create New Policy

Name | | |

Policy Type | User - |

Managed Path Type |Home Folder - |

Specify a descriptive name in the Name field and click OK.
The Policy Options page appears.

Continue with Setting Inactive Users Policy Associations (page 47).

5.9.4 - Setting Inactive Users Policy Associations

1.
2.

5.9.

In the left pane, click Associations.

Click Add, then browse to and select the inactive users organizational unit you created
in Step 3 under Creating an Inactive Users Organizational Unit (page 46).

Click Addto add the inactive users organizational unit to the Selected Object panel.
Click OKto save the setting.

Proceed with Setting Inactive Users Policy Provisioning Options (page 47)

5 - Setting Inactive Users Policy Provisioning Options

. Inthe left pane, click Provisioning Options.

In the Folder Properties region of the page, deselect each of the permissions check
boxes.

This assures that User objects placed in the inactive users organizational unit do not
have permissions to home folders.

3. Click Apply to save the setting.

4. Proceed with Setting Inactive Users Policy Target Paths (page 48)
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5.9.6 - Setting Inactive Users Policy Target Paths

1. Inthe left pane, click Target Path Options.

2. Click Add, then browse to and select the inactive users folder that your created in Step 2
under Creating an Inactive Users Folder (page 47)

3. Click Addto add the inactive users folder to the Selected Items panel.
4. Click Applyto save the setting.
5. Proceed with Setting Inactive Users Policy Cleanup Options (page 48)

5.9.7 - Setting Inactive Users Policy Cleanup Options

1. Inthe left pane, click Cleanup Options.
2. Inthe Storage Cleanup region, select the Enable check box.

3. Inthe Cleanup storage field, specify the number of days you want an inactive user’s
home folder to remain before it is removed from the target path for this policy.

4. Click Applyto save the settings.

5.10 - Copying Policy Data
Policy Import allows you to copy all or a portion of the policy settings of one policy into another
policy.

1. Inthe Admin Client, click the Identity Driven tab.

2. Click Policies.

3. While creating a new policy or editing an existing policy, click Copy Policy Data in the
left pane of the Policy Editor dialog box.

Policy Import - Atlanta Users - o X
Source Policy || ‘ ‘ e
Policy Properties
« [ General Atlanta Users
["] Policy Options Properties
[ Ausiary Polices Type: User
v [] setup Path Type: Home Folder
> [] Provisioning Options Policy State: Enabled
> [] Target Path Options Auto Bypass Events: Disabled
> [ Quota Options Description: Policy created at 3/24/2023 5:54 PM by
7] Move Schedule SPAdministrator
v [ | deanup
D Cleanup Options
[] vaultPath
[] vault Rules
"] Groom Rules
o
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4. Click the Browse button. In the Policy Selector dialog box, select the policy from which
you want to copy policy settings, then click OK.
The dialog box is updated with the name of the policy from which you are copying
settings.

5. Inthe Policy Properties tree, click the settings from the policy you want to import.

Policy Import - HQ Users = [m] x
Source Palicy |Corporate Template Policy ‘ | Browse I
—
v [/ General HQ Users Corporate Template Policy
0l P“"q_' Options Properties Properties
[ Auxlary Policies Type: User Type: User
v ] sep Path Type: Home Folder Path Type: Home Folder
> [] Provisioning Options Policy State: Enabled Policy State: Enabled
> [] Target Path Options Auto Bypass Events: Disabled Auto Bypass Events: Disabled
> [] Quota Options Description: Palicy created at 3/29/2023 8:37 PM by Description: Policy created at 3/29/2023 8:35 PM by
[ Move Schedule SP\Administrator SP\Administrator
v || deanup
D Cleanup Options
[] vaultPath
[] vault Rules
"] Groom Rules
< >

6. When you are finished selecting settings to copy, click OK.

5.11 - Using a Policy to Manage Auxiliary Storage

Auxiliary storage allows administrators to create auxiliary storage folders when a new user is
created. This auxiliary storage can even be invisible to the user for whom it was created.

For example, an organization's HR department might keep an individual folder for each user in
the organization. With auxiliary user storage enabled, this folder can be created when the user
joins the company and File Dynamics creates and provisions his or her home folder. The user

never sees the auxiliary storage, because the policy gives Read and Write permissions only to
the HR department.

Additionally, the auxiliary storage can be as large as the policy specifies. This means that
even though the user's home folder might have 500 MB, the auxiliary storage could be as
small as the HR department needs it to be for storing HR-specific documents about the user.
In fact, the policy can dictate that the auxiliary storage is provisioned with needed HR
documents at the time the auxiliary storage is created.

Of course, you can configure auxiliary user storage so that a user can access it. For example,
you might want to have a separate storage folder for application-specific files. It is important to
remember that auxiliary storage is simply another home folder for a user. To provide access to
this storage, you need to provide some sort of mapping for the user to get automated access
toit.

49



5 - Managing User Home Folders

There is no limit to the number of auxiliary folders that can be created. Auxiliary folders can be
created in shares that differ from the location of the user's home folder.

The life cycle management capabilities in File Dynamics easily manage auxiliary storage to
the specific needs of the organization. For example, if a user transfers from one city to another
and the user home folder is moved to a new Organizational Unit object as a result, the policy
can dictate what becomes of the auxiliary storage including moving it, moving it and adjusting
the quota settings, leaving it where it currently is, etc. For more information on moving
Auxiliary storage, see Establishing Auxiliary Purpose Mappings (page 53).

5.11.1 - Creating an Auxiliary Storage Policy

1. Inthe Admin Client, click the Identity Driven tab.
2. Click Policies.

3. Inthe Manage menu, select New > Auxiliary.
The following dialog box appears:

Create New Policy

Name | | |

Policy Type |.ﬂtu}t‘iliaryI User - |

4. Specify a descriptive name in the Name field, such as “HR-AUX,” and click OK.
The Policy Options page appears.

5. Proceed with Setting Auxiliary Storage Policy Options (page 50)

Setting Auxiliary Storage Policy Options

1. Leave the Process Events for Associated Managed Storage check box selected.

2. Proceed with Enabling Auxiliary Storage Extended Options (page 50)

Enabling Auxiliary Storage Extended Options

1. Inthe left pane, click Extended Options.
2. Click the Enable check box.
3. Inthe Tagfield, enter a descriptive string for the auxiliary storage.

We recommend that once you have made an entry in the Tag field, you do not change it.
If the value of the Tagfield is changed after some users have already had their auxiliary
storage provisioned via that policy, the new tag value does not automatically get
propagated to those users. Only users who get storage provisioned after the change in
the tag value will get the new tag value.

4. Inthe Description field, specify a description of the Auxiliary Storage policy.
5. Click Apply to save your settings.
6. Proceed with Setting Auxiliary Storage Provisioning Options (page 51)
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Setting Auxiliary Storage Provisioning Options

Before setting the provisioning options, you need to decide whether the user should have
rights to auxiliary storage.

Additionally, if you are going to provision auxiliary storage folders with a certain structure or
with specific documents, you need to place them somewhere in the file system so you can use
them as a template. For example, if the HR department wants the auxiliary storage folder to
have an Annual Reviews folderand an Insurance Forms folder, you need to setthese
up in the file system before proceeding.

1. Inthe left pane, click Provisioning Options.

2. Do one of the following:

¢ If you do not want the associated user to have access to the auxiliary storage folder,
deselect all of the Default Permissions check boxes.

¢ If you want the associated user to have access to the auxiliary storage folder, select the
appropriate permissions from the Default Permissions check boxes.

3. Inthe Template Folderregion, click the Browse button, and then specify the template
path in the Path Browser dialog box.

4. Click Applyto save your settings.
5. Proceed with Setting Additional Auxiliary Storage Options (page 51)

Setting Additional Auxiliary Storage Options

1. Select the additional options that you want to use in the Auxiliary Storage policy.

Target Path Options: You need to specify the location where the auxiliary storage folders are
to be located. For example, if these were HR Department folders, they would probably be
located on a network share specific to the HR Department.

The fields presented on the Target Path Options page are identical to those presented when
you create a User Home Folder policy. For an explanation of the page along with procedures
for setting target paths, see Setting Target Paths (page 34).

Quota Options: You need to specify the quota for the auxiliary storage folder associated with a
user. In many cases, such as the HR Department example, this folder can be much smaller
that the home folder.

The fields presented on the Quota Options page are identical to those presented when you
create a User Home Folder policy. For an explanation of the page, along with procedures for
setting quota options, see Setting Quota Options (page 36)

Move Schedule: The fields presented on the Move Schedule page are identical to those
presented when you create a user home folder policy. For an explanation of the page, along
with procedures for setting the move schedule, see Setting the Move Schedule (page 38).

Cleanup Options: The fields presented on the Cleanup Options page are identical to those
presented when you create a User Home Folder policy. For an explanation of the page, along
with procedures for setting cleanup options, see Setting Cleanup Options (page 38)
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Vault: The fields presented on the Vault page are identical to those presented when you
create a User Home Folder policy. For an explanation of the page, along with procedures for
setting vault rules, see Setting Vault Rules (page 39).

Groom: The fields presented on the Groom page are identical to those presented when you
create a user home folder policy. For an explanation of the page, along with procedures for
setting grooming rules, see Setting Groom Rules (page 40).

2. Proceed with Linking a User Home Folder Policy to an Auxiliary Storage Policy (page

52)

5.11.2 - Linking a User Home Folder Policy to an Auxiliary Storage
Policy

This procedure connects the Auxiliary Storage policy with an existing User Home Folder
policy. All new users that are added to a group or organizational unit associated with the linked
User Home Folder policy will also have auxiliary storage created. To provide existing users
with auxiliary storage, see Provisioning Auxiliary Storage for Existing Users (page 52)

1. Inthe Admin Client, click the Identity Driven tab.
2. Click Policies.

3. Inthe list of policies, double-click the policy you want to link to the Auxiliary Storage
policy.
4. Inthe left pane of the Policy Editor, click Auxiliary Policies.

5. Click Add. In the Policy Selector dialog box, select the Auxiliary Storage policy, then
click OK.

6. Click OKto exit the Policy Editor.

5.11.3 - Provisioning Auxiliary Storage for Existing Users

This procedure lets File Dynamics manage an existing second user home folder by classifying
the second home folder as an auxiliary storage folder and managing it through an Auxiliary
Storage policy. In the process, File Dynamics corrects any potential problems.

1. Inthe Admin Client, click the Identity Driven tab.
2. Click Policies.

3. Select the Auxiliary Storage policy linked to the user home folder policy of the users for
whom you want to create auxiliary storage.

4. Inthe Actions drop-down menu, select Assign Auxiliary Attributes.

5. Verify that the Assign using value in policy if Auxiliary Attribute is not set option is
selected.
This option uses the defined Auxiliary Storage policy path and looks for a folder that
matches the SAM of all users defined within the policy. If a match is found, the Auxiliary
Storage Attribute is set and the users are cataloged and managed by the Auxiliary
Storage policy.
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6. Click Preview.
Preview mode allows you to view the results of an action without actually making
changes.

7. Click Executeto set the Auxiliary Attribute.
From the Auxiliary Policy Action drop-down menu, select Apply Quota.

9. Select Set quota for all directories. Overwrite any existing quota assignments except
where the existing quota is larger than the quota defined in the policy.

10. Click Preview.

11. Click Execute to set the quota for the auxiliary storage.

5.11.4 - Establishing Auxiliary Purpose Mappings

Auxiliary Purpose Mappings are the means of moving a user’s auxiliary storage when a user is
moved in Active Directory. For example, if a user were moved from the Atlanta container to the
Detroit container, and the two container’s Auxiliary Storage policies were part of the same
Auxiliary Purpose Mapping, the user’s Auxiliary storage would move to the Detroit Auxiliary
storage location.

If there is no established Auxiliary Purpose Mapping between the source and destination
container, the user’s Auxiliary storage is deleted once the user is moved.

1. Inthe Admin Client, click the Identity Driven tab.
2. Click Policies.

3. From the Manage drop-down menu, select Auxiliary Purpose Mappings.

Auxiliary Policy Purpose Mappings X

Auxiliary Policy Purposes Details
o Add == Remove G Refresh

Name

| Purpose GUID

Type
Description

Characters Allowed: 1024 Remaining: 1024

Mapped Policies
o= Add == Remove

| Policy

o o

4. Click Add.
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5. Give the new Auxiliary Purpose Mapping a descriptive name.
For example, “HR.”

6. Click OK.
In the Mapped Policies region, click Add.

From the Policy Selector dialog box, hold down the Control key to select each of the
Aukxiliary storage policies you want associated with the Auxiliary Purpose Mapping.
You can hold down the Control key to select multiple Auxiliary Policy purposes.

Using the example above, you would select the Auxiliary storage policy for the Atlanta
container, the Detroit container, and any others you want included.

9. Click OK.
10. Inthe Description field, specify the details of the Auxiliary Purpose Mapping.

Auxiliary Policy Purpose Mappings x
Awxiliary Policy Purposes Details
[
== Add == Remove I\ Refresh Name |HR |
| Purpose GUID {41743700-FF93-43D7-BEAD-FA2319EDB 167}
HR Type User Defined

Description | Maintains HR. folders {auxiliary Storage} for employees when they transfer between
locations

Characters Allowed: 1024 Remaining: 933

Mapped Policies
o Add == Remove
|POIicy’

5 Atlanta Aux
3 NYC Aux

11. Click Apply.
12. Click Close.

5.12 - Exporting Policies

File Dynamics provides the ability to export policies so that they can be imported later. For
example, many customers first evaluate File Dynamics in a lab environment and create a large
number of policies in the process. You can export these policies and later import them into the
production environment. All exported policies are saved in a single XML file.

1. Inthe Admin Client, click the Identity Driven tab.
2. Click Policies.
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3. From the Manage drop-down menu, select Export Policies.

Policy Export x

Select All [ Deselect All

Drag a column header here to group by that column ,D

| | Maniaged Path Type | Palicy Name -

& Home Folder Atlanta Users

& Home Folder HQ Users

Policy Export File |C:‘J..lsers\,administrator.SP\Domments\Exported_Policies—20230420192356.)cml | | Browse |
| Export | | Close |

Select the check boxes of those policies you want to export.

Accept the default path of the file or browse to select a new path.

Click Export.
After you are notified that the policies have been exported, click Close.

© N o o A

5.13 - Importing Policies
Previously exported policies are imported by using the Import Policies feature.

1. Inthe Admin Client, click the Identity Driven tab.
2. Click Policies.

Accept the default export filename or indicate a new one in the Policy Export File field.

55



5 - Managing User Home Folders

3. From the Manage drop-down menu, select Import Policies.
The following wizard is launched.

Policy Import Wizard x

Import Policies

Select a policy import file

The import file may contain one or more policies for import.

Policy Import File | | Browse

4. Browse to select the saved export file.
5. Click Next.

Policy Import Wizard X

@ Import Policies

Select Policies to Import

Rename Select All [ ] Deselect All
| | Managed Path Type Paolicy Name -

& Home Folder Atianta Users

& Home Folder HQ Users

E Mext = i| Cancel |

6. Verify that the check box for each policy you want to import is selected.

7. Click Next.
A status page appears indicating what policies were imported and when the import
process is complete.

8. Click Close.
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6 - Managing Existing Collaborative Storage

This section includes the procedures for using File Dynamics to manage the managed paths
that are assigned to Group objects or containers in Active Directory.

In a File Dynamics environment, group-based or container-based storage is referred to as
“collaborative storage,” because File Dynamics, through its collaborative policies, provides the
means of creating storage folders where members can easily collaborate through a single
project folder, or even through a structured project folder where all members have personal
subfolders.

Similar to Managing Existing User Storage (page 15), this section provides the basic
procedures for managing collaborative storage, which includes associating groups and
containers with shared storage, and setting the target path, quota rules, and groom rules.

This section does not provide procedures for establishing a structured project folder with
personal subfolders, which are enabled through template creation and Dynamic Template
Processing. For a comprehensive discussion on managing collaborative storage, including
Dynamic Template Processing, see Managing Collaborative Storage (page 65).

The process for managing existing storage and creating personal subfolders involves the
tasks linked below.

6.1 - Assigning a Managed Path to Existing Group-based or
Container-based Storage

A collaborative managed path attribute is created by File Dynamics when the Active Directory
schema is extended. The attribute is used to associate a Group or container object with a
managed path.

In this procedure, you assign a managed path to a Group or container object that has existing
collaborative storage and then assign the storage path.
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1. Inthe Admin Client, click the Identity Driven tab.

2. Click Actions.

Management Action - User Mode

= O
P Execute User Mode ~ Consistency Check | [F Management Action ~ | %23 Refresh Results
&7 ] 2 P
Consistency Check Targets
Add == Remove | [+ Select All
Path Types +
| | FDM
Home Folder [ ] Remote Desktop Services Home Folder
[ Profile Path [ ] Remote Desktop Services Profile Path
[ Auxiliary
Mask |
== Add to Targets | Selected ltems: 0
Results | Primary Path Statistics
|:| | | | Na.. - | DS Path | Home Dr... | PathT... | D5 Pat... | Paolicy | Flags | Permis. .. | Quota | Manag... | MgmtP... | Mg... | Paths Match

3. Use the menu to replace User Mode with Group Collaborative or Container

4.

Collaborative mode.

In the Targets region, click Add.
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5. Browse to locate and select the container or group you want to associate to a
collaborative storage area, then click Add.

Directory Services Browser x
SO search 'S5 Refresh | Filter: Users Groups = Add == Remove

ForeignSecurityPrincipals |Z| Selected Object

Keys CN=NYC Marketing,OU=Groups,QU-=...
Managed Service Accounts

Program Data

Service Accounts

£ v v v v v

¢~ G0 Rt T EE EET B

Atlanta

HQ

London

Munich

NYC

Tz Employees

f= Groups
2% NYC Employees
2L NYC Helpdesk
2& NYC Managers
2R | NYC Marketing
2& NYC Sales

Tz sFO

?g Spedial Groups

System

Users

-
G0 AR v

[«]

ok || cancel

Click OK.
Click Management Action > Assign Managed Path.
Select the Explicit Assignment check box.

© ©® N

Click Browse, then locate and select the group storage folder you want to manage
through File Dynamics.
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6

10. Click Preview.

Management Action - Group Collaborative Mode

— O X
Q Preview [P Execute 3% Group Collaborative Mode = Consistency Check !‘; Management Action G Refresh Results
Assign Managed Path Targets (1)
Add == Remove Select All -
| | FDN
Explicit Assignment {only warks with single object) 2A CN=NYC Marketing,OU=Groups,OU=NYC,0U=5 ..
Target Path
Explicit Path |‘l,\srs-rn1.sp.ochec.org\SharesWYCWYCShE| | Browse | | Clear |
Process Subcontainers Mask | |

Add to Targets | Selected ltems: 0

O |Name - |Paﬂ1 Type |Action Status

11. Click Execute.

12. Observe in the bottom portion of the page that the managed path has been set.
13. Continue with Creating a Collaborative Storage Policy (page 60).

.2 - Creating a Collaborative Storage Policy

After you assign a managed path, the next step is to create a Collaborative Storage policy for
the group or container you selected in Step 5 under Assigning a Managed Path to Existing
Group-based or Container-based Storage (page 57). In this procedure, the Collaborative

Storage policy will apply to the Group object. However, a Collaborative Storage policy can

apply to a Group's parent container thus making it applicable to all existing and new groups
located therein.
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1. Inthe Admin Client, click the Identity Driven tab.
2. Click Policies.
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3. Select Manage > New > Group Collaborative.
The following dialog box appears:

Create New Policy

Name | | |

Policy Type |Group Collaborative - |

4. Specify a descriptive name for the new policy and click OK.

5. Inthe left panel, click Associations.

6. Atthe top of the right pane, click Add and browse to select the group or container that
you selected in Step 5 under Assigning a Managed Path to Existing Group-based or
Container-based Storage (page 57).

7. Click Add, then click Apply to save your changes.

Identity Policy Editor - NYC Departments — O b4
General Assodiations
== Add == Remove
ﬂ Policy Options |FDN -
yw ﬂ- CN=NYC Marketing, O =Groups,OU=NYC,0U=5P,DC =sp,DC =cctec, DC=org
Setup
+" Provisioning Opti
_-___ Target Path Opti
m Quota Options
(© Move Schedule
Dynamic Template
Cleanup
[Tj Cleanup Options
@ Vault
X Groom
Other
MNotes
E’ho Summary
E Copy Policy Data
ok || cancel || apaly
1, Changes to this policy have not been saved.
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8.

9.

10.
11.

12.
13.

14,
15,

62

In the left panel, click Provisioning Options.

General

v Policy Options
<§’ Assodiations

Setup

" Provisioning Opti
_-___ Target Path Opti
m Quota Options

(© Move Schedule

Dynamic Template
Cleanup

[Tj Cleanup Options

@ Vault
¥ Groom

Other

Notes
E’bo Summary
E“ Copy Policy Data

Identity Policy Editor - NYC Departments

Folder Properties
Default Permissions
|| Full control [ uist
[ Modify | |read

[ |Read and Execute [ | rite

Path Owner

(®) Built4n Administrators
() Assodated Group
() Selected Identity

D Use Group Manager as Owner

Template Folder

DOS Attributes

[ ] set Attributes on Target Folder

Archive System Hidden

Browse Clear

o COwner will be assigned according to selection above when a group's manager is not set

| Browse Clear

i

In the Default Permissions region, specify the permissions that you want the managed
object to have to the collaborative managed path.

(Conditional) Select any DOS Attributes you want to apply to the target folder.

In the Path Ownerregion, select one of the following options:

¢ Built-in Administrator: If you want the owner of the storage to be the Built-in
Administrator, select this option.

» Associated Group: The associated group is the group whose folder you are
creating. If you want the associated group to own their own folder, select this

option.

» Selected Identity: If you want another object to be the owner of the folder,

browse and select the object.

» Use Group Manager as Owner: To use the Active Directory Group Object
Manager as the owner, select this check box. If the manager is not found, File
Dynamics will use the option selected above.

In the left panel, select Target Paths, then click Add.

Browse to and select the parent of the folder you selected in Step 9 under Assigning a
Managed Path to Existing Group-based or Container-based Storage (page 57).

Click Add, then click OK.

In the left panel, select Quota Options.
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17.
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20.
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22.
23.
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In the Quotaregion, select the Enabled check box and specify the amount of initial
quota you want assigned to the collaborative storage folder.

(Conditional) If you want to set specifications for a quota manager, select Enable Quota
Manager / Quota Preservation for this policy and set quota maximums, increments, and
managers.

In the left pane, select Groom.

Browse to select the folder where you want to vault the files that will be groomed.
If the folder does not exist, you can right-click to create the folder.

Click OKto save the vault path, then click Add.

Rule Editor X

Description | |

Action I:I (@) Files () Folders

Masks

* Only one Mask per line

Comparative Criteria Mumeric Criteria Unit

File Size Filter | [Disabled] - Any Size - 0 | || Reset

|
| | | | Reset |
|
|

Create Time Filter | [Disabled] - Any Size -

0
Modify Time Filter | [Disabled] - Any Size - E || Reset
0

Access Time Filter | [Disabled] - Any Size - | | | | | | Reset

| 0K | | Cancel |

In the Rule Editor dialog box, indicate the files that File Dynamics will groom from the
collaborative storage pertaining to this policy.
For information on each of the fields in this dialog box, refer to Setting Groom Rules

(page 40)

Click OKto save the groom rule.

Continue with Performing Management Actions (page 63)

6.3 - Performing Management Actions

This procedure enforces all of the policy specifications to the collaborative storage managed
by File Dynamics.

1.

In the Admin Client, click the Identity Management tab.

2. Click Objects.

3. Browse to and select the group or container that you specified in Step 5 under

Assigning a Managed Path to Existing Group-based or Container-based Storage (page
57).

Right-click the group or container and select Group Collaborative > Manage.
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5.
6.

10.
11.

12.
13.
14.

15.
16.

17.
18.
19.
20.

21.
22.
23.
24.

25.

Click Preview.

Verify that the following message appears in the lower panel of the window:
Existing managed path location would be catalogued.

Click Execute.

From the Management Action menu, select Apply Attributes.
Select the Use policy defined DOS attributes check box.
Click Preview.

Verify that the following message appears in the lower panel of the window:
Apply attributes will be scheduled for object.

Click Execute.
From the Management Action menu, select Apply Quota.

Verify that the Set quota for directories that do not currently have a quota defined option
is selected.

Click Preview.

Verify that the following message appears in the lower panel of the window:
Apply quota will be scheduled for object.

Click Execute.
From the Management Action menu, select Apply Permissions.
Click Preview.

Verify that the following message appears in the lower panel of the window:
Apply rights will be scheduled for object.

Click Execute.
From the Management Action menu, select Groom.
Click Preview.

Verify that the following message appears in the lower panel of the window:
Groom will be scheduled for object.

Click Execute.

6.4 - Editing Collaborative Storage Policies

In this section, you created a basic collaborative storage policy designed to manage a non-
structured storage folder. If you decide later that you want to edit the policy to adjust the quota,
modify the target path, or even structure the group or container managed path with personal
folders for each group or container member, you can easily do so.

For more comprehensive information on collaborative storage policies, including their ability to
create structured group-based or container-based storage folders through Dynamic Template
Processing, see Managing Collaborative Storage (page 65).
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7 - Managing Collaborative Storage

Collaborative storage is a shared storage area where a group of people in an organization can
collaborate by accessing the same collaborative storage. For example, a cross-functional
project team in an organization might need a collaborative storage area where all members
could access and submit project files.

File Dynamics lets you easily create collaborative storage areas through Collaborative
Storage policies that you can assign to Group objects or to an organizational unit (also known
as a container). You can structure the collaborative storage in one of three ways:

» Creating a single project folder where all project members have access and have the
same permissions.

» Creating a project folder with a specified owner. The project folder has subfolders for
each of the members of the group. This configuration is done through Dynamic
Template Processing. For more information on Dynamic Template Processing, see
Setting Group Collaborative Storage Policy Dynamic Template Processing (page 81).

» Creating a multi-group owned project folder with each group having distinct access
rights. This capability is available through Multi-Principal Group Collaborative Storage
policies. For more information, see Create a New Multi-Principal Collaborative Storage
Policy (page 91).

File Dynamics works with Active Directory to ensure that only members of the Group object
have access to collaborative storage. As new members are added to the group, they are
automatically granted access to the collaborative storage. As members are removed, they no
longer have access to the collaborative storage.

In cases where personal folders are issued through Dynamic Template Processing, when a
user is removed from the group, the personal folder is renamed to #REMOVED# username,
leaving the file content in the storage location, but making the former group member unable to
access the files within.

In this chapter, you will learn how to create collaborative storage policies. These include:

* Group-based collaborative policies
» Container-based collaborative policies

¢ Group Multi-Principal collaborative policies

7.1 - Creating Collaborative Storage Objects in Active
Directory

For File Dynamics to manage collaborative storage, it must have the following Group or User
objects located in an organizational unit in Active Directory:

 -MEMBER-
* -MANAGER-
* -GROUP-
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These objects are needed for assigning permissions to the collaborative storage template
folders (that you will create later) for the group members, the manager, and the group itself.

You only need to create these objects in one organizational unit.

1. Ata Windows workstation, launch Active Directory Users and Computers.
2. Right-click an organizational unit and select New > Group.

3. Give the Group object the name -MEMBER- and leave the Group Scope setting as
Global and the Group Type setting as Security.

4. Repeat Step 2 to create a -MANAGER- group and a ~-GROUP- group.
These three objects are used to automatically set permissions for the collaborative
storage. Make sure you name the objects exactly as indicated. The object names can
either be uppercase or lowercase.

7.2 - Understanding Collaborative Storage Templates

When you created User Home Folder policies in Managing User Home Folders (page 29), a
field in the Provisioning Options page let you indicate the path to a template for provisioning
folder structure and content in the home folder.

For collaborative storage management, you can also indicate a template path for provisioning
and folder structure within the collaborative managed path. When File Dynamics creates a
collaborative managed path for a group, File Dynamics examines the policy to determine if a
template has been defined and, if so, it copies the contents of the template directory along with
all attributes, permissions, and quotas.

If you want to enable quota management for collaborative storage folders, the folders must
have the following characteristics:

¢ Belocated on servers running either Windows Server 2008 or above
¢ Have a firewall exception for the Remote File Server Resource Manager

Unlike user home folders, collaborative storage managed by File Dynamics is dynamic in that
the member attributes of Group objects are monitored so that the addition and deletion of
members can have a direct impact on the structure of the individual file system of a group as
well as the permissions given within the structure.

7.3 - Determining How You Want to Structure Your
Collaborative Storage

Your collaborative storage area should be structured so that it optimally serves the needs of
your collaborative users. The collaborative storage needs of a cross-functional team at an
architectural firm would be quite different from a junior high school history class.

Two sample designs are shown below.
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Sample Work Project
Collaborative Storage
Template

ED  Network zhare

Project Team

-MEMBER-

Sample Classroom
Collaborative Storage
Template

EW  network share
Eth Grade U.5. History
Aftendess

Assignment Tum-in Folder

-MEMEBER-

- Clz=z Materizls

W] Grading_policy.doc
W =yiizbus. doc

LH Termm_paper_topics.doc

Teacher

-MANAGER-

In the template structures above, both have -MANAGER- and -MEMBER - folders. This means

that there is a personal folder created for the designated manager of the group, along with

personal folders created for each member of the group.

In order for those folders to be created and managed properly, the -MANAGER- and -
MEMBER- folders must not exist in the same folder.

In the project collaborative storage template, all members can see the contents of each

member’s folder—except for the designated manager’s folder. In the classroom template, class
members cannot see the contents of other classmate’s folders because members have rights

only to their personal folders.
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7.4 - Creating a Collaborative Storage Template

1. Launch Windows Explorer.

2. On anetwork share, create a file structure for a group that you will provide collaborative
storage.

3. Place any documents you want available to the group in the appropriate folders.

7.5 - Setting Up Security for a Collaborative Storage
Template

Properly setting security and permissions for collaborative storage in Active Directory can be
potentially confusing. For this reason, we are providing an example of the correct way to set up
security for a collaborative storage template.

The example provided is for a school class where the instructor is using a collaborative
storage folder as the means of distributing assignments to students, as well as the means of
retrieving assignments that the students turn in. The students cannot see the personal folders
of the other students.
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Common Academic Setting Collaborative Storage Template Structure

L COLLAB_TEMPLATES

L Class-Template

~ Handouts

_ Students

L -MEMBER-

Teacher

_ Turn-in

L -MEMBER-

The file structure above is a common structure that can be used as a template for collaborative
storage in an academic setting. By establishing the correct permissions, the course instructor
can be established as the owner with full control of the collaborative storage area. Students
can be provided with personal folders for retrieving and turning in assignments.

The diagram below shows the security permissions that must be established.
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Security Permissions for Each Folder in the Sample Template

L COLLAB_TEMPLATES

Policy Templote ROOT ~

Class-Template

| Handouts

| Students

L -MEMBER-

I Teacher

L Turn-in

L -MEMBER-

Security Assignments

-GROUP- List {This Folder Only)
-MAMAGER- EC (This will flow down!)

-GROUP- REL

-GROUP- Traverse Folder/List Folder
(Thiz Folder Only)

-MEMBER- MELRW

-GROUP- Traverse Folder/List Folder
(Thiz Folder Only)

-MEMBER- MELRW

The diagram above shows the security permissions that must be established for each of the
folders in the template structure. For example, the ~-GROUP- object must be given the List
permission to the Class-Template folder and the ~-MANAGER- object must be given Full
Control. List, Traverse Folder, and List Folder are all advanced permissions.

When you set the provisioning options for the Collaborative Storage policy, you must override
the path owner and indicate an owner, unless you want all users in the group to have all rights

to the collaborative storage area.

In the example in the figure above, Teacher1 is specified as the owner.
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Owner of a Collaborative Storage Folder

General

" Policy Options
<§’ Assodations

Setup
-+ Provisioning Opti...
_: Target Path Opti...
m Quota Options
C—) Move Schedule

Dynamic Template
Cleanup

ﬁ Cleanup Cptions
@ Vault
¥ Groom

Other

Notes
E—'Bo Summary
E Copy Policy Data

Identity Policy Editor - Training Courses

= ] X

Folder Properties

Default Permissions DOS Attributes

[] Full Contral [ st [ ] set Attributes on Target Folder

[ ] Modify [ | Read Archive System Hidden

[ |Read and Execute || Write
Path Owner
() Built-n Administrators
() Associated Group
(&) Selected Identity  [CN=Mary Langella, OU=Employees, OU=NYC, 0L =57, DC=sp,DC=cctec,DC=0rg || mowse || clar
D Use Group Manager as Owner
Template Folder
|‘\'\sp.ccbec.org‘PubIic‘HQ\Gmups\"lqa"lare\Deparhﬂents‘ut deptifs_templates | E Browse I | Clear

[

1. Changes to this policy have not been saved.

The Selected Identity option is selected and the owner of the folder is set to Mary Langella.
The template is indicated in the Template Folder region.

You use the Group properties of Active Directory Users and Computers to indicate the group
owner in the Managed By screen. In this example, the owner is Mary Langella.
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Group Owner Specified in Managed By Page

MS Office Training Properties ? *
Object Security Attribute Editor
General Members Member Of Managed By
MName: |sp.cctec.orngPfNYD’Employees;’Mary Langella |
| Change.. | | Properties | | Clear |

[ Manager can update membership list

Office:

Strest:

City:
State/province:

Country/region:

Telephone number:

Fax number:

OK || cancel || Appy || Hep

Establishing an owner in the Name field enables the -MANAGER- object to function properly.

7.5.1 - Establishing Permissions

You establish the permissions specified for each of the folders in the second diagram under
Setting Up Security for a Collaborative Storage Template (page 68) through the Windows
Explorer Security tab. Permissions such as Traverse Folder, are special permissions.

To set special permissions:

In Windows Explorer, right-click the desired folder and select Properties.
Click the Security tab.

Click Advanced.

Click Change Permissions.

Click Add.

In the Enter the object name to selectfield, specify the name of the desired user or
group and click OK.

o gk~ w N =

7. Inthe new dialog box, use the Apply to drop-down menu to select the desired
application level, select the check boxes for all special permissions for the user or
group, and click OK.

7.5.2 - Configuring Permissions for the Group Manager

This procedure grants Manager permissions to the group’s designated manager, meaning that
he or she is given all permissions needed to view and modify any document within the
structure of the collaborative storage area.
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. Launch Windows Explorer.

In the file structure that you created earlier, browse to and right-click the topmost folder,
then select Properties.

For example, in the sample work project collaborative storage template example in the
first diagram under Setting Up Security for a Collaborative Storage Template (page 68),
the topmost folder would be the Project folder.

Click the Security tab.

Click Edit.

Click Add.

In the Enter the object names to selectfield, specify -MANAGER-.
Click Check Names.

Click OK.

In the Permissions dialog box, select the Modify check box and click OK to save the
settings.

Click OKto close the Properties dialog box.

7.5.3 - Configuring Permissions for the Group Members’ Personal
Folders

This procedure grants the permissions needed for group members to work in their personal
folders within the collaborative storage area.

1. Launch Windows Explorer.

N

10.

© ® N g kW

In the structure that you created under Creating a Collaborative Storage Template
(page 68), browse to and right-click the -MEMBER- folder, then select Properties.

Click the Security tab.

Click Edit.

Click Add.

In the Enter the object names to selectfield, specify -MEMBER-.
Click Check Names.

Click OK.

In the Permissions dialog box, select the Modify check box and click OK'to save the
settings.

Click OKto close the Properties dialog box.

7.5.4 - Configuring Group Member Permissions to Other Folders

This procedure grants List and Read permissions to other areas of the collaborative storage

area.

1.
2.

Launch Windows Explorer.

In the structure that you created under Creating a Collaborative Storage Template
(page 68), browse to and right-click one of the subfolders, then click Properties.
For example, in the sample work project collaborative storage template example in the
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first diagram under Setting Up Security for a Collaborative Storage Template (page 68),
a subfolder would be the Documents folder.

Click the Security tab.

Click Edit.

Click Add.

In the Enter the object names to selectfield, specify -MEMBER-.
Click Check Names.

Click OK.

Click OKto close the Properties dialog box.

© v x® N gk~

—_

Repeat Step 1 through Step 9 for each additional folder where you want to grant users
List and Read permissions.

7.6 - Understanding Collaborative Storage Policies

Before setting up Collaborative Storage policies, you need to understand the two types of
Collaborative Storage policies and the differences between the two.

A Group Collaborative Storage policy creates storage for a group when a Group object is
created in an organizational unit where the policy is associated. For example, if a cross-
functional team named HEALTHFAIR2018 is created in an organizational unit associated with
the Group Collaborative Storage policy, the collaborative storage area is created when the
group is created.

A Container Collaborative Storage policy grants access to collaborative storage when a new
User object is added to an organizational unit where the policy is associated. For example, if
user BSMITH is added to an organizational unit that had an associated Container policy,
BSMITH is granted access to the collaborative storage area. Furthermore, if the template
associated with the policy is structured with a -MEMBER- Group object, the user is given a
personal storage area within the collaborative storage area.

7.7 - Creating a Group Collaborative Storage Policy

1. Inthe Admin Client, click the Identity Driven tab.
2. Click Policies.

3. Inthe Manage menu, select New > Group Collaborative.
The following dialog box appears:

Create New Policy

Name | | |

Policy Type |Group Collaborative - |

4. Specify a descriptive name in the Name field.
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The Policy Options page appears.

5. Continue with the following.

7.7.1 - Setting Group Collaborative Storage Policy Options

Settings within Policy Options let you indicate how the policy is applied, set policy inheritance,
and write an expanded policy description.

Group Policies in File Dynamics are completely independent of Microsoft Group policies.

1. Leave the Process Events for Associated Managed Storage check box selected.
This indicates that you want the settings in this policy to be applied to all groups within
the organizational unit where this policy is assigned. Deselecting this check box
indicates that you want to create a Blocking policy that can be applied to a specific
group. For more information on blocking policies, see Creating a Blocking Policy (page

18).

2. Do one of the following:

« If you are assigning this policy to a container rather than a group, and you want
the settings to apply to subcontainers, leave the Policy applies to subcontainers
check box selected.

« If you are assigning this policy to a container, and you do not want the settings to
apply to subcontainers, deselect the Policy applies to subcontainers check box.

3. Inthe Description region, use the text field to specify a description of the policy you are
creating.

4. Click Applyto save your settings.
5. Proceed with Setting Group Collaborative Storage Policy Associations (page 75).

7.7.2 - Setting Group Collaborative Storage Policy Associations

The Associations page is where you assign the collaborative policy you are creating to a
organizational unit or group object.

1. Inthe left pane, click Associations.
2. Click Addto bring up the Directory Services Browser.

3. Browse through the directory structure and select the organizational unit or group object
you want to associate the policy to.

4. Drag the object to the Selected Items pane and click OK.
The Directory Services Browser is closed and the object is displayed in fully qualified
name format in the right pane of the window. For example,
OU=Groups, OU=Munich, DC=SP, DC=cctec, DC=org.

5. Click OKto close the Directory Services Browser.
6. Click Apply to save your settings.

7. Proceed with Setting Group Collaborative Storage Policy Provisioning Options (page

76).
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7.7.3 - Setting Group Collaborative Storage Policy Provisioning

Options

The Provisioning Options page is where you indicate collaborative storage permissions, the
location of a template for provisioning the collaborative storage folder structure and content in
a managed path when it is created, and more.

1. Inthe left pane, click Provisioning Options.
The following page appears:

General

Y Policy Options
6’ Assodations

Setup

" Provisioning Opti
_: Target Path Opti
m Quota Options

C—) Maove Schedule

Dynamic Template
Cleanup

ﬁ Cleanup Options

@ Vault

¥ Groom
Other

Motes
E‘ho Summary
E Copy Policy Data

Identity Policy Editor - NYC Departments

- [m] X

Folder Properties

Default Permissions DOS Attributes

D Ful Control D List D Set Attributes on Target Folder

|:| Modify D Read Archive System Hidden

| |Read and Execute || wurite
Path Owner
(@) Built4n Administrators
{_) Associated Group
() Selected Identity Browse Clear
|:| Use Group Manager as Owner o Owner will be assigned according to selection above when a group's manager is not set
Template Folder

| Browse Clear

-

2. Inthe Folder Properties region, select the desired permissions to be applied to the

target folder.

If you chose to create a Collaborative Storage template, the permissions will be applied
from the template that you created earlier under Configuring Permissions for the Group
Members’ Personal Folders (page 73) and Configuring Group Member Permissions to

Other Folders (page 73).

3. Inthe Path Ownerregion, select one of the following options:

¢ Built-in Administrator: If you want the owner of the storage to be the Built-in
Administrator, select this option.

» Associated Group: The associated group is the group whose folder you are
creating. If you want the associated group to own their own folder, select this

option.

» Selected Identity: If you want another object to be the owner of the folder,
browse and select the object.
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» Use Group Manager as Owner: To use the Active Directory Group Object
Manager as the owner, select this check box. If the manager is not found, File
Dynamics will use the option selected above.

In the field below the Override Path Owner check box, browse to indicate a path owner
(thatis, the owner of the group’s managed path).

In the Template Folderregion, click the Browse button and locate the folder structure
that you created under Creating a Collaborative Storage Template (page 68).

Select the topmost folder in the folder structure and click OK.

For example, if you had a structure similar to the Sample Classroom Collaborative
Storage Template in the first diagram under Setting Up Security for a Collaborative
Storage Template (page 68), you would select “8th Grade U.S. History.”

Click Apply to save your settings.
Proceed with Setting Group Collaborative Storage Policy Target Paths (page 77).

7.7.4 - Setting Group Collaborative Storage Policy Target Paths

The Target Paths page is where you set the paths to where the collaborative storage area for
this policy will be hosted.

1.
2.

In the left pane, click Target Path Options.
In the Managed Path Naming Attribute region, do one of the following:

e From the drop-down menu, select the single-value Active Directory attribute you
want as the means of naming your collaborative storage folders.

 Click Link Action Block and select a previously saved Action Block for the naming
attribute.

For some organizations, having the default sAMAccountName attribute as the means
of naming group home folders is not desirable. To allow File Dynamics to create a
collaborative storage folder with a name you can define, you can select a different
attribute from the drop-down list.

sAMACcountMame -

comment &

company
department
desktopProfile
division

employeelD L4

Once you have saved the policy, you can use an account provisioning system such as
NetlQ Identity Manager to automatically populate the selected attribute with the desired
folder name and then File Dynamics will automatically provision the group home folder
based on this attribute setting.
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78

For existing groups whose collaborative storage folders you would like to change to a
new attribute value, you would follow the same procedures, followed by performing an
Enforce Policy Path Management Action.

For specifications pertaining to Managed Path Naming Attribute, see Managed Path
Naming Attribute Specifications (page 259).

In the Target Placementregion, select a option from the Distribution drop-down menu.

If you create more than one target path for a policy, you can indicate any of the following
options:

Random: Distributes storage randomly among the number of target paths.

Actual Free Space: Distributes the creation of collaborative storage folders according
to shares with the largest amount of absolute free space. For example, if you have two
target paths listed, target path 1 has 15 GB of free space, and target path 2 has 10 GB,
the collaborative storage folders are created using target path 1.

Percentage Free Space: Distributes the creation of collaborative storage folders to
shares with the largest percentage of free space. For example, if you have two target
paths listed and target path 1is to a 10 TB drive that has 30 percent free space, and
target path 2 is to a 500 GB drive with 40 percent free space, the collaborative storage
folders are created using target path 2, even though target path 1 has more absolute
available disk space. You should be cautious when using this option with target paths to
shares of different sizes.

. From the Leveling drop-down menu, choose an option.

This setting is used to structure the group home folders so that they are categorized by
the first or last letter of a group name through a subordinate folder. For example, if you
choose First Letter, and the Leveling Lengthfield is setto 1, a group named
Engineering has a home folder located in a path such as \ \SERVER1-DNS-
NAME\GROUPS\E\Engineering.

The Last Letter means the last character of the attribute File Dynamics uses to create
storage.

The Leveling Length field allows you to enter up to 4 characters. This makes it so that
you can organize folders by year. For example, if your Leveling Algorithm setting is Lirst
Letter, and the Leveling Length setting is 4, a group named Engineering has a home
folder located in a path such as \ \SERVER-DNS-
NAME\GROUPS\Engi\Engineering.

5. For each target path that you want to establish, click Addto access the Path Browser.
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6. Browse to the location of the target path you want and click Add to add the target path to
the Selected Paths pane.

File System Path Browser x

= MNew Folder ‘/' Rename Folder _Fb Update Resources - G Refresh o= Add == Remove

Selected Paths
V\sp.cctec.org\Public\NYC\WYCShare\Departme...

|Enter text to search... | | Find |

v /\ sp.cctecoorg
w sp.cctec.org

L_ Atlanta

HQ

Londaon

MNYC

T3 NYCShare

~ T Departments
> T INYC Marketing
» T Training

>
>
¥
~

< Wit

bl srs-ml.sp.cctec.org
> srs-m3.sp.cctec.org

oK | | Cancel

Visp.cctec.orghPublicNYC\NYCShare\ Departments\MYC Marketing

7. Click Apply to save your settings.
8. Proceed to Setting Group Collaborative Storage Policy Quota Options (page 79).

7.7.5 - Setting Group Collaborative Storage Policy Quota Options

This page lets you establish storage quota settings for the group collaborative storage folder.
Until quota management is established, a collaborative storage area has unlimited space.
Quota management for collaborative storage applies to:

e The quota for the entire storage folder

¢ Quotas for personal folders in the collaborative storage folder

In order for the quota to be managed on a personal folder, you must also manage the quota on
the -MANAGER- or -MEMBER- folder. You can set this in the template through the Windows
Server Manager in the same way you set the folder options.

Quota management on NAS devices needs to be managed by the NAS vendor software.

This page is also where you establish quota management settings for quota managers. A
quota manager is a specified user or group who is granted the ability to increase quotas
without having rights to the file system. Quota management actions are performed through
Quota Manager, which is a separate web browser-based management interface. For more
information on Quota Manager, see Using Quota Manager (page 101).
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1.

In the left pane, click Quota Options.
The following page appears:

Identity Policy Editor - NYC Marketing — O b4
General Quota
| Enabled
y Policy Options
6) e (@) Unlimited
Ot e

Setup

+" Provisioning Opti Quota Management

S paloey Enable Quota Manager [ Quota Preservation for this policy

m Quota Options Maxi " nt
(© Move Schedule
Dyniamic Template (®) No Maximum Quota () Set Quota Increment Manually
() Maximum Quota VE (#) Increment Quota by MB

Cleanup

[Tj Cleanup Options Quota Managers

Vault
@ == Add == Remove
X Groom
| Manager -

Other

Motes

E’ho Summary

E“ Copy Policy Data

it

2. Select the Enabled check box to enable an initial storage quota for collaborative storage

paths managed by this policy.
In the MB field, specify the initial storage quota for the collaborative storage folders.

Set up quota managers by filling in the following fields:

Enable Quota Manager / Quota Preservation for this Policy: Select this check box to
enable the Quota Management region of the page.

Quota Maximum: Indicate whether the collaborative storage folders associated with
this policy will have a maximum quota setting. If so, indicate the maximum quota.

Quota Increment: Indicate whether quota managers will set quotas manually or in set
increments. If you select manual increments, the quota manager can increase the quota
in any increment until it meets the maximum quota setting. If you select set increments,
the quota manager can only increase the quota by the increment setting.

Quota Managers: Click Add and use the Directory Services Browser to browse to and
select a user or group you want to be a quota manager, then drag the User or Group
object to the right pane. Repeat this for each user or group you want to be a quota
manager.

If you do not specify a user or group as a quota manager, only members of the File
Dynamics Admins group will be able to use the Quota Manager web insterface.
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5. Click Apply to save your settings.
6. Proceed with Setting the Group Collaborative Storage Policy Move Schedule (page 81).

7.7.6 - Setting the Group Collaborative Storage Policy Move Schedule

This page lets you use a grid to specify when data can be moved.

By default, all days and times are available for data movement. If data movement during
regular business hours creates unacceptable network performance, you can choose to move
data after regular business hours.

The collaborative storage folder will not move if there are any open files. Until the folder can be
moved, the Move event will be listed as a pending event.

1. Inthe left pane, click Move Schedule.

2. Inthe Data Move Schedule grid, click the squares for the day and hour you want to
disable for data movement.

3. Click Apply to save your settings.

4. Proceed with Setting Group Collaborative Storage Policy Dynamic Template
Processing (page 81).

7.7.7 - Setting Group Collaborative Storage Policy Dynamic Template
Processing

Dynamic Template Processing is the term used in File Dynamics for creating personal folders
in a collaborative storage folder. If Dynamic Template Processing is enabled, creating a -
MEMBER- or -MANAGER- folder in the collaborative storage file structure automates the
management of personal storage within the collaborative storage when a user is added,
deleted, or renamed in Active Directory.

1. Inthe left pane, click Dynamic Template.
The following page appears:
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Identity Palicy Editor - NYC Marketing = O X
namic Template Processil
General B na
Enable Dynamic Template Processing
Y Policy Options
<§> Assodiations (®) Do not limit folder search depth
__ Limit folder search to a depth of 2

Setup C v

+ Provisioning Opti Process members of nested groups

L TargetPath Opti ["] Process members of manager group

m Quota Options || 1gnore Hidden attribute on dynamic template
G—) Move Schedule

Dynamic Template
Cleanup

ﬁ Cleanup Options

@ Vault

¥ Groom
Other

Motes
E‘ho Summary
E Copy Palicy Data

ot

Do one of the following:

« If the folder structure in your collaborative storage template includes a -MEMBER-
folder, File Dynamics can create personal folders within the collaborative storage
folder. Leave the Enable Dynamic Template Processing check box selected and
proceed with Step 3.

 If your collaborative storage template does not include a -MEMBER- folder, File
Dynamics will not create personal folders within the collaborative storage folder.
Deselect the Enable Dynamic Template Processing check box and proceed with
Setting Group Collaborative Storage Policy Cleanup Options (page 83).

Choose one of the following options:

* Do not limit folder search depth: The Engine searches through the collaborative
storage folder looking for -GROUP-, ~-MANAGER-, and -MEMBER- folders.
Depending on the number of folders in the collaborative storage folder, this can
take significant time. It is therefore best to not select this option.

« Limit folder search to a depth of: If you know the maximum level where the -
GROUP-, -MEMBER-, and -MANAGER- folders are located in your collaborative
storage template, you can select this option and indicate the level. For example,
in the Sample Classroom Collaborative Storage Template under Setting Up
Security for a Collaborative Storage Template (page 68), the -MEMBER- folder is
located four levels down.

Select the applicable check boxes:
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Process members of nested groups: If you have nested groups in your Active
Directory deployment, selecting this check box creates personal storage for group
members that are part of a group via group nesting.

Ignore hidden attribute on dynamic template: Selecting this check box ignores the
Hidden DOS attribute on the -MEMBER-, -MANAGER-, and -GROUP- folders in the
collaborative managed path when provisioning the corresponding folder for the user or
group. Thus, the Dynamic Template Processing folder will not have the Hidden
DOS attribute set when it is created.

5. Click Apply to save your settings.
6. Proceed with Setting Group Collaborative Storage Policy Cleanup Options (page 83)

7.7.8 - Setting Group Collaborative Storage Policy Cleanup Options

This page lets you enable and specify cleanup rules for the Group Collaborative Storage
policy. Options for cleanup include deleting a collaborative storage folder after a set number of
days following the removal of the associated Group object from Active Directory, or vaulting
(rather than deleting) the collaborative storage folder.

1. Inthe left pane, click Cleanup Options.

2. Enable storage cleanup by filling in the following fields:
Enable: Select this check box to enable storage cleanup rules.

Cleanup storage: Specify the number of days, weeks, or years a collaborative storage
folder remains after the associated Group object is removed from Active Directory.

3. Enable Vault on Delete by filling in the following fields:
Enable: Select this check box to enable Vault on Delete.

Vault Path: Click Browse to browse and select the path where you want the
collaborative storage folders vaulted after cleanup.

When you indicate this path, it also appears in the Vault Path field of the Groom page,
because groom rules and vault rules share the same vault path.

4. Click Applyto save the settings.
5. Proceed with Setting Group Collaborative Storage Policy Vault Rules (page 83).

7.7.9 - Setting Group Collaborative Storage Policy Vault Rules

When a Group object is removed from Active Directory, you can have File Dynamics vault the
contents of the associated collaborative storage folder from primary storage to less expensive
secondary storage. File Dynamics lets you specify what to vault or delete by using vault rules.
For example, you might want to remove all . tmp files before vaulting the collaborative storage
folder. Or, you might want to vault only a single folder, such as Final Proposal and nothing
else in the other folders. You accomplish all of this through settings in the Vault Rule Editor.

1. Inthe left pane, click Vault.
The Vault Path field displays the vault path that you established when you set up
collaborative storage cleanup rules.
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2.

3.

Click Addto bring up the Vault Rule Editor.

Rule Editor X
Description ||
Action I:I (e Files () Folders
Masks
* Only one Mask per line
Comparative Criteria Mumeric Criteria Unit

File Size Filter | [Disabled] - Any Size - | | 0 | | | | Reset |
Create Time Filter | [Disabled] - Any Size - | | 0 | | | | Reset |
Madify Time Filter | [Disabled] - Any Size -1 E| || meset |
Access Time Filter | [Disabled] - Any Size - | | 0 | | | | Reset |
| oK | | Cancel |

In the Description field, specify a description of the vault rule.
For example, “Files to delete before vaulting,” or “Files to vault.”

From the Action menu, select an action.

Select whether the rule will vault files or folders, delete files or folders, or ignore a vault
rule.

There is only one action for each vault rule. For example, if you wanted to delete some
files and vault others, you would need to establish two different vault rules.

Vault: Moves all of the files or folders that meet the criteria specified in the vault rule to a
location specified in the policy.

Delete: Deletes all of the files or folders that meet the criteria specified in the vault rule.

Ignore: Ignores the conditions that would normally vault or delete a file or folder, based
on specifications you provide in the Mask field.

For example, if you wanted to vault all . MOV files, with the exception or approved
training videos located in a folder named Training Videos, you could set an
individual rule to vault . MOV files, and another rule to ignore vaulting the Training
Videos folder.

Selecting Folders disables the filter settings in the lower portion of the Rule Editor.
File or folder names can contain an asterisk.
Specify whether the rule will apply to files or folders.

Files: If the vault rule you are creating will vault, delete, or ignore content at the file
level, leave the File option selected.
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Folders: If the vault rule you are creating will vault, delete, or ignore content at the folder
level, select the Folders option.

Specify the masks for the rule.

Masks: List the files or folders you want to be vaulted or deleted, according to what is
indicated in the Action drop-down menu. For example, if you wanted to delete all
temporary files, you could list * . TMP in the Masks field.

Be aware that if you select Vault, only the files or folders that you list in the Masks text
box are vaulted and the remainder of the managed path content is deleted. Conversely,
if you select Delete, only the files or folders that you list in the Masks text box are
deleted, and everything else is vaulted.

(Conditional) If the rule you are creating is specific to files, complete the applicable filter
settings.

Leaving the setting as [Disabled]-Any Size vaults or deletes all file types listed in the
Masks text box, according to what is indicated in the Action drop-down menu. Choosing
any of the other options from the drop-down menu lets you indicate files to delete or
vault according to size, when created, when last modified, and when last accessed.

8. Click OK'to save the vault rule.

10.

11.

If necessary, create any needed additional vault rules by repeating the procedures
above.

(Conditional) If you have set any rules designed to ignore a vault or delete action, in the
Vault on Delete region of the Vault page, use the Promote arrow to move the rule to the
top. This protects files or folders specified in the Masks field from being vaulted or
deleted.|

Vault on Delete Rules Ex*Vault on Delete Rules
P
Add == Delete /" Edit | AN Promote W Demote ¢4 Link Action Block ¢ Unlink Action Block
Description | Action | Masks File Size Create Time | Modify Time | Access Time
Approved Video Fal... | Ignore Folders \Training Videos
= mov
Vault non-approved | Vault Files = avi Any Any Any Any
Delete old temp files  Delete Files = tmp Any Any == 2 weeks Any

Proceed with Setting Group Collaborative Storage Policy Groom Rules (page 85)

7.7.10 - Setting Group Collaborative Storage Policy Groom Rules

Groom rules in File Dynamics specify the file types that you want to be removed from primary
managed storage. Examples of these might be mp3 and mp4 files, mov files, and many others.
You specify in a groom rule whether to delete or vault a file based on the rule's criteria.

Grooming takes place as a Management Action that is run by the administrator. A
Management Action is a manual action that is enacted through the Admin Client. For more
information, see Management Actions (page 182).

You might notice the nearly identical look of the Vault and Groom pages, including the Rule
Editors. You might naturally wonder what the differences are between a Vault rule and Groom
rule. A Vault rule is enacted automatically when a User or Group object with managed storage
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is deleted from Active Directory. A Groom rule is enacted by a Management Action performed
by the administrator.

For an explanation of the fields and procedures for setting up a Groom rule, refer to Setting
Group Collaborative Storage Policy Vault Rules (page 83).

7.8 - Creating a Container Collaborative Storage Policy

1.

In the Admin Client, click the Identity Driven tab.

2. Click Policies.

3. Inthe Manage menu, select New > Container Collaborative.

5.

The following dialog box appears:

Create New Policy

MName | |

Policy Type | Container Collaborative '|

Specify a name in the Name field.
The Policy Options page appears.

Continue with Setting Container Collaborative Storage Policy Options.

7.8.1 - Setting Container Collaborative Storage Policy Options

Settings within Policy Options let you indicate how the policy is applied and lets you write an
expanded policy description.
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1.

Leave the Process Events for Associated Managed Storage check box selected.

In this example, the Collaborative Storage policy will apply to a container object.
However, it could apply to the parents’ container thus making it applicable to all existing
and new containers located therein. Deselecting this check box indicates that you want
to create a Blocking policy. For more information on blocking policies, see Creating a
Blocking Policy (page 18).

In the Description region, specify a description of the policy you are creating in the text
field.

Click Apply to save your settings.

4. Select the options and setting that you want to policy to use:

Associations: The Associations page is identical to the Associations page presented
when you create a Group Collaborative Storage policy. For an explanation of the page,
along with procedures for setting associations, see Setting Group Collaborative Storage

Policy Associations (page 75).

Provisioning Options: The fields presented on the Provisioning Options page are
identical to those presented when you create a Group Collaborative Storage policy. For


../../../../../../Content/admin/collaborative-storage/Setting Container Collaborative Storage Policy Options.htm

7 - Managing Collaborative Storage

an explanation of the page, along with procedures for setting provisioning options, see
Setting Group Collaborative Storage Policy Provisioning Options (page 76).

Target Path Options: The fields presented on the Target Path Options page are
identical to those presented when you create a Group Collaborative Storage policy. For
an explanation of the page, along with procedures for setting target paths, see Setting
Group Collaborative Storage Policy Target Paths (page 77).

Quota Options: The fields presented on the Quota Options page are identical to those
presented when you create a Group Collaborative Storage policy. For an explanation of
the page, along with procedures for setting quota options, see Setting Group
Collaborative Storage Policy Quota Options (page 79).

Move Schedule: The fields presented in the Move Schedule page are identical to those
presented when you create a Group Collaborative Storage policy. For an explanation of
the page, along with procedures for setting the move schedule, see Setting the Group
Collaborative Storage Policy Move Schedule (page 81).

Dynamic Template: The fields presented on the Dynamic Template page are identical
to those presented when you create a Group Collaborative Storage policy. For an
explanation of the page, along with procedures for setting the move schedule, see
Setting Group Collaborative Storage Policy Dynamic Template Processing (page 81).

Cleanup Options: The fields presented on the Cleanup Options page are identical to
those presented when you create a Group Collaborative Storage policy. For an
explanation of the page, along with procedures for setting cleanup options, see Setting
Group Collaborative Storage Policy Cleanup Options (page 83).

Vault: The fields presented on the Vault page are identical to those presented when you
create a Group Collaborative Storage policy. For an explanation of the page, along with
procedures for setting vault rules, see Setting Group Collaborative Storage Policy Vault
Rules (page 83).

Groom: The fields presented on the Groom page are identical to those presented when
you create a Group Collaborative Storage policy. For an explanation of the page, along
with procedures for setting grooming rules, see Setting Group Collaborative Storage
Policy Groom Rules (page 85).

5. Click Apply to save your settings.

7.9 - Creating a Multi-Principal Collaborative Storage Policy

This section provides details for understanding and creating Multi-Principal Collaborative
storage policies.

7.9.1 - Multi-Principal Collaborative Storage Policy Overview

File Dynamics provides the ability to provision and manage folders that can be owned by
multiple Active Directory security groups. Each group’s access to these folders is dependent
on the security group object’s security principal. For example, one group’s access could be
Read-Only, another’s could Read/Write, and another’s could be Full Control. Based on their
support for multiple security principals, these folders are known as “Multi-Principal Managed
Paths,” and they are issued through “Multi-Principal Collaborative Storage” policies.
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Multi-Principal Managed Paths are owned and accessed by security groups with the same
group prefix name separated by a suffix separator, and then distinguished by a unique security
separator. In the figure below for example, the managed path Group1 is owned by both
Group1-RO and Group1-RW, with the members of each group having Read Only and Read
Write permissions respectively.

Example of a Multi-Principal Managed Path

]
-r.‘;.

Resd-Onby ACE w m
v "

- Group1-RO

L
L Read-Writs ACE irili

Groupl-RW

7.9.2 - Group Naming Parameters

Security groups that own and access a Multi-Principal Path must be in the Group Prefix
Name-Security Suffix format. Inthe table below, the naming components of the
security group names in the figure under Multi-Principal Collaborative Storage Policy
Overview (page 87) are identified.

Group Prefix Name Suffix Separator Security Suffix
Group1 - RO
Group1 - RW

The group prefix names cannot be different. For example, you cannot have Accounting-RW
and Sales-RO groups managed by a Multi-Principal Collaborative policy against the same
managed path. Multiple groups are considered to be participating in the security of the
managed path if they have the same group prefix name up to the well-defined suffix separator
string. The suffix separator can be a character or a string of characters and is configured in a
Multi-Principal Suffix Mapping Action Block.

7.9.3 - Multi-Principal Collaborative Policies

The change in paradigm to support Multi-Principal Managed Paths requires the introduction of
a new Multi-Principal Collaborative policy type. The policy follows the standard association
rules to support effective policy calculation. This means that the policy can be associated to a
container or directly to security groups.

88



7 - Managing Collaborative Storage

The new policy type provides the ability to link to a Multi-Principal Suffix Mapping Action Block
where the separator character or string sequence that differentiates the group’s name from its
security suffix.

7.9.4 - Multi-Principal Collaborative Events

To handle the constraints on the managed path imposed from multiple security principals
managing a folder, new provisioning and de-provisioning events have been introduced. The
primary reason for this is that provisioned managed paths for the Multi-Principal Collaborative
policy can be thought of as referenced-counted based on the number of participating security
groups. For instance, if Group1-RW, Group1-RO, and Group1-A all have active ACEs on the
managed path, then the reference-count for the managed path is 3 and deletion of only one of
these groups does not imply deletion of the folder as a whole. Rather, when any given security
principal is deleted or moved out of policy scope, the corresponding event needs to scan the
corresponding Active Directory container to look for the presence of any other groups by the
group name prefix. If none exist, then the folder can potentially be scheduled for cleanup,
otherwise no action is taken, except for when the ACE is removed.

Similarly, for provisioning, the first group for which an event is received would be responsible
for creating the folder based on the group name prefix and assigning its respective rights. Any
other events for complimentary groups must perform the equivalent of an apply permissions
(ACE) in order to populate their respective transform entries. This allows for a flexible
implementation that does not require a base security principal to be created first.

7.9.5 - Create a Multi-Principal Collaborative Storage Policy

Follow the prerequisites and procedures in the following sections to create a Multi-Principal
Collaborative Storage policy.

Prerequisites for a Multi-Principal Collaborative Storage Policy

¢ Structure Active Directory in a logical manner for the new groups that you will be
creating.

For example, a division of a company has many departments with complex
permissions. For instance, the Accounting Department might have a group of
individuals that need Read/Write permissions, while another group needs Read Only.

~ Managed Storage
Accounting
Information Technology
Logistics
Quality Control
Service

e Structure your network file system so that there is a storage area that will host the
collaborative storage for the new groups.

As an example, the file system might look like this:

v Managed Storage

Accounting
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Create a Multi-Principal Suffix Mapping Action Block

Managing Collaborative Storage

This procedure lets you standardize the groups and their associated permissions for the

collaborative storage folders that will be provisioned by File Dynamics.
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1. Inthe Admin Client, click the Identity Driven tab.
2. Click Action Blocks.
From the Manage menu, select New > Multi-Principal Suffix Mapping.

Create New Multi-Principal Suffix Mapping Action Block

Name | |

o
4. Enter a descriptive name for the new Action Block and click OK.
The following page appears:
Action Block Editor - Multi-principal suffix mapping — O
General Multi-Principal Suffix Settings
3 Multi-Principal Suffix Settin. i |I
E} Options Suffox Mappings
¢§> Linked Policies = Add == Remove
Security Suffix
OK | | Cancel | | Apply
A, Changes to this Action Block have not been saved.
5. Click Add.

In the Security Suffix column, highlight SampleSecuritySuffix and edit it to a more
descriptive name of a group that will access the collaborative storage folder.

For example: Shipping.

7. Click the Full Control setting to access a drop-down menu of access permissions.
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8. Specify the permissions for the particular group and click OK.

Action Block Editor - Multi-principal suffix mapping = O *
Multi-Principal Suffix Settings
General =]
3 Multi-Principal Suffix Settin. i |_
E\' Options Suffix Mappings
<§> Linked Policies = Add == Remove
Security Suffix - ‘ Permission
F Full Control -
M Full Contral
RO [ modify
R D Read & Execute
[st
|:| Read
[ write
OK | | Cancel | | Apply

1, Changes to this Action Block have not been saved.

9. Repeat Step 5 through Step 8 to create all groups and permissions to the collaborative
storage folder.

Action Block Editor - Multi-Principal Suffix Mapping

General Multi-Principal Suffix Settings

§ Mutti-Principal Suffix Settings
Eli Options
(f’ Linked Policies

Suffix Separator

Suffix Mappings
= Add == Remove

Security Suffix =  Permission
F Full Cantrol

M Modify

RO Read & Execute

RW Read & Execute, Read, Write

10. Click Apply.
11. Click OK.
Create a New Multi-Principal Collaborative Storage Policy

1. Inthe Admin Client, click the Identity Driven tab.
2. Click Policies.
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3. Inthe Manage menu, select New > Group Multi-Principal Collaborative.
The following dialog box appears:

Create New Policy

Name | | |

Policy Type |Group Multi-Principal Collaborative - |

4. Specify a descriptive name in the Name field and click OK.

5. Proceed with Setting Policy Options (page 92).

Setting Policy Options

1. Verify that the Process Events for Associated Managed Storage check box is selected.
2. Verify that the Policy applies to subcontainers check box is selected.

3. (Optional) Enter an expanded description of the policy in the Description field.

4. Proceed with Setting Associations (page 92)

Setting Associations

1. Click Associations.
Click Add.

In the browser, locate the organizational unit where the group objects will reside and
drag it to the right pane.

Directory Services Browser *

D Search G Refresh o= Add == Remove

v /\ sp.cctecoorg | * ||| Selected Object

> Builtin OU=Managed Storage,0U=HQ,0U=...
Computers

Domain Controllers
ForeignSecurityPrincipals
Keys

Managed Service Accounts
Program Data

Service Accounts

5P

Atlanta

HQ

‘fg Employees

f= Groups

?g Inactive Employees
= {Managed Storage
fa Training

London

Munich

NYC

SFO

L v
¢ v 60 EED e eED GED AET GED 6B

G0 ERT BEC BRT BET v v v v v EET AR

W W W

Spedial Groups
- [-]

[ox ]| caneel
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5. Proceed with Setting Provisioning Options (page 93).

Setting Provisioning Options

1.

Click Provisioning Options.

2. Click Link Action Block, select the Action Block you created earlier, and click OK.

5.

General

“ Policy Options
6’ Assodations

Setup

" Provisioning Opti
_-:_ Target Path Opti
m Quota Options

C—) Maove Schedule

Cleanup

[Tj Cleanup Options

@ Vault
X Groom

Other

Motes
E‘bo Summary
E Copy Policy Data

Identity Policy Editor - HQ Managed Storage

[m] X

Multi-Principal Suffix Settings E::Muln-pnncipa\ suffix mapping
Suffix Separator l:l gﬂ, Link Action Block @ Unlink Action Block
Suffix Mappings
Add == Remove
Security Suffix a | Permission
F Full Control
M Modify, Read & Execute, List, Read, Write
RO Read & Execute, List, Read
R Read & Execute, List, Read, Write

Folder Properties
DOS Attributes

[ ] set Attributes on Target Folder
Archive System Hidden

Path Owner

(®) Built-n Administrators

() Selected Identity

Template Folder

Browse

Clear

| | Browse

‘ | Clear |

1. Changes to this policy have not been saved.

oK ‘ ‘ Cancel

|| ooy |

In the Path Ownerregion of the page, click Browse and browse to specify an owner of
all of the collaborative storage folders that will be created with this policy.

(Optional) In the Template Folderregion, click Browse to specify a template for the
collaborative storage folders that will be created by this policy.

Proceed with Setting the Target Path (page 93).

Setting the Target Path

1.
2.

Click Target Path Options.

In the Target Paths region of the page, click Add.
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3. Inthe browser, locate the share or folder where the collaborative storage folders will
reside and drag it to the right pane.

File System Path Browser x
= New Folder ‘/' Rename Folder _Fb Update Resources - G Refresh o= Add == Remove
Selected Paths
Enter text to search... | | Find | -
V\sp.cctec.org\Public\HQ\GroupsthgshareMan. ..
» T3 Engineering |Z|
» [ Finance Dept
> [ Finance Managers
> T3 HQEmployees
» B3 HQ Marketing -
» 5 HQ Sales
v [ hgshare
> [ Departments
5 T Managed Storage

> [ HR Dept
> T IT Administrators
» [ IT Helpdesk
» 5 IT Suppert
> [ Legal Department
> B3 Medical
> [ Project Managers
» T3 Risk Management
» @ Training

» : London -

> e B

oK | | Cancel
Wsp.cctec.org\Public\HQ\Groups\hgshare\Managed Storage

4. Click OKto close the browser.
5. Click Apply.
6. Proceed with Setting Cleanup Options (page 94)

Setting Cleanup Options

1. Inthe Vault on Delete region, select the Enable check box.
Click Browse.

In the browser, locate the share or folder where deleted folders will be archived once all
of the groups that own a collaborative storage folder have been deleted and click OK.

4. Click Apply.
5. Click OKto close the Policy Editor.
6. Proceed with Testing the Policy (page 94).

Testing the Policy

These procedures let you verify that the policy is functioning as you designed it.

1. In one of the organizational units associated with the new Multi-Principal Collaborative
Storage policy, create a new group that includes a - and one of the security suffixes you
established earlier.
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New Object - Group

a Createin:  sp.cctec.org/SP/HQ/Managed Storage

X

Group name:

Accounting-RO|

Group name (pre-Windows 2000):

Accounting-RO

Group scope Group type

© Domain local (®) Security
(®) Global () Distribution

() Universal

OK

Cancel
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2. Inthe same organizational unit, and using the same group prefix name and suffix
separator, create additional groups for each of the security suffixes you created earlier.

> [E
v

>

v oV v v

Saved Queries
sp.cctecorg
| Builtin
:j Computers
2| Domain Controllers
| ForeignSecurityPrincipals
1 Keys
| LostAndFound
1 Managed Service Accounts
| Program Data
_3j Service Accounts
=l sp
» (2] Atlanta
v 2] Ha
> (3] Employees
> [ Groups
> (2] Inactive Employees
|3 Managed Storage
> = Training
> 121 London
> (2] Munich
» [E1 NYC
> 137 SFO

%Accounting—RO

52 Accounting-RW
mlnformaticn Technology-RW
B2 Logistics-RO

2 | ogistics-RW

mQuality Control-RO

2 Quality Control-RW

2 service-M

2 Service-RO

52 service-RW

Security Group - Global
Security Group - Global
Security Group - Global
Security Group - Global
Security Group - Global
Security Group - Global
Security Group - Global
Security Group - Global
Security Group - Global
Security Group - Global

] Active Directory Users and Computers — O X
File Action View Help

e 7@ 0 Bcd= Hm 3aEaTahR

j Active Directory Users and Compu ~ || Name Type Description

3. Using File Explorer, verify that each of the collaborative storage folders were created.

| = | Managed Storage
Home Share View
&« v g <« sp.cctecorg » public » HQ » Groups * hgshare » Managed Storage ~ O
ol Name Date modified Type Size
» it Quick access
Accounting 472472023 6:39 PM File folder
> @ OneDrive - Persor Information Technology 4/24/20236:36 PM  File folder
v ! This PC Logistics 472472023 6:36 PM File folder
. Quality Control 472472023 6:36 PM File folder
> J 3D Objects X X
Service 472472023 6:36 PM File folder
> [ Desktop
> Documents
> < Downloads
» b Music
5[] Pictures
> @ Videos
7 i Local Disk ()
> awm dedup (E) v
5items

[m]

Search Managed Storage

v @
r
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4. While still in File Explorer, verify that the permissions for each of the groups are correct.

Accounting Properties

Previous Versions
General

Group or user names:

Customize Classffication
Sharing Security

Object name:  E:\Shares\HQ\Groups‘\hgshareManaged Storage

X

<

S2 SrsProxyRights (SP\SrsProxyRights)

Accounting-RO (SP\Accounting-RO)
82 Accounting-RW (SP\Accounting-RW)
B2 Administrators (SRS-M1\Administrators)

To change pemissions, click Edit.

Pemissions for Accounting-RO Allow Deny

Full control

Modify

Read & execute
List folder contents
Read

Write

Special permissions

click Advanced.

For special permissions or advanced settings,

OK Cancel

et |
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Accounting Properties X
Previous Versions Customize Classffication
General Sharing Security

Object name:  E:\Shares\HQ\Groups‘hgshareManaged Storage

G’OUP Oor user names:

$2 SrsProxyRights (SP\SrsProxyRights) o
82 Accounting-RO (SP\Accounting-R0)

Accounting-RW (SP\Accounting-RW)

82 Administrators (SRS-M1\Administrators)

< >

To change pemissions, click Edit. \Eﬂ;

Pemissions for Accounting-RW Allow Deny

Full control A
Modify

Read & execute
List folder contents
Read

Write

Special pemmissions W

For special pemissions or advanced settings, — ]
click Advanced. Adv

AANANEN

| oK | Cancel | Aopy

5. Once you have verified that the Multi-Principal Collaborative Storage policy is creating
collaborative storage with the correct access permissions for the various groups, create
the remaining groups in all of the organizational units associated with the new Multi-
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Principal Collaborative Storage policy.

v = | Managed Storage — O X
g g

Home Share View ~ o
= % Cut 7 New item ~
@» U
= X =]
» 20 -

!_, Open ~ [ Selectall

W] Copy path fj Easy access ~ Edit | Select none
Pinatcoci;lick Copy  Paste [8] Paste shortcut I\ilnu\ie {tzpvy Delvete Rename fl:lz\gr Pmp;erlies EE‘ (.
Clipboard Organize New Open Select
&« v T > ThisPC » (E) » Shares > HQ » Groups » hgshare > Managed Storage v U Search Managed Storage p
Engineering " Name h Date modified Type
Finanace Accounting 4/24/2003 6:39PM File folder
it dept Information Technology 4/24/2023 6:36 PM File folder
Marketing Logistics 4/24/2023 6:36 PM File folder
Medical Quality Control 4/24/2023 6:36 PM File folder
Sales Service 4/24/2023 6:36 PM File folder
Training
Managed Storage
Accounting
Information Technology
Logistics
Quality Control
Service v <

5 items State: 2& Shared
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8 - Using Quota Manager

Using Quota Manager

Quota Manager is a separate management interface for designated users, such as help desk
or support personnel, to adjust user home folder or collaborative storage quota without
needing permissions to the file system.

Quota Manager can also provide storage information such as the total number of files and file
types in a managed path. With this type of information, the help desk or support representative
can make suggestions for freeing up space in the managed path rather than simply granting
additional storage quota.

8.1 - Quota Management Prerequisites

1.

Using the Admin Client, verify that all of the policies managing the users for whom you
want to manage quotas through Quota Manager have the Enable Quota Manager
check box selected, with a Quota Maximum and/or Quota Increment setting.

Identity Policy Editor - Atlanta Users — O b4
General Queta
| Enabled
ﬂ Policy Options
<§) e ey () Unlimited
== Auxiiary Polides (8] Quota 10240 7| B
SEtuD Quota Management

O ey ErE Enable Quota Manager [ Quota Preservation for this policy

_-__ Target Path Opti

- Quota Maximum Quota Increment
m Quots Options
(© Move Schedie (L) No Maximum Quota () Set Quota Increment Manually
(®) Maximum Quots 20480 | ME (®)increment Guota by! 1 *| mp
Cleanup
|]_ﬁ Cleanup Options Quota Managers
Vault
@ + Add == Remove
X Groom
| Manager -
Other 2k SP\Atanta Helpdesk
Motes
E’“o Summary

E Copy Paolicy Data

oK ‘ ‘ Cancel | | Apply |

1, Changes to this policy have not been saved.

Verify that you have users or groups listed in the list box in the Quota Managers region
of the page.

101



8 - Using Quota Manager

8.2 - Managing Quotas Through Quota Manager

1. Launch a web browser.

2. Enter the following address: https://ip-address-or-dns—-name-of-engine-
server:3009/gm

3. (Conditional) If a message appears informing you that the connection is not trusted,
proceed by adding the security exception and downloading the certificate.
The following screen appears:

opentext- | File Dynamics

Username

4. Enter a username and password and click Login.

The username and password must correspond to a user that has been designated as a
quota manager either directly or through a group association.
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The username must be in Domain\Account or User Principal Name format such as
domain\user Oruser@full.domain.com.

opentext” | File D i Signed in as sp\administrator  LOGO

QUOTA MANAGER SEARCH CRITERIA

This form provides the ability fo manage quota based on defined policy rules.

Enter the name of the user, group, or container for which you would like to manage quota:

Object(s):

Display Options
Name Type: User Object Options:

O DisplayName (User objects only)
® Eny. O Domain\SAM (User objects only)

Filter Options unchecking all will defautt o a list of objects of all types
User Storage: Group Storage: Container Storage:

O Home Folder O Home Folder O Home Folder
O Remote Desktop Home Folder
O Auxiliary Storage

SUBI

Copyright Condrey Corporation

5. Inthe Object(s)field, specify a user, group, or container name, or use an asterisk (*).
In large networks, building a list through the asterisk can be time consuming.

6. Specify your display and filter preferences in the corresponding regions.
7. Click Submit.

Opel’ltext . File Signed in as sp\ad trator LOGOUT
New Search
MANAGED PATHS FOR OBJECTS MATCHING: *
SPACE
OBJECT CN FOLDER AVAILABLE POLICY PURPOSE
8 | Adam James \\srs- o Quota exceeded Atlanta Users User Home Folder
ml.sp.cctec.orgiShares\Atlanta\Employees\ajames by 785MB.
8  Alicia Nance Wisrs- @ 432 MB (42%) Atlanta Users User Home Folder
m1.spcctecorg\Shares\Atlanta\Employees\anance
& | AnnReid Yisrs- @ 926 MB (90%) Atflanta Users User Home Folder
mlsp.cctec.org\Shares\Atlanta\Employees\areid
&  Ben Dover Wsrs- 9811 MB (79%) Atlanta Users User Home Folder
ml.sp.cctec.org\Shares\Atlanta\Employees\bdover
& Brenda Nabors Wisrs- @ 1,023 MB (99%) Atlanta Users User Home Folder
ml.sp.cctec.org\Shares\Atlanta\Employees\bnabors
&  Brian Lawson Wisrs- ® 926 MB (50%) Atlanta Users User Home Folder
ml.sp.cctec.orgiShares\Atlanta\Employees\blawson
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8. Select the user, group, or container you want to manage and click the Manage Object
button.

Opentext y File Dynamics Signed in as sp\administrator LOGOUT

New Search > Objects Matching

DETAILS FOR @@ \\SRS-M1.5P.CCTEC.ORG\SHARES\ATLANTA\EMPLOYEES\AJAMES

Purpose User Home Folder

Object s Adam James
CN=Adam James,OU=Employees,QU=Atlanta,0U=5P,DC=sp,DC=cctec,DC=0rg

Managed Path Wsrs-mlsp.cctecorgiSharesiAtlanta\Employees\ajames
Policy Name Atlanta Users

Space Available @ Quota exceeded by 785MB.

Current Quota 1,024 MB

Policy Maximum 20,480 MB

9. Add or remove a quota or perform a storage analysis by using the buttons provided.

8.3 - Understanding Quota Manager Status Indicators

Quota Manager uses three different status indicators to show the current storage quota status
for a user home folder or collaborative storage folder.

Red: Denotes one of the following conditions:
¢ Quota usage has exceeded 90 percent.
¢ The Engine is unable to contact the server containing the share.
¢ The share does not support quota management.

¢ The home folder does not exist.

* The server containing the share gave an Access Denied error, indicating that either
remote storage management is not configured or enabled for the Engine, or that the
firewall disallows remote storage management.

Yellow: Denotes that the quota usage has exceeded 75 percent.

Green: Denotes that quota usage is under 75 percent and that there are none of the problems
specified above.
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9 - Creating Target-Driven Policies

In previous chapters, you worked with Identity-Driven policies that manage data associated
with users and groups. File Dynamics also lets you manage data through Target-Driven
policies that are associated directly with a network folder or share. Target-Driven polices
provide unique management capabilities that are detailed in this chapter.

9.1 - Target-Driven Policy Types

There are presently seven types of Target-Driven policies in File Dynamics:

e Content Control policies

e Data Location policies

e Workload policies

¢ Target-Driven Security policies
» Security Notification policies
¢ Security Lockdown policies

¢ Security Fencing policies

9.1.1 - Content Control Policies

File Dynamics provides a Groom policy option for its Content Control policies. Groom policies
remove files according to file type, age, size, last accessed date, and more. From any file path,
you can either vault files to a new location or delete the files altogether. For example, you
could use this feature to easily delete temporary files and, in the process, make much more
disk space available on your storage devices.

9.1.2 - Data Location Policies

These policies are the means of copying or moving folders and their contents to another

location on the network. Copy policies duplicate a folder’s contents and file structure to a
location of your choosing. Move policies move the folder’s contents and file structure to a
target parent folder.

9.1.3 - Workload Policies

Workload policies in File Dynamics provide the ability to handle work processes initiated from
other applications. For example, reports generated in OpenText File Reporter that specify the
location of sensitive files can be imported into the Data Owner Client where a designated Data
Owner can remediate the location of these sensitive files. This approach empowers
organizations to provide automated network file system security remediation approved by a
gatekeeper familiar with the files.

Workload policies specify source paths, along with the Data Owners who can access these
paths.

105



9 - Creating Target-Driven Policies

9.1.4 - Target-Driven Security Policies

With the objective of providing data access governance to high-value target paths located on
your enterprise network, File Dynamics provides a variety of Target-Driven Security policies
designed to inform you of changes in access permissions, lock down access to an baseline
that is strictly enforced, and provide and deny access based on group memberships.

How Target-Driven Security Policies Work

File Dynamics scans the security of the network file system and records the results. The first
scan is considered the baseline and is the means of comparing changes produced by each
scheduled follow-up Security Scan. The Security Scan records the following:

¢ Access Control Entries for the file share

¢ Security Descriptor (including Access Control Entries, Owner, etc.) of the target path
and all subordinate folders

e Group memberships (Optional)
How Target-Driven Security Policies Address Changes in Security

Any changes detected result in a security alert to the associated email recipients and
notification records written to the database. Each policy type handles these security changes
in different ways.

The Notification policy simply records what changed to the database, updates it baseline, and
alerts the associated email recipients that there was a change.

The Lockdown policy records what changed along with what action was taken to remediate
the changes back to the baseline and then alerts the associated email recipients that changes
were made. This baseline scan acts as the baseline, and must be rebuilt when security
changes are needed to this associated target path.

The Fencing policy records the security changes identified but applies the rules from the policy
to determine if the security changes should be allowed or reverted. If the rules allow for the
change, the baseline is update automatically. If the rules do not allow for the change, the
change is reverted and a notification record is created. An alert is sent the associated email
recipients that a change occurred.

9.1.5 - Target-Driven Security Policy Types

At the present time, File Dynamics includes three Target-Driven Security policy types: Security
Notification policies, Security Lockdown policies, and Security Fencing policies.

Security Notification Policies

Security Notification policies enable administrators to be notified of any changes in access
permissions to network folders. These changes in permissions include a user being given a
new or updated permission to a specific folder, or a user has been granted access
permissions to a folder by being added to a group.

Notification emails are sent to the specified recipients. Only the recipients that are also Data
Owners can log in to the Data Owner Client to view the changes.
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Security Lockdown Policies

Security Lockdown policies let you establish the baseline permissions for a high-value target.
When unauthorized access permissions are made, the new permissions are removed and the
appropriate permissions are restored.

Updates to security permissions are logged and notifications are sent via email to specified
recipients.

Security Fencing Policies

Security Fencing policies set limits on how access permissions may change over time by
specifying groups that can be given permissions and others that should never be given access
permissions.

Updates to security permissions are logged and notifications are sent via email to specified
recipients.

9.2 - Create a Groom Policy

Groom policies remove files from any arbitrary path to a vault location. The files that are
removed and the frequency that the removals are performed are in accordance to the
specifications that you establish.

9.2.1 - Creating an Action Block for the Groom Policy

A Groom policy utilizes groom specifications that have been established and saved in an
Action Block.

1. Inthe Admin Client, click the Target Driven tab.
2. Click Action Blocks.

3. Inthe Manage menu, select New > Filter.

Create New Filter Action Blodk

MName | | |

ox

4. Inthe Create New Filter Action Block dialog box, give the new Action block a descriptive
name.
For example, Main Groom Rules.
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5. Click OK.
The Rule Editor dialog box appears.
Action Block Editor - Main Groom Rules = O X
General Fules
ok Add == Delete # Edit | 4% Promote )y Demote
Y Rules
Description Action | Masks | File Size Create Time Modify Time Access Time

E} Options
6’ Linked Polices

6. Establish your groom rules by specifying in separate rules, the file or folder types to be
vaulted or deleted, and under which conditions they are to be ignored.

For detailed procedures on how to set up groom rules, see Setting Groom Rules (page

40).

7. When you have finished creating your groom rules, close the Action Block Editor.

9.2.2 - Creating a Groom Policy
With the groom rules now saved to an Action Block, you can now create the Groom policy.

1. Inthe Admin Client, click the Target Driven tab.
2. Click Policies.
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3. Select New > Groom Policy.

Target Policy Editor - New Groom Policy — O X
@ General Name |New Groom Policy |
Description | Filter Action Elock Filter Action Blodk
G) Schedule Target Path | | | Browse | | Clear |
Vault Path | | | Browse | | Clear |
Job Cleanup

I:‘ Remove completed jobs older t lII day(s)

Security Options
[ copy Security

Merge Permissions

Overwrite Permissions

1. Changes to this policy have not been saved. | oK | | Cancel | | Apply

4. Inthe Namefield, give the Groom policy a descriptive name.
For example, Main Groom for General Atlanta Storage.

Click Filter Action Block.

In the Action Block Selector dialog box, locate and select the Action Block you created
under Creating an Action Block for the Groom Policy (page 107).

7. Click the Browse button that pertains to the Targetfield.
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8.

10.

11.

12.

13.
14.
15.

110

In the File System Path Browser, specify the location in the file system from where you
will be grooming files for this policy.

File System Path Browser x
= MNew Folder _/. Rename Folder _Fp Update Resources  ~ G Refresh o= Add == Remove
Selected Paths
|Enter text to search... | | Find

v /\ sp.cctecoorg
~ sp.cctec.org
~ 07 Aflanta
Data

i Home

== Managed Storage

== Managed Storage Template
bl srs-ml.sp.cctec.org

> srs-m2.sp.cctec.org

¥ srs-m3.sp.cctec.org

?
>
>
*

Ok | | Cancel

\\sp.cctec.org\shares\Atlanta\Home

Click the Browse button that pertains to the Vault Path field.
A vault path is not required if the filter block does not contain a vault action. If the filter is
later updated to add a vault action, then a vault path is required.

In the File System Path Browser, specify the location in the file system where you want
groomed files stored for this policy.

Select the Remove completed jobs older than check box and specify the number of
days that a Groom task from this policy is listed on the Jobs list before it is purged.

(Conditional) If you want your users to be able to continue to access groomed files from
the new vault location, select the Copy Security check box and choose one of the
following options:

* Merge Permissions: Merges permissions from the source to the target if the
target contains permissions that are not present in the source. This applies to all
folders and files in the source folder structure.

e Overwrite Permissions: Overwrites permissions in the target with those found in
the source. This applies to all folders and files in the target folder structure.

Click Apply to save your settings.
Click the Description tab and enter any information you want about the policy.
Click Apply.
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16. Click the Schedule tab.

17.
18.
19.

20.
21.

Target Policy Editor - New Groom Policy — O X
@ General
Start
Description
Date |4/22/2023 - Time [12:00:00 AM =
G) Schedule
Recurrence Pattern
[ | Recurrence
Hourly
Daily
Weekly
Monthly
1. Changes to this policy have not been saved. | oK | | Cancel | | Apply |

In the Date field, specify the date you want the policy to be initially invoked.
In the Timefield, specify the time you want the policy to be initially invoked.

(Conditional) If you want the Groom policy to run on a recurrent basis, select the
Recurrence check box and then select one of the options.

Click Apply to save the schedule.
Click OK.

9.3 - Create a Copy Policy

1.
2.

In the Admin Client, click the Target Driven tab.

Click Policies.
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3. Select New> Copy Policy.

Target Policy Editor - New Copy Policy — O X
@ General Name |New Copy Policy |
Description Frioe | | | Browse | | Clear |
G) Schedule Destination | | | Browse | | Clear |
Job Cleanup
|:| Remove completed jobs older than III day(s)
Copy Options

Ovewrite Existing Data
() Always
(®) Only If Newer
Copy Security
(®) Merge Permissions

() Overwrite Permissions

Copy Quota
|| skip Open Files

1. Changes to this policy have not been saved. | oK | | Cancel | | Apply

4. Inthe Namefield, give the Copy policy a descriptive name.
For example: Copy User Available Apps from Helpdesk Share to London Server.

5. Click the Browse button that pertains to the Source field.
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In the File System Path Browser, specify the location in the file system from where you
will be copying files for this policy.

File System Path Browser x

= MNew Folder _/. Rename Folder _Fp Update Resources  ~ G Refresh

| Enter text to search... | | Find

v /\ sp.cctecoorg -
~ sp.cctec.org E
> : Atlanta
v [0 HQ

» T Employees

== Groups

L4

» T Engineering
» T Finance Dept
¥ T Finance Managers
» T HQEmployees
» T HQ Marketing
» T HQSales
~ == hgshare
~ T Departments

v T itdept
LéApplimﬁons
T Contacts
== fs_templates
== migration_skipped files

¥
»
*
¥

3 T3 Marketing |z|

Ok | | Cancel |

\\isp.cetec.org\Public\HO\Groupsihgshare\Departments\it dept\Applications

Click the Browse button that pertains to the Destination field.

In the File System Path Browser, specify the location in the file system where you want
the selected files copied for this policy.

Select the Remove completed jobs older than check box and specify the number of
days that a Copy task from this policy is listed on the Jobs list before it is purged.

In the Copy Options region, specify your copy settings.

Overwrite Existing Data: With the default setting, File Dynamics will overwrite an
existing file on the target destination only if the same file from the source location is
newer. You can adjust this setting to your preferences. If the Overwrite Existing Data
check box is deselected, all duplicate named files will not be copied.

Copy Security: When selected, this setting maintains the file permissions from the
source location to the destination location.

* Merge Permissions: Merges permissions from the source to the target if the
target contains permissions that are not present in the source. This applies to all
folders and files in the source folder structure.

¢ Overwrite Permissions: Overwrites permissions in the target with those found in
the source. This applies to all folders and files in the target folder structure.
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11.
12.

13
14,
15,

16.
17.

114

Copy Quota: If the target supports quota management, this setting maintains the disk
quota settings from the source location to the destination location.

Skip Open Files: Skips all of the files that are opened from the source folder.

With Copy policies, File Dynamics does not attempt to copy skipped files later. You
might want to therefore schedule a Copy policy to run during a time when users are
logged out.

Click the Description tab and enter any information you want about the policy.
Click the Schedule tab.

Target Policy Editor - New Copy Policy = O X
@ General
Start
Description
Date |4/22/2023 -] Tme |12:00:00 AM =
G) Schedule
Recurrence Pattern
I:‘ Recurrence
Hourly
Daily
Weekly
Monthly
1, Changes to this policy have not been saved. | QK | | Cancel | | Apply |

In the Date field, specify the date you want the policy to be initially invoked.
In the Time field, specify the time you want the policy to be initially invoked.

(Conditional) If you want the Copy policy to run on a recurrent basis, select the
Recurrence check box and then select one of the options.

Click Apply to save the schedule.
Click OK.
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9.4 - Create a Move Policy

1. Inthe Admin Client, click the Target Driven tab.

2. Click Policies.
3. Select New > Move Policy.

Target Policy Editor - New Move Policy = O X
@ General )
Name |New Move Policy |
Description Source Path | | | Browse | | Clear |
(O schedule | Destination Path | | | Browse | | Clear |
Job Cleanup
|:| Remove completed jobs older than lIl day(s)
Copy Options
Ovenritz EXSING DAt g1 alyiays
() Only If Newer
1. Changes to this policy have not been saved. | oK | | Cancel | | Apply

4. Inthe Namefield, give the Move policy a descriptive name.
For example, Move NY Departments to Atlanta.

5. Click the Browse button that pertains to the Source Path field.
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6.

10.

11.

116

In the File System Path Browser, specify the location in the file system from where you
will be moving files for this policy.

File System Path Browser x

7 Mew Folder ‘/' Rename Folder _Fb Update Resources - G Refresh

| Enter text to search... | | Find

v /\ sp.cctecoorg -
w sp.cctec.org

b3 : Atlanta

= 1o

» T Employees
v

== Groups

e

» T Engineering
» T Finance Dept
% = Finance Managers
» T HQEmployees
» T HQ Marketing
» T HQSales
~ == hgshare
~ T Departments
v T itdept
> T Applications
> T Contacts
y T fs_templates
» T migration_skipped files

3 T Marketing

[-]

oK | | Cancel |

Visp.cctec.org\Public\HO\Groupsihgshare\Departments\it dept\Applications

Click the Browse button that pertains to the Destination Path field.

In the File System Path Browser, specify the location in the file system where you want
the selected files moved for this policy.

Select the Remove completed jobs older than check box and specify the number of
days that a Move task from this policy is listed on the Jobs list before it is purged.

In the Copy Options region, specify your copy settings.
Overwrite Existing Data: With the default setting, File Dynamics will overwrite an
existing file on the target destination only if the same file from the source location is

newer. You can adjust this setting to your preferences. If the Overwrite Existing Data
check box is deselected, all duplicate named files will not be copied.

Click the Description tab and enter any information you want about the policy.
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12. Click the Schedule tab.

13.
14.
15.

16.
17.

Target Policy Editor - New Move Policy — O X
@ General
Start
Description
Date |4/22/2023 - Time [12:00:00 AM =
G) Schedule
Recurrence Pattern
[ | Recurrence
Hourly
Daily
Weekly
Monthly
1. Changes to this policy have not been saved. | oK | | Cancel | | Apply |

In the Date field, specify the date you want the policy to be initially invoked.
In the Timefield, specify the time you want the policy to be initially invoked.

(Conditional) If you want the Move policy to run on a recurrent basis, select the
Recurrence check box and then select one of the options.

Click Apply to save the schedule.
Click OK.

9.5 - Create a Workload Policy

Workload policies in File Dynamics provide the ability to handle work processes initiated from
other applications. For example, reports generated in OpenText File Reporter that specify the
location of sensitive files can be imported into the Data Owner Client where a designated Data
Owner can remediate the location of these sensitive files. This approach empowers
organizations to provide automated network file system security remediation approved by a
gatekeeper familiar with the files.

Workload policies specify source paths, along with the Data Owners who can access these

paths.
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Before Data Owners can move file to a destination target path, you should verify that the Data
Owners have permissions to the destination target path.

9.5.1 - Workload Policy Example Scenario

A network administrator uses OpenText File Reporter to generate a report of potentially
sensitive files and their locations on the network. Through the report, it is discovered that there
are a number of files with Social Security numbers buried deep in a subfolder accessible by a
group of users who shouldn’t have access to that sensitive information.

The network administrator decides that these sensitive files need to be moved to the HR folder,
where only members of the HR group have access. He creates a Workload policy and within
the policy, specifies which users in the HR container are to be Data Owners for this policy as
well as each of the file system paths where the sensitive files currently reside on the network.

With the Workload policy saved, a Data Owner designated in the policy can now launch the
Data Owner Client, import the CcsV file listing all of the sensitive files and their locations, and
then specify where to move those files - in this example, to the network path of the HR folder.

Upon clicking OK, each file to be moved is consolidated into a single move job in the job
gueue. Once the files have been moved, the specific details are recorded, where they can be
reviewed.

9.5.2 - Creating a Workload Policy

1. Inthe Admin Client, click the Target Driven tab.
2. Click Policies.
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Select New > Workload Policy.

Target Policy Editor - New Workload Policy = O
‘ @ General Mame |MNew Workload Palicy
| Description
Wi Paths
1 Create Action Block & Link Action Block ¢ Unlink Action Block
Path =
Identity List
2% Create Action Block & Link Action Block 5 Unlink Action Block
| Data Owner -
1. Changes to this policy have not been saved. | oK | | Cancel | | Apply

In the Name field, give the Workload policy a descriptive name.
For example, HR Data Owners.

In the Workload Paths region, click Create Action Block.

Create New Workload Paths Action Blodk

Name | | |

119



9 - Creating Target-Driven Policies

6.

10.
11.

12.

13,
14,
15,

16.
17.

In the Name field, enter a descriptive name and click OK.
For example HQ HR Storage.

Action Block Editor - HQ HR Storage = O X

Workload Paths
o= Add == Remove

General

L_ Workload Paths

E} Options
6’ Linked Polices

Path -

oK | | Cancel | | Apply

/1, Changes to this Action Block have not been saved.

Click Add and from the File System Path Browser, select a path from which the Data
Owners will be able to perform Workload policy management tasks.

For example, moving sensitive files from the specified path to a new location.
Add all applicable paths.

Click Apply.

Click OK.

In the Identity Listregion, click Link Action Block.

In the Namefield, enter a descriptive name and click OK.
For example HQ HR Data Owners.

In the Action Block Editor, click Add and from the Directory Services Browser, select the
users who you want to be Data Owners for this policy.

Click Apply.
Click OK'to close the Action Block Editor.

Click the Description tab and in the Description field, specify any information you want
to include pertaining to this policy.

Click Apply to save the Workload policy.
Click OKto close the Workload policy editor.

9.5.3 - Remediating Using the Data Owner Client

Once Workload policies have been established, the specified Data Owners have the ability
through the Data Owner Client to perform remediation tasks. Procedures for doing so are
detailed in the File Dynamics 26.2 Data Owner Client Guide.
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9.6 - Create a Security Notification Policy

Many organizations must comply with security regulations that require vigilance in user access
to areas of the network containing personal data or other restricted or sensitive information. An
HR folder containing employee Social Security numbers or a Legal Department share would
both contain files whose access permissions would need to be regularly analyzed for access
and security compliance.

Security Notification policies let you specify the shares or folders to be analyzed, the
frequency of this analysis through scheduled scans, and the administrators who are to be
notified when changes in access permissions take place.

Analysis is performed through scans conducted by the Phoenix Agents and stored in the
database. The baseline scan is stored in the SQL Database while the security notifications are
stored in the CouchDB database.

9.6.1 - How Security Notification Policy Reporting Works

Reporting on security access changes is accomplished via a Security Scan, which is
performed using the following information for comparison against the previous Security Scan
for notification purposes:

¢ Discretionary access control list (DACL) of the security descriptor (SD) for the share
through which the target path is being accessed

¢ Owner field of the SD
¢ Access Allowed & Access Denied (Access Control Entry) ACEs in the DACL

Inherited ACEs in the DACL are only evaluated on the target path.
Directly assigned ACEs are evaluated on the target path and all subordinate folders.

¢ Group memberships in AD for security-enabled Domain Global Groups and Universal
Groups

¢ Local groups on the member server that may have members that reside in an AD
domain

If there are any changes to these items, a notification is sent identifying the scope of the
change.

Security Notification Policy Scan

A Security Scan will retrieve the DACL and Owner sections of the SD of folders for storage and
evaluation purposes.

A Security Scan can be scheduled or executed manually. A Phoenix Agent is responsible for
performing the scan.

Email Reporting
The email report is text based and includes the following:

« The policy responsible for triggering the notification

¢ The target path of the policy
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9.6.2 - Creating a Security Notification Policy

1. Inthe Admin Client, click the Target Driven tab.
2. Click Policies.

3. Select New > Security Notification Policy.

Target Policy Editor - New Security Notification Policy = O X

@ General
Description Target Path | | |
(O schedule

Ooata

Mame |New Security Motification Policy

Policy Enabled T

Browse | | Clear |

Notification and Report Options

Email Recipients | | | Clear |

Security Change Events

Share Permissions Inherited ACEs (Target Path only)
Owner Directly assigned ACEs
Group Membership

Data Cleanup

Retain Notification Data for days
Retain Job Entries for days

Data Owners
ok Add == Remove

|Name

1. Changes to this policy have not been saved. |

4. Inthe Namefield, give the Security Notification policy a descriptive name.
For example, HQ Finance Notification Policy

5. Leave the Policy Enabled check box selected.
This check box is provided for administrators when they are editing a policy.
Deselecting this check box lets you suspend all notifications scanning and notifications

for this policy until the administrator has finished updating the policy or file system
permissions.
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Click the Browse button pertaining to the Target Path field and specify the share or
folder for this policy.

File System Path Browser x

7 Mew Folder ‘/' Rename Folder _Fb Update Resources - G Refresh

Enter text to search... | | Find

v = hgshare |Z|
v T Departments

== Engineering

»
> ©7 Finanace
» T itdept

» T Marketing
»

»

¥

T Medical

= Sales —
== Training
» T HR Dept
> [ IT Administrators
3 T ITHelpdesk
» T IT Support
» = Legal Department
> T Medical
» T Project Managers
» T Risk Management
» T Training
» _-:_ London _
¥ MNYC
g

oK | | Cancel |

Y\sp.cetec.org\PublictHO\Groups\hgshare\Departments'Finanace

In the Email Recipients field, specify the email addresses of each user you want notified
when access permissions to the selected folder or share are changed.

Email addresses can be separated by a comma, semicolon, or a space.

File Dynamics only reports on the changes in permissions between one scan and the
next. Therefore, if there are no changes in access permissions between scans, no
notifications will be emailed.

In the Security Change Events region, specify the event types for which this policy will
email notifications.

In the Data Cleanup region, specify how long you want scan job information to remain in
the database.
For more information, see Security Lockdown Policy (page 212).

In the Data Owners region, click Add to specify the users or groups that will serve as
Data Owners for this policy.

Data Owners assigned for a Security Notification policy will be enabled to view changes
in the security reports via the Data Owner Client.

Click the Description tab and in the Description field, specify any information you want
to include pertaining to this policy.
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12. Click Schedule.

13.
14.
15.

16.
17.

Target Policy Editor - Mew Security Notification Policy — O X
@ General
Start
Description
Date |4/22/2023 - Time [12:00:00 AM =
G) Schedule
o Data Recurrence Pattern
[ | Recurrence
Hourly
Daily
Weekly
Monthly
1. Changes to this policy have not been saved. | oK | | Cancel | | Apply |

In the Date field, specify the date you want the policy to be initially invoked.
In the Timefield, specify the time you want the policy to be initially invoked.

(Conditional) If you want the policy to run on a recurrent basis, select the Recurrence
check box and then select one of the options.

Click Apply to save the schedule.
Click OK.

9.6.3 - Editing a Security Notification Policy and Resetting the Baseline

There might be times when you need to adjust the permissions assignments for a target path
that is being monitored through a Security Notification policy.

1.
2.
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3. From the list of policies, double-click the Security Notification policy you want to edit.

10.
11.

Target Policy Editor - Sales Security Notification Policy — O X
@ General MName |Sales Security Notification Policy | Policy Enabled
Description Target Path |‘\‘l,sp.ocbec.org\Puinc\,l—IQ‘l,Groups%qshare\,Deparhﬂems‘l,Sales | | Browse | | Clear |
(O schedule

Notification and Report Options
O oata

Email Recipients | * acox@sp.cctec.org |E Clear i

Security Change Events

Share Permissions Inherited ACEs (Target Path only)
Owner Directly assigned ACEs
Group Membership
Data Cleanup
Retain Notification Data for days
Retain Job Entries for days
Data Owners

o= Add == Remove

| Name
& SP\amanda Cox
& SP\Jack Sanders

1. Changes to this policy have not been saved. oK | | Cancel | | Apply

Deselect the Policy Enabled check box.

Click OK.

In the policy list, note the new warning icon indicating that the policy you are editing is
now disabled.

In the network file system, make any needed security changes.

From the list of policies, double-click the Security Notification policy you disabled
previously.

Select the Policy Enabled check box.
Click OK.
From the Execute drop-down menu, select Reset Baseline.

From the Execute drop-down menu, select Security Scan.
This creates the new baseline.
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9.7 - Create a Security Lockdown Policy

Sensitive data should be accessible on a “need to know” basis, meaning that only a limited set
of individuals, based on their roles, should have access to this sensitive data. Furthermore,
Data Owners, those most familiar with the sensitivity of the data and who should have access
to it, should be empowered to be the ultimate decision makers.

Once you have established the proper access permissions for a high-value target, you can
establish the baseline of access permissions for the target path that will be strictly enforced
through a Lockdown policy. When unauthorized access permission changes are made to the
target path or its subfolders, the new permissions are removed and the permissions specified
in the Lockdown policy are restored.

9.7.1 - Creating a Security Lockdown Policy

1. Inthe Admin Client, click the Target Driven tab.
2. Click Policies.

3. Select New > Security Lockdown Policy.

Target Policy Editor - New Security Lockdown Policy = O X

[ General Policy Enabled [
Description Target Path | || Browse || Clear |

(O schedule

Ooata

Mame |New Security Lockdown Policy

Notification and Report Options

Email Recipients | | | Clear |

Indude Security Events
Security Change Events
Share Permissions Inherited ACEs (Target Path only)

Owner Directly assigned ACEs
Group Membership

Data Cleanup

Retain Notification Data for days
Retain Job Entries for days

Data Owners
o Add == Remove

| MName Can Enable Policy

1. Changes to this policy have not been saved. | oK | | Cancel | | Apply

4. Inthe Namefield, give the Security Lockdown policy a descriptive name.
For example, HQ Finance Lockdown Policy.
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5. Click the Browse button pertaining to the Target Path field and specify the share or
folder for this policy.

File System Path Browser x

7 Mew Folder ‘/' Rename Folder _Fb Update Resources - G Refresh

Enter text to search... | | Find

v = hgshare |Z|
v T Departments

== Engineering

»

> ©7 Finanace
» T itdept

» T Marketing
»

»

¥

T Medical
= Sales —
== Training
== HR Dept
= IT Administrators
=5 ITHelpdesk
=5 IT Suppert
== Leqal Department
T Medical
= Project Managers
== Risk Management

R R T

» T Training

w

_-:_ London
I nve ]

oK | | Cancel |

w

Y\sp.cetec.org\PublictHO\Groups\hgshare\Departments'Finanace

6. (Conditional) If the currently established access permissions to the specified target path
are the permissions you want enforced, select the Policy Enabled check box.

Otherwise, come back and select the check box after you have updated the access
permissions to the target path.

Once this option is selected, this becomes the baseline for comparison for all Security
Scans.

7. Inthe Email Recipients field, specify the email addresses of each user you want notified
when access permissions to the selected folder or share take place.

Email addresses can be separated by a comma, semicolon, or a space.

File Dynamics only reports on the changes in permissions between one scan and the
next. Therefore, if there are no changes in access permissions between scans, no
notifications will be emailed.

8. Inthe Security Change Events region, specify the event types for which this policy will
email notifications.

9. Inthe Data Cleanup region, specify how long you want scan job information to remain in
the database.
For more information, see Security Lockdown Policy (page 212).
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10.

11.

12.

13.

In the Data Owners region, click Add to specify the users or groups that will serve as
Data Owners for this policy.

Data Owners assigned for a Security Lockdown policy will be enabled to view changes
in access permissions in the security reports via the Data Owner Client.

(Conditional) If you want the specified Data Owners to be able to enable the policy,
select the Can Enable Policy check box.

When a Data Owner can enable a policy, he or she can enable or disable the policy. An
example of when this might be helpful is when the access permissions for the target
path need to be updated.

If a Data Owner disables and then enables a policy, the Data Owner is given the option
to rebuild the baseline.

Click the Description tab and in the Description field, specify any information you want
to include pertaining to this policy.

Click Schedule.

Target Policy Editor - New Security Lockdown Policy = O X
@ General
Start
Description
Date |4/22/2023 -] fime [12:00:00 AM =
G) Schedule
o Data Recurrence Pattern
[ | Recurrence
Hourly
Daily
Weekly
Monthly
1. Changes to this policy have not been saved. | oK | | Cancel | | Apply |

14. Inthe Datefield, specify the date you want the policy to be initially invoked.

15. Inthe Timefield, specify the time you want the policy to be initially invoked.
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16. (Conditional) If you want the policy to run on a recurrent basis, select the Recurrence
check box and then select one of the options.

17. Click Apply to save the schedule.
18. Click OK.

9.7.2 - Editing a Security Lockdown Policy and Resetting the Baseline

There might be times when you need to adjust the permissions assignments for a target path
that is locked down through a Security Lockdown policy.

1. Inthe Admin Client, click the Target-Driven tab.
2. Click Policies.

3. From the list of policies, double-click the Security Lockdown policy you want to edit.

Target Policy Editor - Finance Lockdown Policy = O X

[T General Name |Finanoe Lockdown Policy | Policy Enabled [ |

DESC”Pﬁ"" Target Path |‘\‘l,sp.ochec.org\Puinc\,l—!Q‘l,GroupsWqshare\,Deparh'nems\Finanaoe || Browse || Clear |

(O schedule

Ooata

Notification and Report Options

Email Recipients | * gnance@sp.cctec.org |E Clear i

Indude Security Events

Security Change Events

Share Permissions Inherited ACEs (Target Path only)
Owner Directly assigned ACEs
Group Membership

Data Cleanup

Retain Notification Data for days
Retain Job Entries for days

Data Owners
o= Add == Remove

| MName | Can Enable Policy
L 5P\Gary Nance ]

1. Changes to this policy have not been saved. oK | | Cancel | | Apply

Deselect the Policy Enabled check box.

Click OK.
In the policy list, note the new warning icon indicating that the policy you are editing is
now disabled.

6. Inthe network file system, make any needed security changes.
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7. From the list of policies, double-click the Security Lockdown policy you disabled
previously.

8. Select the Policy Enabled check box.
9. Click OK.
10. From the Execute drop-down menu, select Reset Baseline.

11. From the Execute drop-down menu, select Security Scan.
This creates the new baseline.

9.8 - Create a Security Fencing Policy

There might be some high-value targets on which you might not want to place the same level
of restrictions as a Security Lockdown policy, but might nevertheless want to secure the
access to only authorized users or roles.

Security Fencing policies let you set limits on how access permissions might change over
time. Using a set of rules by creating inclusion and exclusion lists to define a “fence,” the policy
specifies Active Directory containers, groups, users, and Security Identifiers (SIDs) that might
be given permissions to a high-value target in the future without an issue or should never be
given rights in the future.

Security Fencing policies work by creating a set of rules that create a boundary around your
storage against which any security will be evaluated. The security changes are then preserved
or reverted based on the rules created. You should therefore create your rules carefully,
potentially using tools like OpenText File Reporter to verify the permissions granted to
subfolders of your target path.

There is currently no path overlap protection between policies. While this is ideal for flexibility,
it is not so when you have conflicting policies.

9.8.1 - Creating a Security Fencing Policy

1. Inthe Admin Client, click the Target Driven tab.
2. Click Policies.
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Select New > Security Fencing Policy.

Target Policy Editor - Mew Security Fending Policy — O X

@ General Mame |New Security Fendng Policy | Policy Enabled [ ]
Rules Target Path | | | Browse | | Clear |

Description
(O schedule

O oat

Notification and Report Options

Email Recipients | | | Clear |

Indude Security Events

Security Change Events

Share Permissions Inherited ACEs (Target Path only)
Owner Directly assigned ACEs
Group Membership

Data Cleanup

Retain Notification Data for days
Retain Job Entries for days

Data Owners
o Add == Remove

|Name

1. Changes to this policy have not been saved. | oK | | Cancel | | Apply

In the Name field, give the Security Fencing policy a descriptive name.
For example, Engineering Department Fencing Policy.

Click the Browse button pertaining to the Target Path field and specify the share or
folder for this policy.

(Conditional) If the currently established access permissions to the specified target path
are the permissions you want enforced, select the Policy Enabled check box.

Otherwise, come back and select the check box after you have updated the access
permissions to the target path.

Once this option is selected, this becomes the baseline for comparison for all Security
Scans.

In the Email Recipients field, specify the email addresses of each user you want notified
when access permissions to the selected folder or share take place.

Email addresses can be separated by a comma, semicolon, or a space.
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10.

11.
12.

132

File Dynamics only reports on the changes in permissions between one scan and the
next. Therefore, if there are no changes in access permissions between scans, no
notifications will be emailed.

In the Security Change Events region, specify the event types for which this policy will
email notifications.

In the Data Cleanup region, specify how long you want scan job information to remain in
the database.
For more information, see Security Fencing Policy (page 214).

In the Data Owners region, click Add to specify the users or groups that will serve as
Data Owners for this policy.

Data Owners assigned for a Security Fencing Policy will be enabled to view permitted
changes in security, ownership, and group membership of folders in the target path via
the Data Owner Client.

Click Apply to save your settings.

Click Rules.
Target Policy Editor - Atlanta Engineering Fending Policy = O X
@ General + Included Identities
P
7] Rules == Add == Remove # Edit
Description | Name Scope Applies To
CM=Users,DC=sp,DC=cctec, DC=or Subtree | Grou
© schedie T ,DC=sp, ,DC=org p
'fg OU=Groups, OU=Atanta,0U=5P ,DC=sp,DC=cctec,DC... Subtree | Group
Data
o .I!- CN=IT Administrators,OU=Groups,OU=HQ,0U=5F,DC... Base Group
e BUILTIN\Administrators Base Group
e NT AUTHORITY\SYSTEM Base | Computer
e 5-1-5-21-3548517610-2711151581-1220673217-1107 Baze Unknown
(@) Excluded Identities
o Add * == Remove " Edit
| Name Scope Applies To
1, Changes to this policy have not been saved. oK | | Cancel | | Apply
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In the Included Identities and Excluded Identities regions, use the Add drop-down
buttons to include and exclude groups, users, and SIDs for this Fencing policy.

Built-n Accounts *
|Name 4 | 51D |
& Interactive 5154 [=]

L sk 5-1-5-17

2& Local 5-1-2-0

& Local Service 5-1-5-19

Local System 5-1-5-13

2&  Network 5-1-5-2

2 Network Configuration Operators 5-1-5-32-556

& Network Service 5-1-5-20

& NTLM Authentication 5-1-5-64-10

.IJ- Performance Log Users 5-1-5-32-559

.IJ- Performance Monitor Users 5-1-5-32-558

2L Power Users 5-1-5-32-547

2& Pre Windows 2000 Compatible Access 5-1-5-32-554

.IJ- Print Operators 5-1-5-32-550

& proxy 5-1-58

.IJ- Remote Desktop Users 5-1-5-32-555

& Remote Interactive Logon 5-1-5-14 |Z|
| Ok | E Cancel ;

Be sure to include any desired well known security objects such as
BUILTIN\AdministratorsandNT Authority\SYSTEM appropriate to your
environment, before you perform a Security Scan. If you do not include these objects,
their access will be disabled following the initial Security Scan.

For more information on creating rules for a Fencing policy, including adding Built-in
accounts and Security Identifiers, see the Rules Tab under Security Fencing Policy

(page 214).

Click the Description tab and in the Description field, specify any information you want
to include pertaining to this policy.
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15. Click Schedule.

16.
17.
18.

19.
20.
21.

22.

Target Policy Editor - Atlanta Engineering Fending Policy — O X
@ General
Start
Rules
= Date |4/22/2023 - Time [12:00:00 AM =
Description
(O schedule Recurrence Pattern
Oost Recurrence
 Houd (e Day of every month
() Hourly
() The |First v| |Sunda\-I ~ | of every month
() Daily
() Weekly
(®) Monthly
1. Changes to this policy have not been saved. | oK | | Cancel | | Apply |

In the Date field, specify the date you want the policy to be initially invoked.
In the Timefield, specify the time you want the policy to be initially invoked.

(Conditional) If you want the policy to run on a recurrent basis, select the Recurrence
check box and then select one of the options.

Click Apply to save the schedule.
Click OK.

From the Target Policies page, highlight the Security Fencing policy and from the
Execute drop-down menu, select Security Scan.

In the confirmation dialog box, click Yes.

9.8.2 - Editing a Security Fencing Policy and Resetting the Baseline

There might be times when you need to adjust the permissions assignments for a target path
whose access permissions are managed through a Security Fencing policy.

1.

In the Admin Client, click the Target-Driven tab.

2. Click Policies.
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3. From the list of policies, double-click the Security Fencing policy you want to edit.

10.
11.
12.
13.

Target Policy Editor - Atlanta Engineering Fending Policy — O X
@ General MName |Aﬁama Engineering Fencing Policy | Policy Enabled I:‘
Rules Target Path |‘\‘l,sp.cchec.org\Puinc‘l,Aﬁanta‘l,Groups‘l,Aﬂama Engineering | | Browse | | Clear |
Description
Notification and Report Options
(O schedule
o Email Recipients | » acox@sp.cctec.org ¥ administrator @sp.cctec.org | | Clear |
Data
Indude Security Events

Security Change Events

Share Permissions Inherited ACEs (Target Path only)
Owner Directly assigned ACEs
[ Group Membership

Data Cleanup

Retain Notification Data for days
Retain Job Entries for days

Data Owners
o= Add == Remove

|Name
&L sPDaryll Thomas
& SP\amanda Cox

E oK ; | Cancel Apply

Deselect the Policy Enabled check box.

Click OK.
In the policy list, note the new warning icon indicating that the policy you are editing is
now disabled.

In the network file system, make any needed security changes.

From the list of policies, double-click the Security Fencing policy you disabled
previously.

Click the Rules tab.

Preserve the security changes made in the network file system by making any needed
updates in the Included Identities and Excluded Identities lists.

Click the Generaltab.

Select the Policy Enabled check box.

Click OK.

From the Execute drop-down menu, select Reset Baseline.
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14.

From the Execute drop-down menu, select Security Scan.
This creates the new baseline.

9.9 - Executing a Security Scan

In addition to executing scans through a schedule, you can do so at any time through the
Admin Client.

e nh =

In the Admin Client, click the Target Driven tab.
Click Policies.
Right-click the name of the Security policy and click Execute > Security Scan.

When the confirmation screen appears, click Yes.

The target path for the selected Security policy is scanned for security changes. If
changes are determined, an email is sent to the users specified in the Email Recipients
field of the policy.

A sample email is shown below:

Sorted by Received MNewest v . . . . .
Security change detected for policy "Finance Notify Policy".
¥  Last Week

alerts@dom.cctec.org Fri 3:00 AM

. From alerts@dom.cctec.org Mo date
S hi detected fi licy “Atlanta 20k Fenci... .
ecurity change detected for policy “Atlanta 20k Fenci to AAMANTE@dom cctec.org, administrator@dom.cctec.org

A security change has been detected concerning path

Please sign in to the Data Owner Client to view details.

Depending on the policy type, the email specifies that access permissions to a high-
value target have been changed.

9.10 - Viewing Security Notifications

Viewing security notifications through the Security Notifications page is the means of
determining changes in access permissions and group memberships for target paths
managed through security policies and obtaining additional details through Detail Reports.

1.
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In the Admin Client, click the Target Driven tab.



2. Click Security Notifications.

Identity-Driven Target-Driven
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= e 2 =
2 O ile =

Polices Palicy  Action Jobs Security
Schedules Blocks Motifications
Management Notification Data
% ?@ Security Notifications

P Run Detail Report= (5 Reload Policies ' Refresh

Policy: Atlanta Engineering Fencing Policy
Target Path: ‘\sp.cctec.org\Public\Atlanta\Groups\Atlanta Engineering

R

.0

8:00 PM 4:00 AM 12:00 PM 8:00 PM
4:00 PM 12:00 &AM 8:00 AM 4:00 PM

4
12:00 AM

00 AM

8:00 AM

12:00 PM

0 Events

@ Actions

Access Control Entry

0 1 2 3 4 5

M Events
M Actions

Version: 6.6.0.28

User: SP\Administrator Engine Address: 172.17.3.103

~ Policies

~

Engine Version: 6.6.0.22

e

@
)
G
o
@
G
G

Atlanta Users Security Notification Policy
Finance Security Notification Policy
Atlanta Helpdesk Fencing Policy

Medical Lockdown Policy

Sales Security Notification Policy
Finance Lockdown Policy

Atlanta Engineering Fencing Policy

~ Filters

Counts

Total Policy Events:
Fittered Events:
Total Policy Actions:
Fittered Actions:

W ww o

3. From the Policies list, select the policy for which you want to see graphical information

and reported in the Detail Report.

If the policies are not displayed, you can click Reload Policies and select the security

policy types to display.

reported in the Detail Report.

From the Filters region, specify the options you want displayed in the graphs and

5. Inthe same region, specify the date range you want displayed in the graphs and

reported in the Detail Report.

6. From the Run Detail Report drop-down menu, choose one of the following options:

» File System Events: Generates a preview report of file system events that have
taken place within the parameters you have specified in the right-hand portion of
the Security Notifications page.

* Group Membership Events: Generates a preview report of group membership
events that have taken place within the parameters you have specified in the
right-hand portion of the Security Notifications page.
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7. From the report dialog box, export or email the report in the format you want.

Margins v Previous Page Zoom Out
=B ae B g 0 [ SRR —
[P orientation + b Next Page W Q, Zoom +
Open Save  Print Quik Parameters Sl Find Thumbnalls Bookmarks | Editing  First Many Pages ) watermark
Frint ¥ IO size v Fields | Page Pl Last Page @ M @ ZoomIn
Document Print Page Setup ] Navigation Zoom Page Background HTML File
Document Map B X 1 Web Page
~ Seaurity Notifications. @ MHT File
Parameters Single File Web Page
> ReportData RTF File
Rich Text Format
DOCX File
Microsoft Word Document
XLS File
Microsoft Excel 2000-2003 Workbook
. e - XLEX File
Security Notifications Moot el Werkbock
fa5g CSv File
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Plain Text
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10 - Work Log Reports

This chapter provides a detailed explanation of Work Log reports along with procedures for
setting up and generating Work Log reports.

10.1 - Work Log Reports Overview

The Work Log is a mechanism that maintains a history of File Dynamics events. The Work Log
contains summary records for events that have reached the processed state; in other words,
those that have run to completion or have been aborted by administrative action.

Data from the Work Log is presented in a pivot grid based on the parameters you choose. You
can use this data for historical event tracking.

The Work Log is an optional component of File Dynamics and requires you to install Apache
CouchDB.

10.1.1 - Restrictions
The current Work Log implementation has the following restrictions:

e Work Log entries include only those pertaining to Identity-Driven policies. No Target-
Driven policy entries are logged.

¢ Not all incoming events from the Event Monitor are logged. Only Event Monitor
generated events that have calculated an effective policy are logged.

¢ A Work Log entry is written only after the event has run to completion or has been
aborted.

¢ Events are written to the database once every minute.

e After an upgrade of a previous version of Storage Manager or File Dynamics that does
not support the Work Log, or Work Log was not configured, any existing events that are
active or pending will not be logged. Only new events, new events generated via
Management Actions, and new Operations will be logged.

10.1.2 - Database
The Work Log leverages Apache CouchDB, an open source NoSQL database.

For recommended disk space and RAM allocations, see Installing CouchDB

10.1.3 - Configuration

You are required to install and configure CouchDB prior to enabling and configuring the Work
Log.

Similar to the File Dynamics database configuration, the following will be created and
managed for you via the Admin Client

¢ User for managing the CouchDB instance from the Engine
¢ User for reading from CouchDB instance from the Admin Client
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e CouchDB database for the Work Log
e Any necessary views for querying the CouchDB database

The following options are provided:

e The number of days to retain Work Log Entries
e The ability to turn the Work Log on or off

10.2 - Establishing the Work Log Database Settings in the
Admin Client

Follow these procedures to establish the CouchDB settings in the Admin Client.

1. Inthe Admin Client, click the Configuration tab.

2. Click Work Log Configuration.

Identity-Driven Target-Driven Client

_); Work Log Configuration User: DOM\ocaladmin Engine Address: 172.17.2.21
Engine Version: 6.5.0.53
Configuration o Database Information o
Database Settings
Database Host Port:
Database Name

Admin Username

Admin Password

There is no database configured.
Please configure a CouchDB instance.

Clear entries after 1 day(s)

Apply

3. Inthe Database Hostfield, enter the IP address or DNS hostname of the server hosting
the CouchDB database.

In the Portfield, enter 5984.

. Inthe Database Name field, establish a name for the CouchDB database instance for
the Work Log.

Letters used for the database name must be lowercase.

6. Inthe Admin Username and Admin Password fields, enter the username and
passwords you established in when you installed CouchDB.
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7. Click Provision.
If you go back to the Apache CouchDB administrative interface and click Databases in
the menu bar, you should now see the database name you entered in Step 5.

8. Return to the Admin Client and in the Work Log Configuration region, specify the
settings you want for Work Log entries.

9. Click Apply.

10.3 - Building Work Log Reports

With the CouchDB database installed and the Work Log database settings established in the
Admin Client, you are ready to build Work Log reports.

Work Log reports are built in the Admin Client using a pivot grid interface. There are four
preset options for viewing data, along with a playground option that lets you choose the
parameters and presentation of the report.

The remainder of this chapter briefly introduces you to the features and capabilities of Work
Log reports through some basic procedures.
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10.3.1 - Loading Work Log Entries

1.

142

In the Admin Client, click the Work Log tab.
2. Click Reports.

Work Log

File Export

Work Log View

Work Log Scope: [ 7 Days, Work Completed

Data View: | Data Lifecyle ... = | Time Metric | Work C...

= | Time View: | Month

Load Work Log

= | Completion Scope:

Chart

1. No Work Log Entries have been loaded!

Mo -




3. Click Load Work Log Entries.

Work Log

10 - Work Log Reports

File Export

‘Work Log View

Event Type Count

Policy Type =
w Group Collaborative

w User

User Total

Grand Total

Data View: | Data Lifecyle ...

Woaork Log Scope: | 7 Days, Work Completed

Policy =
w Atlanata Team Share

w Atlantallsers

Atlantallsers Total

~ HQUsers

HQ Users Total

~ | Time Metric. | Work C...

Action =
Manage

Apply Home Drive
Apply Owner
Apply Permission

Create User

Create User

Manage

= | Time View: | Month

WorkCompleted Year =

» 2019
August
]

15

51

- Load Work Log

~ | Completion Scope: | No

WorkCompleted Month =

Chart

All Work Log entries in the CouchDB database are loaded and displayed with default
parameters that you can modify.
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10.3.2 - Setting the Work Log Scope

1.

2.
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Click the down arrow that pertains to the Work Log Scope field.

Work Log

File Export Chart

Work Log View

‘Work Log Scope: | 7 Days, Work Completed ~ (ies have been loaded!
Data View:
Scope ‘Custom Start and End Date
Completion Scope:
7 Days Friday, August 2, 2019
Event Type Count 30 Days « August 2019 S
50 Days SU MO TU WE TH FR SA
28 29 30 31 1 2 3
Policy Type =S 90 Days

4 5 6 7 8 9 10
w Group Collaboratiy 1 vear
P Al 1 12 13 14 15 1% 17

w User : . 18 19 20 21 22 23 24
' 25 26 27 28 26 30 31

1 2 3 4
Time Metric
Clear

® '‘Work Completed

Work Begin

Queued

User Total

Grand Total

Set as Default oK | | Cancel

In the dialog box, specify the parameters you want by selecting applicable options.

Scope: Lets you specify the timespan for the report. All of the Days options will include
events, according to the selected Time Metric option from today’s date. The All option
will include all events, according to the selected Time Metric option. The Custom option
lets you select a start and stop date from the calendar using the Shift key.

Time Metric: Lets you specify what types of events to include in the Work Log report.

Custom Start and End Date: This calendar is activated when you select the Custom
option from the Scope region. Select a start and end date using the Shift key.

Set as Default: Lets you establish your selected options and specifications as the
default setting for all Work Log reports.

Click OK.

The new parameters are specified in the Work Log Scope field.
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10.3.3 - Data View Options

The Data View drop-down menu has five options:

e Playground: This Work Log report option enables you to specify what fields to include
in the report. All of the reporting parameters are available for selection in the top portion
of the pivot grid. You build the Work Log report by dragging the desired fields where you
want them placed in the report. These fields can be displayed as either rows or

columns.
Work Log
File Export Chart
‘Work Log View
Woaork Log Scope: | 7 Days, Work Completed - Load Work Log

Data View: | Playground

Create Time Delete Time Event ID Path Type Path Type Count Policy Type Count Trigger Type
Triggered By Object Type Fdn Domain SAM Aborted By Storage Path Completion Status
WorkCompleted Day WorkCompleted Week WorkBegin Day WaorkBegin Week WaorkBegin Month
WorkBegin Year Queued Day Queued Week Queued Month Queued Year Folicy Type Policy
Event Type Count WorkCompleted Year = ‘WorkCompleted Month =

~ 2019
Event Type = Action = August
~ Apply File System Permissions | Apply Permission 15
~ Apply Home Drive Apply Home Drive 15
~ Apply Owner Apply Owner 15
~ Create User Create User 2
w Set Policy Collaborative Manage 1
v Set Policy User Manage 3
Grand Total 51

In any cell with a numeral, you can double-click to access an expanded, detailed report
of events.

You can also click Chartto view the data in a graphical format of your choosing.

¢ Policy Activity: This Work Log report option specifies events for all policies regardless
of how they were triggered. according to the selected Time Metric, Time View, and
Completion Scope options.
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146

In the example below, the Work Log report lists completed File Dynamics events for the
Month of May 2018.

Work Log
File Export Chart
Work Log View

Work Log Scope: | 7 Days, Work Completed - Load Work Log
Data View: | Policy Activity ~ | Time Metric: | Work C... -~ | Time View: | Month ~ | Completion Scope: | No -
Event Type C... WorkCompleted Year = WorkCompleted Month =

v 2019

Policy = August

Atlanata Team Share 1

Atlantalsers 46

HQ Users 4

Grand Total 51

In any cell with a numeral, you can double-click to access an expanded, detailed report
of events.

You can also click Chartto view the data in a graphical format of your choosing.

Event Trigger: This Work Log report option specifies events generated by an Event
Monitor or a File Dynamics administrator performing Management Actions, according to
the selected Time Metric, Time View, and Completion Scope options.
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In the example below, the Work Log report lists completed Active Directory enacted
events for the Month of May 2018.

Work Log
File Export Chart
Work Log View
Woaork Log Scope: | 7 Days, Work Completed -
Data View: - | Time Metric: | Work C... = | Time View: | Month - | Completion Scope: | No -
Event Type Count ‘WorkCompleted Year = WorkCompleted Month =
~ 2019
Triggered By = Event Type = August
w cctec2 dynamics.cctec.org Create User 2
~ DYMAMICS\Administrator Apply File System Permissions 15
Apply Home Drive 15
Apply Owner 15
Set Policy Collaborative 1
Set Policy User 3
DYNAMICS\Administrator Total 43
Grand Total 51

In any cell with a numeral, you can double-click to access an expanded, detailed report
of events.

You can also click Chartto view the data in a graphical format of your choosing.

Policy Type Event Distribution: This Work Log report option distinguishes events by
File Dynamics policy types according to the selected Time Metric, Time View, and

Completion Scope options.
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In the example below, the Work Log report lists completed events for the Month of May

2018.

Work Log

File Export

Work Log View
Work Log Scope:

Data View:

Event Type Count

7 Days, Work Completed

~ | Time Metric. | Work C...

= | Time View: | Month

WorkCompleted Year =

~ | Completion Scope: | No

WorkCompleted Month =

Chart

- Load Work Log

v 2019

Palicy Type = Event Type = August
w Group Collaborative | Set Policy Collaborative 1
v User Apply File System Permissions 15
Apply Home Drive 15

Apply Owner 15

Create User 2

Set Policy User 3

User Total 50
Grand Tatal 51

In any cell with a numeral, you can double-click to access an expanded, detailed report
of events.

You can also click Chartto view the data in a graphical format of your choosing.

« Data Lifecycle Monthly: This Work Log report option specifies events by policy type,
policy name, action, and month according to the selected Time Metric, Time View, and
Completion Scope options.
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In the example below, the Work Log report lists completed events for the Month of May
2018.

Work Log = o
File Export Chart

Work Log View

‘Work Log Scope: | 7 Days, Work Completed -
Data View: | Data Lifecyie .. ; = | Time Metric: | Work C... = | Time View: | Month ~ | Completion Scape: | No
Event Type Count ‘WorkCompleted Year = ‘WorkCompleted Month =
v 2019
Poliy Type = Action = Palicy = August
v Group Collaborative  + Manage Atlanata Team Share 1
v User v Apply Home Drive  AtlantaUsers 15
+ Apply Owner AtlantaUsers 15
~ Apply Permission  AtlantaUsers 15
~ Create User AtlantalUsers 1
HQ Users 1
Create User Total 2
v Manage HQ Users 3
User Total 50
Grand Total 51

In any cell with a numeral, you can double-click to access an expanded, detailed report
of events.

You can also click Chartto view the data in a graphical format of your choosing.

10.3.4 - Build a Work Log Report

S

6.

In the Admin Client, click the Work Log tab.

Click Reports.

Click Load Work Log Entries.

From the Data View drop-down menu, select the data view option you want.

(Conditional) If you select Playground, select and position the fields you want in the
report.

Select your Time Metric, Time View, and Completion Scope options.

10.3.5 - Saving a View

After you have designed a Work Log report using the Playground data view option, you can
save it and then use it to again to report on updated event data.

1.

In the Admin Client, click the Work Log tab.

2. Click Reports.
3. Click Load Work Log Entries.
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From the Data View drop-down menu, select Playground.
Select your Time Metric, Time View, and Completion Scope options.
Select and position the fields you want in the report.

From the File menu, select Save View.

© N o g &

Name and save the view.
With the view saved, you can retrieve through the Load View or Views menu options of
the File menu.

10.3.6 - Exporting a Work Log Report
File Dynamics enables you to export Work Log reports to the following formats:

e CSV

e HTML

e MHT

e PDF

e« RTF

e TXT

e XLS

e XLSX

In the Admin Client, click the Work Log tab.
Click Reports.

Click Load Work Log Entries.

From the Data View drop-down menu, select the data view option you want.

o > L bh =

(Conditional) If you select Playground, select and position the fields you want in the
report.

6. Select your Time Metric, Time View, and Completion Scope options.
7. From the Export menu, select the format you want.

8. Name and save the exported Work Log report.
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This chapter presents the tabs and tools in the Admin Client in a reference format. All of the
tools are covered as they are presented in the Admin Client interface, beginning with the
Home tab.

11.1 -Home Tab

The Home tab provides a dashboard of File Dynamics component summaries, statistics,
access to Engine services settings, and more.

11.1.1 - Status

This displays a dashboard summarizing the status of the product license, the Event Monitor
and Agents, if the Work Log is configured, the last time the GSR Collector was run, and
graphic summaries of policy and jobs in the queue. You can resize and rearrange the
presentation to your preferences.

The Status Page

Identity-Driven Target-Driven Cross-Empire Data Migration Configuration
f L @ @ [
o B M O L 5 g
Status Runtime Path Analysis Scheduled | Storage  Forest Agents | Event  Event = Check
Config Report Tasks Resources  Trusts Monitors  Scope | Updates
Tools Assets Components
User: DOM\localadmin Engine Address: appl.dom.cctec.org
o Status
Engine Version: 6.5.0.53
General o Event Monitors o File System Agents o Phoenix Agents o
Managed Forest:  dom.cctec.org . Total Event Monitors: 2 Total File System Agents: 2 Total Phoenix Agents: 2
Current Engine Time: 11/15/2019 1:46:39 PM
¢ + Authorized: 2 + Authorized: 2 + Authorized: 2
Engine Start Time:  11/14/2019 7:46:23 PM
License Type: Production Last Event Received: 11/15/2019 11:14 AM Active Copy Jobs: 0 i, Heartbeat: 1
License Expires: 7/14/2020 Unparsed Pending Events: 0 Active Delete Jobs: 0 Active Epoch Cleanup Jobs: 0
License Features: " Accepting Events Active Vault Jobs: 0 Active Epoch Integrity Check Jobs: 0
- Core
- Cross-Empire Data Migration Active Directory P ing Event: , - .
e Empire Data Miration <0itecion rocessing Events Active Epoch Recovery Jobs: 0
jgg:ﬂ;m Protection Active Epoch Scan Jobs: O
- Waorkload v « >
Systems o Policies u] Queues o
N . . .
A 15 - -
 Global Statistics Collector - Identity-Driven Target-Driven
Last Run Time: 7/17/2019 9:13:47 AM
61
+ Storage Resources
Last Update Duration: 00:00:21 1 "2
Last Update Time: 11/15/2019 12:00 AM -
Next Update Time: 11/16/2012 12:00 &AM 12
Complete ™, Failed
v ity-Dri Y
Work Log "y, Identity-Driven Target-Driven  Ceferred  Aborted
-

Version: 6.5.0.59

11.1.2 - Runtime Config Report

Runtime Config reports are used to build reports on the current configuration and pending
events from the Engine. You can indicate which configuration data you want included in the
report by selecting the desired check boxes.

Runtime Config Report
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11.1.3 - Path Analysis

The Path Analysis page shows a tree view of your network storage and provides various
storage reports. These reports are a quick way to determine the trustees of a share or folder,
the number of files and file types in a given folder, whether a quota is assigned to a folder and
if so, how much, and the permissions assigned to individual files.

Whether managed by File Dynamics or not, all of the storage visible in the left panel is eligible
for path analysis.

Use the left pane to browse and select network shares and folders. Use the right pane to view
the files within a selected folder.

Clicking a share or folder in the left pane activates the toolbar. The toolbar has the following
options:

Information: Lets you view a variety of information pertaining to a selected share or folder.

¢ Quota: Specifies if quota is set for a folder, the quota size, and the amount of free space
remaining in the folder.

» File Types: Categorizes the content of the selected folder by displaying the various file
types, the total number of each file type, and the total size of each file type. For
example, to know if a user is storing non-work related files in his or her home folder and
the total size of these files, you could use this feature to quickly determine this
information.

¢ Permissions: Opens the View Permissions dialog box, which lists all users and objects
that have any type of rights to the selected share, folder, or file. The View Permissions
dialog box also indicates the permissions that each of these users and objects have as
well as how these rights are obtained.

Tools: Lets you create, rename, and delete folders within the network file system.

Rebuild: Rebuilds your storage resource list. You might need to do this to display the storage
resource list structure after it has been modified.

Refresh: Refreshes the view within the Path Analysis page.

File Permissions: This opens a dialog box displaying all the objects that have permissions to
a selected folder, the specific permissions, and how those permissions were obtained.

Filter: This lets you filter the view of the subfolders for a specified folder.

11.1.4 - Scheduled Tasks

Use the Scheduled Tasks page to schedule storage resources discoveries and database
cleanup tasks as well as schedule Groom policies.

Schedule a Storage Resources Discovery

This task initiates a search within the entire forest domain for any new shares or DFS
namespaces. Depending on the size, configuration, and topology of your network, this can
take a significant amount of time.
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In the Admin Client, click the Engine tab.
Click Scheduled Tasks.
From the list of scheduled tasks, double-click Storage Resources Discovery.

In the Schedule Startregion, set the time and data parameters when you want the
storage resources discovery to take place.

In the Schedule Recurrence region, specify the frequency of the storage resources
discovery.

Click OK.

Run a Storage Resources Discovery

In addition to scheduling a storage resources discovery, you can run the storage resources
discovery immediately.

1.

In the Admin Client, click the Engine tab.

2. Click Scheduled Tasks.

3. From the list of scheduled tasks, right-click Storage Resources Discovery and select

4.

Run.

Click Yes in the confirmation dialog box.

Schedule a Database Cleanup

A database cleanup reduces database bloat that can affect File Dynamics performance. A
database cleanup does the following:

Removes old scan entries

Removes deleted path history entries

Removes deleted object entries

Removes events that are marked as completed
Cleans up DS objects based on their delete time

Removes orphaned action blocks

While the database cleanup is in process, event processing is turned off. Once the cleanup
finishes, event processing is turned on.

o nh =

5.
6.

In the Admin Client, click the Engine tab.
Click Scheduled Tasks.
From the list of scheduled tasks, double-click Database Cleanup.

In the Schedule Startregion, set the time and data parameters when you want the
database cleanup to take place.

In the Schedule Recurrence region, specify the frequency of the database cleanup.
Click OK.

Run a Database Cleanup

In addition to scheduling a database cleanup, you can run a database cleanup immediately.
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In the Admin Client, click the Engine tab.
Click Scheduled Tasks.
From the list of scheduled tasks, right-click Database Cleanup and select Run.

w o=

4. Click Yesin the confirmation dialog box.
Schedule a Groom Policy

1. In the Admin Client, click the Engine tab.
2. Click Scheduled Tasks.
3. Click Add.

Schedule

Task Mame: -- Select Task -- e Options

Description:

Schedule Start

Engine Local Time: |12:1}|}:1}4}AM -

Engine Local Start Date: |Wednesday, Movember &, 2019 -

Schedule Recurrence

O Once
@ Daily
() Weekly Sunday i
() Monthly
Day [1 = | of every month.
The | First ~ | Sunday = of every month,

Cancel

4. From the Task Name drop-down menu, select Policy-based Groom.
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Click Options to access the Take Action dialog box.
Enter the settings in the dialog box and click OK.
In the Description field, enter a description of the scheduled groom.

© N o O

In the Schedule Startregion, set the time and data parameters when you want the
scheduled groom to take place.

In the Schedule Recurrence region, specify the frequency of the scheduled groom.
10. Click OK.

11.1.5 - Storage Resources

This page lets you rebuild the storage resource cache used in File Dynamics. Because File
Dynamics uses the storage resource cache to accelerate operations, there might be times
when you need to use this page to populate the cache with new shares.

To prevent burdening the File Dynamics Engine in listing or rebuilding all storage devices and
shares in the Active Directory forest or domain, you can “scope” the containers of the forest or
domain for storage devices and shares to be included or excluded as managed storage
resources.

Storage Resources Page

Identity-Driven Target-Driven Cross-Empire Data Migration Configuration

= 4308 0 E
o B & O I » 3
Status  Runtime Path Analysis Scheduled | Storage  Forest Agents | Event  Event | Check
Config Report Tasks Resources  Trusts Monitors Scope | Updates
Tools Assets Components
User: DOM\localadmin Engine Address: appl.dom.cetec.org
.| Storage Resources
== Engine Version: 6.5.0.53
Current Storage Resources Scope
[ Update Resources  ~ ) Update Server (D) SetSchedule  Tg Sharelnfo 5 Path Analysis Shares | T Clear [ Save
» /A dom.cdecorg s
Enter text to search... - || Find Clear + A domz.cctecorg
Shares Remov
Name Quota Support o s
» « B appl.dom.cctecorg Yes Object =
» B dcldom.cctecorg Yes e CN=Computers,DC=dom,DC=cctec,DC=0rg
> o dc2.dom2.cetec.org T5  CN=Computers,DC=dom2,DC=cctec,DC=org
v v _“_"’"“‘t“"“»‘ 5 OU=Domain Contrallers,DC=dom DC=cctec, DC=arg

\\dom.cctec.org\DFSWAtlanta
\dom.cctec.org\DFSI\HQ
\dom.cctec.org\DFS\London

T3 OU=Domain Controllers,DC=dom2,DC=cetec,DC=org

5 \\dom.cctec.org\DFS\Munich

2 \dom.cetec.org\DFS\NYC E—
\dom.cctec.org\DFS\SFO

T “dom.cetec.org\Public\Atlanta\Home S ]
" [ domz.cdecorg
= Object B
» " [ fsl.dom.cctecorg Yes

Last Update Time:  11/15/2019 12:00 AM Last Update Duration:  00:00:21
Mext Update Time:  11/16/2019 12:00 AM

Version: 6.5.0.59

Current Storage Resources: This region displays storage resources while providing tools for
performing actions pertaining to these storage resources.

Update Resources: Clicking this button initiates a search within the specified scope for all
available shares or DFS namespaces. When you create or edit a policy, you might need to
rebuild the list if the share or DFS namespace you need does not appear in the storage
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resource list. Depending on the size, configuration, and topology of your network, this can take
a significant amount of time.

Clear Resources: Available from the Update Resources drop-down menu, this option clears
the current storage resource list so that it can be completely rebuilt when issues arise.

Set Schedule: Allows you to set the schedule for rebuilding the storage resource cache.

Share Info: Selecting a share and then clicking this button opens the Server Share Properties
dialog box which displays the permissions and Local Security Authority (LSA) settings for the
share.

Share Info requires elevated privileges.

Path Analysis: Clicking this button opens the Path Analysis page for the selected share,
allowing you to browse it and do path analysis on any folder you select.

Scope: This region lets you specify the scope within Active Directory and the network file
system of the containers and servers to include and exclude. Based on the specified scope,
the available shares will be displayed in the Storage Resource list.

Shares: When you expand a container object and select a server, you can click Shares to
view details about the shares located on that server. Clicking Shares opens the Server Shares
Properties dialog box where you can view the permissions and Local Security Authority (LSA)
settings for each share.

Clear: Clicking this removes any object located in the Include and Exclude lists.

Save: Saves the scope settings.

Remove: Removes objects located in the corresponding Include or Exclude lists.

Last Rebuild Time: Displays the last date and time that the storage resource list was rebuilt.

Last Rebuild Duration: Displays the length of time it took to generate the new storage
resource list.

Next Rebuild Time: Displays the date and time when File Dynamics next rebuilds the storage
resource list. Unless rebuilt through the Rebuild button, the storage resource list is rebuilt
automatically at midnight each day.

Displaying Windows Server Clusters

If a Windows Cluster File Server Resource is not displayed in the Storage Resource List, verify
that the Description field of the cluster file server resource includes the words cluster and
virtual. If these two words are not included in the description, File Dynamics cannot see it
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as a storage resource.

cgad-vel Properties ? >
Location Managed By Object Securty Dial-n Attribute Editor
General QOperating System Member Of Delegation Password Replication
:E. sgad-vs1
Computer name (pre-Windows 2000): SEAD-VST |
DMS name: |sgad-w.rs1 dom cctec.org |
DC Type: |Glnbal Catalog |
Site: | Difautt-First-Site-Name |
Description: | Failowver cluster virtual network name account |
[ ok |  cance | ool Help

Once you modify the description in the Description field, you can perform a storage resources
discovery from the Scheduled Tasks page to add the resource to the Storage Resource List.
For more information, see Run a Storage Resources Discovery (page 153).

11.1.6 - Forest Trusts

Forest trust relationships provide security across multiple Active Directory forests. Before you
can authenticate across trusts and migrate folders from one forest to another, Windows must
first establish a trust path between the forests.

Forest Trusts Overview

File Dynamics has limited support for forest trusts for Target-Driven content control policies
(Copy, Move, and Vault policies) and for managing storage resources in another forest. The
trust cannot be leveraged to monitor for events in another forest.
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After a forest trust is configured for use, you will need to grant the proxy account appropriates
rights and permissions to shares on servers in the trusting forest. This is the same process
used for granting access to servers where Agents have not been deployed in the primary
forest. See Setting Rights and Privileges on Managed Storage in the File Dynamics 26.2
Installation Guide for details.

Supported Trust Models

Active Directory provides a number of configurations for forest trusts. File Dynamics currently
supports only forest-wide one-way incoming and two-way forest trust models.

Trust Type Direction Scope of Authentication Supported

External One-way ortwo-way | Selective or Forest-wide No

Forest One-way ortwo-way | Selective No

Forest One-way incoming or Forest-wide Yes
two-way

Shortcut One-way ortwo-way | Selective No

11.1.7 - Agents

File System Agents perform copying, moving, grooming, and vaulting. Phoenix Agents
conduct scans and enforcement forTarget-Driven Security Policies and Workload Policies. All
Agents tasks are done through directives from the Engine. File Dynamics determines which
Agent to use based on the task, as well as the target destination of the data or via proxy
configuration.

For optimum performance, File System Agents should be installed on all servers with storage
managed by File Dynamics. Agents run as a service on Windows.

The Agent page lets you:

¢ Authorize an Agent

¢ Verify that Agents are authorized

* View Agents software versions installed
¢ View Agent statistics

¢ Remove an Agent

¢ Configure a Proxy Agent
The Agent page also indicates:
¢ Whether the Agent is functioning as a Proxy Agent and for which server and share

Procedures for authorizing an Agent are located in Authorizing the Agents in the File
Dynamics 26.2 Installation Guide.
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Deleting an Agent

Within the Admin Client, you can delete a deauthorized Agent. Only deauthorized Agents can
be deleted. If you want to remove an Agent, you must deauthorize it first.

If an Agent is deauthorized and it hasn't successfully sent a heartbeat within 7 days, it will
automatically be removed

Configuring Proxy Agents

For storage resources that do not or cannot host an Agent, for example a NAS (Network
Attached Storage) device, File Dynamics can utilize an Agent running on another server to
perform the copying, moving, grooming, and vaulting on the server or NAS device. In this type
of scenario, the Agent is serving as a “Proxy Agent.” Both File System Agents and Phoenix
Agents can serve as Proxy Agents.

A Proxy Agent can also be set up to reduce the workload on the Engine. For example, a Proxy
Agent can be configured for a server on one side of a WAN environment to move data from
one server to another on the same side of the WAN link. This keeps the data from crossing the
WAN link only to cross back again.

To configure a proxy agent:
1. In the Admin Client, click the Engine tab.

Click Agents.

From the Configure Proxies drop-down menu, select the Agent type you will be
configuring.

File System Agents Proxy Configuration

Enter text to se - Find Clear Enter text to search... M Find Clear

Servers without Authorized File System Age... = File System Agents (2)

dcl.dom.cctec.org appl.dom.cctec.org

dc2. dom2.cctec.arg fs1.dom.cetec.org

dom.cctec.org

Cancel
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The left pane displays all servers without an authorized Agent. The right displays
servers hosting Agents, and consequently, can serve as Proxy Agents

4. From the left pane, select and drag a listed server to one on the right pane that you want
to serve as a Proxy Agent.

File System Agents Proxy Configuration

Enter text to se ~ Find Clear Enter text to search... - Find Clear
Servers without Authorized File System Age... = File System Agents (2) =
dc2.dom2.cctec.org ~ appl.dom.cctec.org
dom.cctec.org dcl.dom.cctec.org

fs1.dom.cctec.org

Cancel

5.
6. Click OKto save the Proxy Agent assignments.

7. Click OKto save and close the proxy setting association.

11.1.8 - Event Monitors

The Event Monitor monitors changes to Active Directory based on create, move, rename, and
delete events.

You install one Event Monitor per domain, and it can run on a domain controller or a member
server. If you install the Event Monitor on a domain controller, the Event Monitor always
monitors the local server for changes in the domain. If you install the Event Monitor on a
member server, the Event Monitor identifies the closest available domain controller and
monitors it for changes in the domain. The Event Monitor runs as a service on Windows.

In the Event Monitors page, you can:

¢ Authorize an Event Monitor
 Verify that an Event Monitor is authorized

* View the Event Monitor software version installed
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* View Event Monitor statistics

¢ Remove an Event Monitor

The Event Count number indicates the total number of events sent from the Event Monitor to
the Engine.

Procedures for authorizing the Event Monitor are located under Authorizing the Event Monitor
in the File Dynamics 26.2 Installation Guide.

Deleting an Event Monitor

Within the Admin Client, you can delete a deauthorized Event Monitor. Only deauthorized
Event Monitors can be deleted. If you want to remove an Event Monitor, you must deauthorize
it first.

11.1.9 - Event Scope

Rather than burdening the Event Monitor in observing all events in the Active Directory forest
or domain, this feature lets you “scope” the segments of the forest or domain that the Event
Monitor will monitor. A scoped segment of the forest or domain might include specific
containers or groups.

For procedures on how to use this feature, see Event Monitor Scoping (page 7). For a
complete discussion of the Scope feature, including Include and Exclude behaviors, see .

11.1.10 - Check Updates

This page compares the version numbers of File Dynamics components that you have
installed with the latest versions available. It also provides links for downloading the latest
versions of each of the components.

11.2 - Identity-Driven Tab

The Identity Driven tab provides access to tools for creating and managing ldentity-Driven
policies in File Dynamics.

11.2.1 - Statistics

This page charts graphical statistics for all Identity-Driven actions taken over a specific period
of time.
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Statistics Page

Identity-Driven Target-Driven

Cross-Empire Data Migration

Configuration

w & R R B

Statistics  Identity Policies Adion Management Pending
Objects Blocks Actions Events

Management
/%) Identity Event Statistics

Show statistics for | 30 days i3 Refresh

Event Counters

Queued Pending Events: 1 Latest Event:

Unparsed Pending Events: 0 High Transaction Number:
Type Count
~ | All Events 16596

~ | Collaborative 12302

Update Collaborative Home Folder...

Delete Collaborative

TSGR _

Collaborative

v | User

Version: 6.5.0.59

Check Actions
Reports

11/15/2019 11:14 AM
49944

10000
1000

100

Consistency  Management Poliq  Work Log

Paths

@ Ok

Global Statistics ~ Global ~ Anomaly
Collector Statistics  Reports

Global Statistics

11/14/2018

11/15/2018

User: DOM\localadmin

Engine Address: appl.dom.cctec.org
Engine Version: 6.5.0.53

+ Accepting Events | Processing Events

@ Remove Member
@ Update Collaborative Home Folder Owner
@ Delete Collaborative
- Create Collaborative
@ Add Member
@ Set Policy Collaborative
Pravision Multi-Principal Collaborative Storage
@ Delete User
Remove User Membership
- Create User
@ Add User Membership
@ SetPolicy User

By default, all actions indicated in the legend will appear on the chart. To make the chart less

busy, you can remove categories by holding the Control key and in the left pane, deselecting
categories.

11.2.2 - Identity Objects

The Identity Objects page lets you manage the associations between File Dynamics Identity-
Driven policies and Active Directory objects such as organizational units, groups and users.

This management includes creating organizational units, setting context, viewing properties,
performing Management Actions, and assigning policies.
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Identity Objects
. Identity-Driven Target-Driven Cross-Empire Data Migration Configuration
= m = = =
w B RE R 3 B B ZE & Ok
Statistics | Identity Policies Action Management Pending =~ Consistency Management Poliy Worklog —Global Statistics  Global  Anomaly
Objects Blocks  Actions Events Check Actions  Paths Collector  Statistics  Reports
Management Reports Global Statistics
?8 Identity Objects User: DOM\ocaladmin Engine Address: app1.dom.cctec.org
Engine Version: 6.5.0.53
Browse Search | ' Refresh Fg Actions- [ Assign Policy ) Properties  [v| Containers || Groups [v] Users
v /A dom.cctec.org Hame =
> Tg Builtin & Adam James
’ ?'F‘: Z::pums & aicia Nance
» Ta admin accounts & Ann Reid
+ T4 Atlanta & Brenda Nabors
+ T ET L o oo
» 2 Groups & Charles Edwards
> & Ha & Darii Thomas
» T London L Disne Adams
: E :«:Cmm &L Dickey Betts
> fo Service Accounts & szmes ecord
» T sFo & Julia Munz
> g Domain Controllers L karen Farks
» g ForeignSecurityPrincipals L Lance Jones
> T2 Managed Service Accounts & Pt Davis
> g Program Data
> Tg System
> fg Users
> /A dom2.cctecorg
4 4 Recordlof1d4 w4+ — S S %

Version: 6.5.0.59

Left Pane

Use the left pane to browse and select organizational units in the directory. Right-clicking an
organizational unit in the left pane lets you take additional actions:

¢ Create an organizational unit (OU)

¢ Set the directory context in the left pane to display the hierarchy from the root or from
the selected organizational unit

Right Pane

Use the right pane to view the objects within a selected organizational unit as well as view
properties, perform Management Actions, and assign policies. The right pane displays
containers (organizational units), groups, and users, according to what you have selected in
the Filter check boxes.

When you perform actions in the right pane, it is important that you know whether you are
performing management specific to users, groups, or organizational units (containers).

Assign Policy

Right-clicking a User, Group, or Organizational Unit object and selecting Assign Policy lets
you easily assign any of these objects a policy while you are in the Objects page. If an
effective policy is already assigned to one of these objects, you can assign a new policy,
replacing the effective policy with an assigned policy.
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Policy Selector Dialog Box

Assign Policy for CN=Adam James, OU=Employees, OU=Atlanta,OU=dom,DC=do...

Enter text to search.., - Find Clear
Palicy =  Policy Type Path Type
Atlanta Users Home Folder
; Atlanta Users Larger Q... User Haome Folder
; Elocking Policy User Home Folder
; Corporate Template P... | User Home Folder
; HO Users User Home Folder
& HR Users User Home Folder
& London Users User Home Folder -
[ ok | concel
Properties

You can easily view an expanded set of object properties in the Objects page by right-clicking
an object in the right pane and selecting Object Properties.

The five tabs display the following information:
Properties: Displays Active Directory values and Engine database values.

Effective Policies: Lists all of the effective policies for the selected object. An effective policy
is a policy that affects a user either directly through association or inheritance by membership
in a domain, container, or group.

Associated Policies: Lists all of the associated policies for an object. An associated policy is
an explicitly assigned policy associated with a domain, container, group, or user.

Transactions: Shows pending events for the selected object. If there are many pending
events, but you only want to see those pertaining to a particular user, you can see the pending
events for the User object.

History: The GSR Collector maintains multiple histories for an object in Active Directory.

The FDN History records the FDN and SAM Account name of an object, when applicable (e.g.
organization unit objects do not have a sAMAccount attribute). When an object gets renamed
or moved, on the next run, it will catalog the new location or new name and the corresponding
timestamp when the change was recorded.

The Path History records the location of paths that are commonly associated to users. When
the Active Directory schema is extended to support user auxiliary storage and collaborative
storage, the managed path attributes for user auxiliary, groups, and containers can be
cataloged as well. The Path History consists of path types that are managed by File Dynamics.
The possible recorded path types are:
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e User Home folder

¢ User Profile path

¢ User Remote Desktop Services Home Folder

¢ User Remote Desktop Services Profile Path

e User Auxiliary (ccx-FSFAuxiliaryStorage)

e Collaborative - Groups (ccx-FSFManagedPath)

e Collaborative - Container (ccx-FSFManagedPath)

The granularity of the historical data is only as fine as the frequency at which you schedule the
GSR Collector to run. For more information, see Global Statistics Collector (page 193).

If you schedule it to run once a week and you have objects that move several times over the
course of a week between the runs, you'll lose the interim historical move data.

The GSR Collector's historical data can be especially useful when managed paths are moved
based on policy.

To view the history of an object, from the Objects page, display a User object in the right pane
and then double-click it.

In the Object Properties dialog box, click the History tab.
The example below shows an unmanaged user without a cataloged path.

Example of an Unmanaged User without a Cataloged Path

Object Properties - CN=5amatha Jones, OU=Employees,0U=5F0,0U=dom,DC=dom,DC=cctec, DC=0rg

Properties Effective Policies Associated Policies Transactions History

FDM SAM Account Name Maming Attribute MName Date,/Time
Samatha Jones.Employees.... sjones 11/15/2019 2:42 PM
Purpose Path Policy Date/Time

The FDN column is the LDAP formatted location of the object. The SAM Account Name
column is the sAMAccount attribute value. The Date/Time column is based on the local time of
the Engine when the history record was cataloged.
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The example below shows the same unmanaged user that was moved from one
organizational unit to another. This example demonstrates a change in the FDN and the date
when the new value was cataloged by the GSR Collector when it was run.

Example of a Moved Unmanaged User

Object Properties - CN=5amatha Jones,0U=Administration,0U=5F0,0U=dom, DC=dom,DC=cctec, DC=org

Properties Effective Policies Associated Policies Transactions History

FOM SAM Account Mame MNaming Attribute Mame Date/Time
019 2:42 PM
11/15/2019 2:45 PM

Samatha Jones.Employees....

Samatha Jones.Administra... @ sjones

Purpose Path Policy Date,/Time

The example below shows an unmanaged user that has a home folder. The Policy column is
empty because this user has not been managed. The Date/Time column for the path indicates
the time at which the GSR Collector recorded the path.

Example of an Unmanaged User with a Home Folder

Object Properties - CN=Heidi Belheim,OU=Employees, 0U=5F0,0U=dom, DC=dom,DC=cctec, DC=org

Properties Effective Policies Associated Policies Transactions History

FDOMN SAM Account Name Maming Attribute Mame Date/Time

Heidi Belheim.Employeas.... | hbelheim 11/15/2019 2:51 PM

Purpase Path Palicy Date/Time

Home Folder ‘Wsl.dom.cctec.orghShares\Munic...  Munich Users 11/15/2019 2:49 PM
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The example below shows the same user that has now been managed. The path now
contains two entries. The first path reflects when the user was originally cataloged. The
second path reflects that the user is now managed and the policy that is managing it. This is
useful because the Date/Time for Policy “History” indicates when the object became
managed.

Example of a Managed User

Object Properties - CN=Adam James, OU=Employees 0U=Atlanta, OU=dom, DC=dom,DC=cctec, MC=0rg

Properties Effective Policies Associated Policies Transactions History

FDOMN SAM Account Name Maming Attribute Mame Date/Time

Adam James.Employees.Atl.. ajames displayMame Adam James 11/15/2019 2:27 PM
Adam James.Employees.Atl.,  ajames displayMame Adam James 11/15/2019 2:28 PM
Purpose Path Palicy Date/Time

Home Folder ‘Wis1.dom.cctec.orgh\Shares\Atlant...  Atlanta Users Larger Quota 11/15/2019 2:27 PM

The example below shows the same user has now been moved from one container to another
that is managed by a different policy. The user's new FDN has been recorded as well as the
new location of the path.

Example of a Moved Managed User

Object Properties - CN=5teffi Strauss,OU=Employees, OU=Munich,0U=dom,DC=dom,DC=cctec, DC=o0rg

Properties Effective Paolicies Associated Policies Transactions History

FDM SAM Account Mame Maming Attribute MName Date/Time

Steffi Strauss.Employees.... sstrauss s&MAccountName sstrauss 11/15/2019 2:32 PM

Steffi Strauss.Employees.A... | sstrauss displayMame Steffi Strauss 11/15/2019 3:15 PM

Steffi Strauss.Employees.... sstrauss sAhAccountMame sstrauss 11/15/2019 3:26 PM

Purpose Path Policy Date/Time

Home Folder ‘Wis1.dom.cctec orghShares\Atlant..,  Atlanta Users 11/15/2019 3:15 PM
‘Whs1.dom.catec.orghShares\Wunic... | Munich Users 11/15/2019 3:26 PM
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The example below shows the same user has how been moved to a container that is not
managed by policy. The Policy column now shows that the path is no longer managed by an
effective policy.

Example of a Moved User to a Container Not Managed by a Policy

Object Properties - CN=Peter Uiz, OU=Employees, OU=5F0,0U=dom,DC=dom, DC=cctec, DC=org

Properties Effective Policies Associated Policies Transactions History

FOM SAM Account Mame MNaming Attribute Mame
Peter Liz.Employees. Muni.. putz sAMAccountMame putz
Peter Ltz.Employees, SFO... putz

Purpose Path Policy

Home Folder “WWis1.dom.cctec.orghShares\Munic...  Munich Users

“Wis1.dom.cctec.orghShares\Munic...

Date/Time

11/15/2019 2:32 PM
11/15/2019 3:30 PM

Date,/Time
11/15/2019 3:28 PM
11/15/2019 3:30 PM

The History data also tracks the rename of objects and the relevant paths. The example below

shows a managed user before it has been renamed.

Example of a Managed User Before Being Renamed

Object Properties - CN=5ofie Shultz,0U=Employees,OU=Munich,0U=dom, DC=dom,DC=cctec, DC=org

Properties Effective Policies Associated Policies Transactions History

FDOMN SAM Account Name Maming Attribute Mame
Sofie Birkner.Employees.M... sbirkner sAMAccountMame shirkner
Purpose Path Palicy

Home Folder ‘Wis1.dom.cctec.orghShares\Munic...  Munich Users

“Wsl.dom,cctec.orghShares\Munic.. | Munich Users
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The example below shows the new FDN, SAM Account Name, and Path after having been
renamed.

Example of a Managed User After Being Renamed

Object Properties - CN=5ofie Shultz,0U=Employees,OU=Munich,0U=dom, DC=dom,DC=cctec, DC=0rg

Properties Effective Policies Associated Policies Transactions History
FDM SAM Account Mame MNaming Attribute Mame Date/Time
Sofie Birkner.Employees.M... sbirkner sAMAccountMame shirkner 11/15/2019 2:32 PM
Sofie Shultz.Employees.M... | sshultz sAMAccountMame sshultz 11/15/2019 3:35 PM
Purpose Path Policy Date,/Time
Home Folder

11.2.3 - Policies

The Policies page displays all policies, along with a summary of policy details. When you
select a policy, applicable tools in the toolbar are activated. A summary of the toolbar follows.

All of these tools are also accessible by right-clicking a selected policy.
Manage: Lets you create any of the following policies:

e User Home Folder

e User Profile Path

¢ User Remote Desktop Services Home Folder

¢ User Remote Desktop Services Profile Path

e Group Multi-Principal Collaborative

¢ Group Collaborative

e Container Collaborative

¢ Auxiliary
Edit: Brings up the Policy Editor, where you can edit the selected policy.
Rename: Lets you rename the selected policy.
Delete: Lets you delete the selected policy.

Auxiliary Purpose Mappings: Selecting this brings up the Auxiliary Purpose Mappings page,
where you can establish or edit Auxiliary Purpose Mappings.

169



11 - Reference

Auxiliary policy mappings give you the ability to specify a purpose or classification for auxiliary
storage policies. For example, you might want to create an HR purpose for all of the auxiliary
storage policies that create HR folders for employees. With each of the auxiliary storage
policies that create HR folder assigned the same purpose, it makes it possible for File
Dynamics to make intelligent decisions for auxiliary storage when a user is moved.

For example, if a user in the Detroit office transfers to the Dallas office, and the user has a
home folder and an auxiliary storage folder in the Detroit office’s HR department, you want to
migrate both the home folder and the auxiliary storage folder to correct locations in Dallas.
Having the Detroit auxiliary storage policy and the Dallas auxiliary storage policy identified
with the same HR purpose, ensures that the user moved from Detroit to Dallas, will have his
auxiliary storage properly established with the move. For procedures on establishing Auxiliary
Purpose Mappings, see Establishing Auxiliary Purpose Mappings (page 53).

Import: Provides the ability to import policies that were previously exported through the Export
menu option.

Policy associations are not imported. After policies are imported, you need to associate the
policies to containers or groups.

For more information on importing policies, see Importing Policies (page 55).

Export: Provides the ability to export policies so that they can be imported later. For example,
many customers first evaluate File Dynamics in a lab environment and create a large number
of policies in the process. You can export these policies and later import them into the
production environment. All exported policies are saved in a single XML file. For more
information, see Exporting Policies (page 54).

Actions: Provides menu options that are applicable to Auxiliary policies. To activate this menu,
click an Auxiliary policy. Menu options include Manage, Groom, Apply Attributes, Apply Quota,
Apply Rights, and Assign Auxiliary Attributes.

Redistribute: Allows you to define additional target paths in the policy and then redistribute or
load-balance the data among the various paths.
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Redistribute Policy Paths Dialog Box

Redistribute Paths for: Atlanta Users

Policy | Atlanta Users EBrowse

nThe Global Statistics collector process was last run on 11/26/2019 10:22 AM

Distribution Type | Data Size ~ Calculate + | Show All Field:
Path Volume Size Volume Free Current Percent | Target Percent Current Data.. = Projected Dat... = Current Direct... Projected Dire... = Current Quot.. = Projected Quota...
‘\dom.cctec.o... 0 bytes 55 GB 056 508 : 0 bytes 0 bytes 0 0 0 bytes 0 bytes
Ws1.dom. ccte... 0 bytes 55 GB %% 50% - 0 bytes 0 bytes 12 o 4GB 0 bytes

Total Assigned Percentage: 100%

Using the Redistribute Paths dialog box, you can redistribute the user and collaborative
storage across the target paths associated with a policy.

The data displayed in the dialog box is taken from the most recent report from the GSR
Collector.

Use the Distribution Type drop-down menu to view your data distribution according data size,
directory count, and quota commitment.

Click Nextto view the current locations of the home folders and collaborative storage folders,
and the location where File Dynamics proposes to redistribute the folders. If you want, you can
deselect a folder for distribution by deselecting the check box corresponding to the folder. You
can also indicate a new target path for the folder by clicking in the Target Policy Path column
and selecting a new target path.

Clicking Submit begins the process of redistributing the folders.
Search: Provides a search field for locating policies.
Refresh: Refreshes the list of policies.

Refreshing locks the database during the refresh operation. For best performance, do not
refresh more than is necessary.

Reload: Reloads your policies from the database. You can use this tool, for example, if you
have a new policy that is not displayed in the list.

Check Boxes: The Admin Client shows only the policy types that are checked.
11.2.4 - Action Blocks

This page lets you create Action Blocks that can be linked to a policy.
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Action Block Overview

Action Blocks allow the sharing of specific policy options between multiple policies. The
design goal behind Action Blocks is to provide a framework where the sharing of options
between policies can be achieved in a straightforward and easy to understand manner.

Action Block Overview

User Policy A
User Policy B ek s
Group Policy X

Action Blocks do not introduce a new policy type. Rather, they are extensions of policies in that
the set of options they represent are not contained within the policy itself. This eliminates the
need for policies to inherit from each other and promotes the sharing of general and often-
repeated policy options such as groom and vault rules. Existing User, Group, and
Collaborative policy types remain as they previously did with the exception that they have
been extended to support a relationship value providing the necessary link for a given Action
Block.

An Action Block can have a many-to-one relationship. This means that any number of policies
can share any particular Action Block for a given policy option. Action Block inheritance cannot
be chained. That is to say, “Policy A” cannot inherit the Filter rules from “Groom Block A” and
“Groom Block B”. “Policy A” can only be to linked to one of the two Action Blocks and they do
not inherit from each other. When changes are made to an Action Block, those changes are
implicitly taken up by every linked policy. Thus, before making changes to an Action Block, it is
important to understand the impact of those changes. As with normal event processing and
policy editing, if a change is made to an Action Block while an event is in-flight for its given
options, those changes may not be reflected in the outcome of the event.

Private Versus Shared
Regardless of an Action Block’s type, it is either Private or Shared.

A Private Action Block represents a set of policy options that aren’t shared, yet have been
migrated to the Action Block architecture. Private Action Blocks are also created and
associated to a policy when the policy is upgraded as new Action Block types are supported.
Below is an example of the relationships between policies and their Private Action Blocks for
Filters. Any of these might be the result of creating a new policy with Groom Rules or an
upgrade from the legacy policy architecture.
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Relationships Between Policies and their Private Action Blocks for Filters

Private Action Blodk
User Policy A
Groom Rules

Private Action Blod:

User Policy B - ; User Policy B
Groom Rules

Private Action Block
Group Policy X Group Policy X
Groom Rules

When you create an Action Block, it is automatically marked as Shared and is available for
being shared with other policies. However, if you edit a policy that does not derive a particular
policy option from an Action Block, a Private Action Block is created and associated to the
policy when the policy is saved. If you change a policy that has a Private Action Block to use a
Shared Action Block, the policy’s Action Block reference is updated to that of the Shared
Action Block and the Private Action Block is deleted.

Shared and Private Action Block Associations

Private Action Blodk
User Policy A Linked to User Policy &
GroomRules

User Policy B

Shared Action Blodk

Groom Rules

Linked to

Group Policy X

By default, a Private Action Block is not viewable in the list of Shared Action Blocks.
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Creating a Filter Action Block

In the Admin Client, click the Identity Driven tab.

1
2. Click Action Blocks.
3.
4

Select Manage > New> Filter.

In the Name field, give the new Action Block a name and click OK.

The following dialog box appears:

Action Block Editor - NYC User Groom

General Rules

Y Rules = Add Delete 'I‘ Edit * Promote \'4 Demote
E:"- Options

Description Action Masks File Size Create Time Maodify Time Access Time
¢§’ Linked Policies

oK Cancel Apply

Rules: Rules are composed of the standard File Dynamics rule options. Rules cans be
added, deleted, edited, promoted, and demoted. Once a Filter Action Block is saved,
those settings will be effective immediately.

Options: The Description option can be used to provide detailed context for the usage
and implementation of the Filter Action Block.

Linked Policies: Linked Policies is a read-only view of which policies are linked to the
Filter Action Block.

5. Click Add.

7.

In the Rule Editor, specify the parameters for the Action Block Filter and click OK.

For procedures on entering settings in the Rule Editor, see Setting Vault Rules (page

39).
Click OKto close the Action Block Editor dialog box.

Linking Filter Action Blocks

Filter Action Blocks can be linked to the following:

e Policy-based Vault

¢ Policy-based Groom
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These procedures specify how to link a Filter Action Block to an existing policy. You can also
link a Filter Action Block to a new policy as you create one.

1. Inthe Admin Client, click the Identity Driven tab.
2. Click Policies.
3. Right-click a selected policy and select Edit.
4. Click either Vaultor Groom.
5. Click Link Action Block.
6. From the Action Block Selector dialog box, select the Filter Action Block you want to
link.
Action Block Selector
Enter text to search... - Find Clear
Mame Type
f Archive Files Older Than Five Years | Filter
f Delete GroupWise Archive Files Filter
Y Delete Temp Files Filter
f Groom Files Older Than 10 Years Filter
Y Vault on Delete Rules Filter
MNYC User Groom
f Main Groom Rules Filter
Cancel
7. Click OK.

The link is specified in the Groom Rules or Vault on Delete Rules header.

When a policy's Vault or Groom Rules are linked to a Filter Action Block, the rules
displayed in the policy editor are read-only. To edit the Filter Action Block, click the

name as it appears in the header.

8. Click OK'to save the link.

Creating a Managed Path Naming Attribute Action Block

You can use a Managed Path Naming Attribute Action Block to specify the haming attribute
and its corresponding definition, to an existing policy.
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For specifications pertaining to Managed Path Naming Attribute, see Managed Path Naming
Attribute Specifications (page 259).

e nh =

176

In the Admin Client, click the Identity Driven tab.
Click Action Blocks.
Select Manage > New> Managed Path Naming Attribute.

In the Name field, give the new Action Block a name and click OK.

The following dialog box appears:

Action Block Editor - NYC Managed Path Naming Attribute

General Options

§3 Managed Path Maming Attrib... Policy Type | User/User Auxiliary =~
Eli Options Attribute | sAMAccountName -
¢§’ Linked Policies

oK Cancel Apply

Managed Path Naming Attribute: Displays the Policy Type and Attribute drop-down
menus.

Options: The Description option can be used to provide detailed context for the usage
and implementation of the Managed Path Naming Attribute Action Block.

Linked Policies: Linked Policies is a read-only view of which policies are linked to the
Managed Path Naming Attribute Action Block.

From the Policy Type drop-down menu, specify whether the Managed Path Naming
Attribute Action Block will be linked to a User/User Auxiliary policy or a Group
Collaborative storage policy.

The attributes types that you can select vary based on the selected policy type.

From the Attribute drop-down list, select one of the single-valued Active Directory
attributes for the User or Group object.

You have the ability to specify an attribute other than sAMAccountName. This ability
was added to provide network administrators the ability to give provisioned folders a
more descriptive name.

Once you select a different attribute, you can then use an account provisioning system
such as NetlQ Identity Manager to automatically populate the selected attribute with a
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desired folder name and then File Dynamics will automatically provision the home
folder based on this attribute setting.

For more information, see Setting Target Paths (page 34)

Click Apply.

Linking a Managed Path Naming Attribute Action Block to a Policy

These procedures specify how to link a Managed Path Naming Attribute Action Block to an
existing policy. You can also link a Managed Path Naming Attribute Action Block to a new
policy as you create one.

7.

o s~ wh =

In the Admin Client, click the Identity Driven tab.
Click Policies.

Right-click a selected policy and select Edit.

In the Policy Editor, click Target Paths.

Click Link Action Block.

Select the Action Block you want to link.

Click OK.

Creating a Move Schedule Action Block

Use Move Schedule Action Blocks to standardize when data can be moved during data
movement operations.

1.

In the Admin Client, click the Identity Driven tab.

2. Click Action Blocks.

3. From the Manage menu, select New > Move Schedule.

Create New Move Schedule Action Block

Mame ||

DK Cancel

Enter a descriptive name for the new Action Block and click OK.
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6.
7.

The following page appears:

Action Block Editor - NYC Move Schedule

General

G—) Move Schedule
Eli Options
(f’ Linked Policies

Color Key

DDDDDDDDDDDDDD . Allowed to move

r Not allowed to move

o
o

4 »

By default, all days and times are available for data movement. If data movement during
regular business hours creates unacceptable network performance, you can choose to
move data after regular business hours.

In the Move Schedule grid, click the squares for the day and hour you want to disable
for data movement.

Click Apply to save your settings.
Click OKto close the page.

Linking a Move Schedule Action Block to a Policy

These procedures specify how to link a Move Schedule Action Block to an existing policy. You
can also link a Move Schedule Action Block to a new policy as you create one.

8.

N o s~ webh =

In the Admin Client, click the Identity Driven tab.
Click Policies.

Right-click a selected policy and select Edit.

In the Policy Editor, click Move Schedule.

Click Link Action Block.

Select the Action Block you want to link.

Click Apply to save your settings.

Click OKto close the page.

Creating a Multi-Principal Suffix Mapping Action Block

Use Multi-Principal Suffix Mapping Action Blocks to standardize the groups and their
associated permissions for the collaborative storage folders that are provisioned by File
Dynamics.
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1. Inthe Admin Client, click the Identity Driven tab.
2. Click Action Blocks.

3. From the Manage menu, select New > Multi-Principal Suffix Mapping.

Create New Multi-Principal Suffix Mapping Action Block

Mame |

(o] 4 Cancel

4. Enter a descriptive name for the new Action Block and click OK.

The following page appears:

Action Block Editor - Managed Storage multi-principal suffix

General Multi-Principal Suffix Settings
§ Multi-Principal Suffix Settings Suffix Separator | -
E} Options

(f’ Linked Policies Sutfix Mappings
== Add Remove

Security Suffix = Permission

OK Cancel Apply

A Changes to this Action Block have not been saved.

Click Add.

In the Security Suffix column, highlight SampleSecuritySuffix and edit it to a more
descriptive name of a group that will access the collaborative storage folder.

7. Click the Full Control setting to access a drop-down menu of access permissions.
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8.

9.

10.
11.

Specify the permissions for the particular group and click OK.

Suffix Mappings

= Add == Remove

Security Suffix =  Permission
F Full Control -]
2
RO Madify
RW Read & Execute

List

Read

Write

OK Cancel

Repeat Step 5 through Step 8 to create all groups and permissions to the collaborative
storage folder.

Action Block Editor - Multi-Principal Suffix Mapping

General Multi-Principal Suffix Settings
#8 Multi-Principal Suffix Settings Suffix Separator | -
E Options

<§’ Linked Policies Sutfix Mappings

o= Add == Remove

Security Suffix =  Permission
F Full Control
M Modify

Read & Execute

RW Read & Execute, Read, Write

oK Cancel Apply

Click Apply.
Click OK.

Linking a Multi-Principal Suffix Mapping Action Block to a Policy

These procedures specify how to link a Multi-Principal Suffix Mapping Action Block to an
existing policy. You can also link a Multi-Principal Suffix Mapping Action Block to a new policy
as you create one.

1.

180
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In the Admin Client, click the Identity Driven tab.

Click Policies.

Right-click a selected Group Multi-Principal Collaborative policy and select Edit.
In the Policy Editor, click Provisioning Options.

Click Link Action Block.

Select the Action Block you want to link.



7.
8.
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Click Apply to save your settings.
Click OKto close the page.

Creating a Target Paths Action Block

Use Target Paths Action Blocks to standardize the placement rules for the managed path, as
well as the paths to the shares where managed paths will be hosted.

AL nh o=

In the Admin Client, click the Identity Driven tab.
Click Action Blocks.
From the Manage menu, select New > Target Paths.

Enter a descriptive name for the new Action Block and click OK.

The following page appears:

Action Block Editor - NYC Target Paths

General Target Paths
_-___ Target Paths Placement Rules
Distribution
(5’ Linked Policies
Leveling
Leveling Length 0 =
Path Distribution
Maximum Unreachable Paths [
Paths
== Add Remove
Path =
oK Cancel Apply

5. Click Addto access the Path Browser.

Browse to the location of the target path you want and click Add to add the target path to

the Selected Paths pane.

7. Click OK'to close the Path Browser.

9.
10.

In the Placement Rules region, specify a Distribution field setting and if you choose,
Leveling parameters.

For more information on target path distribution and leveling, see Setting Target Paths

(page 34).
Click Apply.
Click OK.

Linking a Target Paths Action Block to a Policy

These procedures specify how to link a Target Paths Action Block to an existing policy. You
can also link a Target Paths Action Block to a new policy as you create one.
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In the Admin Client, click the Identity Driven tab.
Click Policies.

Right-click a selected policy and select Edit.

In the Policy Editor, click Target Path Options.
Click Link Action Block.

Select the Action Block you want to link.

Click Apply to save your settings.

© N o gk e =

Click OKto close the page.
11.2.5 - Management Actions

In managing user and collaborative storage with File Dynamics, there are cases when you
need to retroactively apply policies, rights, attributes, and quotas to existing user storage, or
perform some administrative corrective action or operation on a large set of users, groups, or
containers.

In File Dynamics, performing these types of operations is collectively referred to as performing
a Management Action and is done through the Take Action page.

You can perform a Management Action on an organizational unit, a Group object, or a User
object. Management Action operations on a Group object apply to users who are members of
the group. Management Action operations on an organizational unit apply to users in the
organizational unit, and optionally to all subordinate organizational units.

The Management Actions vary based on whether the selected mode is User, Group, or
Container. For example, if Group mode is selected, the Management Action will be performed
for collaborative storage processing using Dynamic Template processing. If Collaborative
mode is selected, the Management Action will be performed for container based collaborative
storage.

File Dynamics analyzes each User object independently, regardless of whether the
Management Action is initiated via organizational unit, Group objects, or User objects.

Management Actions Dialog Box

Whenever you initiate a Management Action, you work in a dialog box similar to the one
below. A description of the components follows the graphic.
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Management Action Dialog Box

Management Action - User Mode

Execute ; User Mode - Consistency Check ’ha Management Action ~ G Refresh Results
Consistency Check Targets
== Add Remove | [ Select All  [] Deselect All

H Remote Desktop Services Home Folder

Pi Remote Desktop Services Profile Path FON

Auxiliary
| Process Subcontainers Mask

[ Select Al [] Deselect All Add to Targets
Results Primary Path Statistics
MName = DS Path Home Drive Path Type Ds Path... Policy Flags Permissi... Quota  Manage... Mgmt Path | Mgm... = Paths Match

Execute: Clicking this button executes the management action. Once you have specified a
target and selected a Management Action, a Preview option appears, allowing you to preview
the effects of the Management Action before executing the action.

Mode: This drop-down menu lets you indicate if the Management Action is to apply to a User,
Group, or Container policy.

Consistency Check: This button lets you perform a consistency check before determining
what Management Actions to perform. You can also use the Consistency Check button to view
the results after you perform a Management Action.

A consistency check notifies you of inconsistencies or potential problems pertaining to user
and group storage being managed through File Dynamics. These potential problems might be
missing storage quotas, inconsistent directory attributes, missing and inconsistent managed
paths, and more.

In addition to reporting on storage issues, consistency check reports let you review current
quota assignments and can help you with the design and planning of storage policies. In
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Running Consistency Check Reports on Existing Storage (page 15), you ran a consistency
check before creating your first primary user policy to help you determine how to configure the

policy.

Management Action: This drop-down menu lets you change from one Management Action to
another while you are in the dialog box.

Refresh Results: This button refreshes the results displayed in the bottom pane of the dialog
box.

Top Left Pane: The fields, options, and check boxes in this region vary based on the
Management Action you are performing. In some cases, there is nothing in this region,
because there are no settings to create. This region includes some powerful options for
Management Actions, including the following:

¢ Process Subcontainers

¢ Mask

When you perform a Management Action on an organizational unit, File Dynamics applies the
action to all subcontainers. If you do not want the action applied to subcontainers, you can
deselect the Process Subcontainers check box.

For Management Actions performed on organizational units or Group objects, you can enter a
search filter in the Mask field to limit the number of objects that File Dynamics analyzes. You
can enter standard wildcard characters with multiple strings separated by the “|” character.

Top Right Pane: This part of the dialog box lets you add, delete, or select objects to which the
Management Action applies.

Bottom Pane: This part of the dialog box displays the results after the Management Action has
taken place. To expand the viewable area, click the *.

Available Management Actions

File Dynamics lets you perform an extensive set of Management Actions. For details on each,
click a link below.

Manage
This Management Action catalogs objects in File Dynamics, putting them in a managed state.

If the existing objects already have established managed paths, attributes, and rights, File
Dynamics does not change these settings, nor does it enforce policy paths, grooming, and
qguota management. If you need to change attributes and rights, or enforce policy paths,
grooming, and quotas, you can do so through the specific Management Actions.

If these existing objects do not have established managed paths, Manage creates the
managed paths and sets the rights, attributes, quotas, etc. according to the policies that apply
to the objects.

Enforce Policy Path

This Management Action moves data to where the policy’s target path specifies. If you decide
to move your user home folders from one location to another, you can simply change the
target path in the policy and then select Enforce Policy Path to move the home folders.
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The Enable pre-stage data copy option lets you copy data without alerting you to failures if
there are files open. When a user is moved in Active Directory and the policy dictates that the
home folder is to be moved to a new target path, this option allows for all closed files to be
moved. At a later time, you can go back and run an Enforce Policy Path Management Action
without the Enable pre-stage data copy check box selected, to move the files that were
previously open.

Enforce Policy Path for Vault

This Management Action will set or reset the user's vault path to one that matches their
managing policy's vault path. This can be useful in cases where a previous vault is no longer
valid. For example, when an administrator decommissions the previous server or share used
for vaulting and has established a new vault location.

Groom

This Management Action carries out file grooming according to the file grooming specifications
in the applied policy.

Apply Attributes

This Management Action lets you apply file system attributes. If you decide to modify the file
system attributes in a policy, you can select Apply Attributes to immediately apply the new
attributes for all of the affected objects.

If you cataloged existing objects with existing managed paths through Manage, the attributes
for the managed path are not modified once the object’s managed path attribute is cataloged
(see Manage (page 184)). If you want to modify the original attributes of the managed path,
you can do so through the settings in the in the left pane of the Apply Attributes dialog box.

Apply Home Drive

When the Home Folder check box is selected, this Management Action changes the home
drive letter for the user that is assigned under Active Directory, to the drive letter that is
specified in the File Dynamics policy.

If you have a File Dynamics Remote Desktop Services home folder policy and you want to
apply the drive letter that is established in that policy, you can select the Remote Desktop
Services Home Folder check box.

The new drive letter does not take effect until the user logs out and then logs in again.

Apply Members

This Management Action is included to create the owner folder and personal folders in a
collaborative storage area, where these folders did not exist previously. You must first modify
the collaborative storage template in the policy to include -OWNER- and -MEMBER-. For more
information, see Managing Collaborative Storage (page 65).

If you do have personal folders in the collaborative storage area and you later change the
rights on -MEMBER-, you use the Apply Members Management Action to enforce the new
rights.

Apply Owner

This Management Action lets you set ownership of the home folder and home folder contents.
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Apply Owner Management Action Page

Management Action - User Mode

q Preview Execute ; User Mode - Consistency Check G Management Action ~ G Refresh Results
Apply Ownership Targets

set Target Folder Owner == Add Remove | [/] Select Al [[] Deselect All
Use policy-defined ownership FON
Set to target identity
Set to selected identity

Browse Clear
Set Contents Owner
Use policy-defined ownership
Set to target identity
Set to selected identity
Browse Clear
./ Home Folder Remote Desktop Services Home Folder
Profile Path Remote Desktop Services Profile Path
Auxiliary
~'| Process Subcontainers Mask
[ Select Al [] Deselect All Add to Targets
MName =  Path Type Action Status

The ownership specifications you make on the page shown above are applied to folders and
files that exist at the time the Management Action takes place. The ownership of files and
folders that are created later is not affected by this action. For example, if a user's home folder
is moved due to an Enforce Policy Path action, the ownership of the user’'s home folder will be
determined by the settings in the policy.

Set Target Folder Owner: Select this check box to specify that the ownership applies only to
the home folder and not to any subfolders.

Use policy-defined ownership: This option sets the home folder owner according to the
specified owner in the Path Owner field of the policy.

Set to target object: When this option is selected, each of the selected users’ home folders is
set to have that User object as the owner.

Set to explicit object: This option lets you browse to select a specific owner for the home
folder.
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Set Contents Owner: Select this check box to specify that the ownership applies to the
subfolders and files contained in the home folder.

Use policy-defined ownership: This option sets the home folder contents owner according to
the specified owner in the Path Ownerfield of the policy.

Set to target object: When this option is selected, each of the selected users’ home folders is
set to have that User object as the owner.

Set to explicit object: This option lets you browse to select a specific owner for the contents of
the home folder.

Specify the policy types you want this Management Action to apply to by selecting from the
policy type check boxes.

Process Subcontainers: Selecting this option specifies that you want the settings on this page
to apply to users that reside in the subcontainers within the container where this policy is
applied.

Mask: For Management Actions performed on organizational units or Group objects, you can
enter a search filter in the Mask field to limit the number of objects that File Dynamics
analyzes. You can enter standard wildcard characters with multiple strings separated by the “|”
character.

Apply Quota

This Management Action lets you apply managed path quotas. If you decide to modify the
quota settings in a policy, you can select Apply Quota to immediately apply the new quota
setting to all of the affected users.

If you cataloged existing network users with existing home folders through Manage, there
might be no quota settings for the user home folders. Or, the quota settings might be
inconsistent with those specified in the policy. If you want to establish or reset the quota for the
home folder, you can do so through the settings in the left pane of the Apply Quota dialog box.

Apply Permissions

This Management Action lets you apply NTFS file system permissions. If you decide to modify
the file system permissions in a policy, you can select Apply Permissions to immediately apply
the new permissions for all of the affected users.

Apply Template

This Management Action lets you apply a template specifying how to provision user or
collaborative storage. If you decide to modify the template in a policy, you can select Apply
Template to immediately apply the new template structure to all of the affected users. This can
be especially useful if you need to quickly provision a new subfolder with a document, such as
a new health benefits document for all employees. All you need to do is modify the template to
include the new subfolder and document inside the subfolder and then use Apply Template to
provision it to everyone.

If you cataloged existing network users with existing home folders through Manage, the file
structure created by the template is not modified after the user and his or her associated home
folder are cataloged (see Manage (page 184)). If you want to modify the original file structure
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for the home folder, you can do so through the settings in the in the left pane of the Apply
Template dialog box.

Clear Managed Path Attribute

This Management Action removes the managed path attribute so you can create a new one.
Administrators might find this useful when users have invalid values for their home folder
attributes and want to start over by creating new ones.

Recover Managed Path Attribute

If the attribute for a user home folder, profile path, Remote Desktop Services home folder, or
Remote Desktop Services profile path ever becomes corrupted, this Management Action can
be used to recover an uncorrupted version of the attribute from the File Dynamics database.

Assign Managed Path

You can use this Management Action to assign an attribute to a user folder, profile path,
Remote Desktop Services home folder, or Remote Desktop Services profile path.

Directory Merge

This Management Action lets you merge contents of one home folder with those of another.
This is especially useful if a user leaves an organization and you want to transition the files
from the former user to another user. Another example might be if a user has two home folders
and you want to merge the contents into one.

Remove from Engine Database

This Management Action removes objects from the File Dynamics database and makes the
object unmanaged.

11.2.6 - Pending Events

This page displays a list of pending events for the Engine. All of the pending events are listed
with details on the status of those events. Some events process very quickly and might
actually be completed before they can be viewed in the list. Other events might remain in the
queue for a long time, waiting for some condition to be met before they can be completed.

Clicking a listed event or events activates the toolbar. The toolbar has the following options:
Properties: Displays event properties such as FDN, ID, Action, and Current Status.

Make Eligible: If an event is deferred, you can click this option to make the event eligible
immediately.

Defer: If an event is eligible, you can click this option to manually defer it to a specific date.
The chosen deferral date is displayed in a Notes field. You can also enter any notes explaining
the reason you are deferring the event. Text from the Notes field is also displayed in the
Deferred Notes field of the Properties dialog box.

Configure: Lets you adjust the time parameter for making pending events eligible for display
as deferred events.

The default setting is one hour, meaning that any pending events scheduled to be addressed
within one hour will be displayed when the Active Only menu option is selected. Those events
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scheduled to be addressed later than one hour will be displayed when the Deferred Only menu
option is selected.

Configure Pending Event Defer Time Dialog Box

Configure Pending Event Defer Time

Events having a next eligible processing time greater than or equal to
this value will only be displayed in the Deferred Events tab.

Minimum Defer Time: - |Hnurs

| DK I | Cancel |

Bypass: Lets you bypass the status that is holding up the event.
Abort: Lets you terminate the selected event or events.
Refresh: Refreshes the event list.

View Events: Lets you filter the displayed events by displaying All, Active, or Deferred
pending events.

These settings are persisted across Engine restarts. Therefore, if you stop processing and
restart the Engine or the server hosting the Engine reboots for some reason, event processing
will remain off until you turn it back on.

« Accepting: A green check mark indicates that File Dynamics is accepting events to
process. You can stop accepting events to process by clicking this button. You are
prompted to enter text in a field indicating your reason for stopping the acceptance of
events. The text you enter is recorded on the Engine Status page.

¢ Processing: A green check mark indicates that File Dynamics is processing events.
You can stop processing events by clicking this button. You are prompted to enter text
in a field indicating your reason for stopping the processing of events. The text you
enter is recorded on the Engine Status page.

11.2.7 - Consistency Check

This page is used to access and export stored Consistency Check reports.

To access a report, double-click a report listing to access the View Report dialog box.
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Consistency Check Report

View Report

[ CsV HTML

Consistency Check - CN=Atlanta Employees,0U=Groups,0U=Atlanta,0U=dom,DC=dom,DC=cctec,DC=org

Target Type: User
Subcontainers: Yes
Administrator: DOMyocaladmin
Path Types: Home Folder

Results {15) Primary Path Statistics

Mame = DS Path Home Drive | Path Type DS Path... Policy Flags Permiss... Quota Manage.. MagmtP.. Mag. Paths Match
« & Adam J... \\fsl.do.. H: Home F... ~ Atlanta.. [none) MELRW JOOMB Managed ‘\fs1.do.. o LY 4
LY 4 & Alicia M...  \Wfsl.do.. H: Home F... " Atlanta..  [none) MELRW 300 ME = Managed | ‘“Wfsl.do.. J L 4
LY 4 & Ann Rei.,  \WWsl.do., H: Home F... " Atlanta..  [none) MELRW 300 ME = Managed | ‘“Wfsl.do.. J L 4
v 4 & Erenda...  ‘\fsl.do.. H: Home F... + Atlanta...  [none) MELRW 300 ME | Managed | \\fsl.do.. o v
LY 4 & Brian L...  ‘\\fsl.do.. H Home F... " Atlanta..  [none) MELRW 300 ME = Managed | ‘“Wfsl.do.. J L 4
LY 4 & Charles...  ‘\fsl.do.. H Home F... " Atlanta..  [none) MELRW 300 ME = Managed | ‘“Wfsl.do.. J L 4
LY 4 & Daryll T..  \WWfsl.do..  H Home F... " Atlanta..  [none) MELRW 700 ME  Managed | “Wfsl.do.. J L 4
LY 4 & Diane A..  \\fsl.do.. H: Home F... " Atlanta..  [none) MELRW 300 ME = Managed | ‘“Wfsl.do.. J L 4
LY 4 & Dickey...  Wsl.do.. H Home F... " Atlanta..  [none) MELRW 300 ME = Managed | ‘“Wfsl.do.. J L 4
LY 4 & James... ‘Wsl.do.. H Home F... " Atlanta..  [none) MELRW 300 ME = Managed | ‘“Wfsl.do.. J L 4
LY 4 & Julia M., | \Wsl.do..  H Home F... " Atlanta..  [none) MELRW 300 ME = Managed | ‘“Wfsl.do.. J L 4
LV 4 & Karen P...  ‘\fsl.do.. H: Home F... + Atlanta..  [none] MELRW 300 ME  Managed | ‘\fsl.do.. + Evs
LY 4 & Lance J.. | \Wfsl.do.. H: Home F... " Atlanta..  [none) MELRW 300 ME = Managed | ‘“Wfsl.do.. J L 4
LY 4 & Larry H... | ‘Wfsl.do.. H: Home F... " Atlanta..  [none) MELRW 300 ME = Managed | ‘“Wfsl.do.. J L 4
£ & Pat Dav... | \\fsl.do.. H: Home F... + Atlanta...  [none] MELRW 300 MB | Managed | \\fsl.do.. b Y4

The dialog box displays the contents of the Consistency Check report.

The Primary Path Statistics tab shows the rights, flag, and path distribution data in text and
graphical format.
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Primary Statistics in a Consistency Check Report

View Report

[ CsV HTML

Consistency Check - CN=Atlanta Employees,0U=Groups,0U=Atlanta,0U=dom,DC=dom,DC=cctec,DC=org

Target Type: User
Subcontainers: Yes
Administrator: DOMyocaladmin
Path Types: Home Folder

Results {15) Primary Path Statistics

Permissions Distribution Flags Distribution Quota Distribution

Permissions = Count | % Flags = Count % Quota = Count | %

MELRW (none) 300 MB = I
700 MB 2 =

Path Distribution
Fath = Count %

‘Wfs1.dom.cctec.org\Shares\Atlanta\Users

To export a Consistency Check report, double-click a report listing to access the View Report
dialog box, and then in the upper-left corner of the dialog box, click either the CSV or HTML
icons.

For more information on Consistency Check Reports, see Running Consistency Check
Reports on Existing Storage (page 15) and Performing a Consistency Check (page 26).

11.2.8 - Management Action Reports

Management Action reports are stored each time a Management Action is performed. Use this
page to view or export to a report, the results of any Management Action performed. A list of
available Management Action reports is presented, identifying the report by the Active
Directory object it was run on, and the time the report was generated.

Double-clicking any item in the list brings up the individual Management Action report.
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Management Action Report

mpire Data Migration Configuration

v B & B EH 3 & @ O ks

Statistics | Identity Policies Action Management Pending —Consistency Management Poliq Worklog — Global Statistics  Global — Anomaly
Objects Blocks  Actions Events Check Actions Paths Collector Statistics  Reports

Management Reports Global Statistics

User: DOM\localadmin Engine Address: app1.dom.cctec.or
ﬂManagement Action Reports g Ly g

Engine Version: 6.5.0.53

[§ Open Delete  Report Count: 14

.. Report Time = | Size
Manage - Employees.Munich.dom.dom.cctec.org 11/15/2019 3:27:41 PM 4KB
Remove From Engine Database - Samatha Jones.Employees.5FO.dom.dom.cctec.org 11/15/201G 2:35:21 PM 911 bytes
Assign Managed Path - NYC Marketing.Groups NYC.dom.dom.cctec.org 11/15/2019 8:22:07 AM 963 bytes
Reapply Membership - Atlanta Groups.Atlanta.dom.dom.cet rg 11/14/2013 5:11:48 PM 5KB
Manage - Atlanta Employees.Groups.Atlanta.dom.dom.cctec.org 11/14/2019 5:0%9:38 PM 891 bytes
Manage - Atlanta Employees.Groups.Atlanta.dom.dom.cctec.org 11/14/2019 4:58:03 PM 897 bytes
Apply Template - Atlanta Employees,Groups Atlanta.dom.dom.cctec.org 11/14/2019 4:57:54 PM 979 bytes
Manage - Atlanta Employees.Groups.Atlanta.dom.dom.cctec.org 11/14/2019 4:57:18 PM 899 bytes
Manage - dom.dom.cctec.org 11/14/2019 1:05:45 PM 20 KB
Manage - dom.dom.cctec.org 11/14/2019 1:05:04 PM 20 KB
Enforce Policy Paths - Users.Greenville.dom.dom.cctec.org 9/19/2019 2:34:23 PM 170 KB
Apply Ownership - sales.Managed Storage Atlanta.dom.dom.cctec.org /22/2019 3:34:55 PM 965 bytes
Reapply Membership - sales. Managed Starage.Atlanta.dom.dom.cctec.arg 8/22/2019 3:18:17 PM 29KB
Manage - users.Columbia, DOM2.dom2.cctec.org 7/16/2019 11:05:51 AM 18 KB

To export an Action report, double-click a report listing to access the View Report dialog box,
and then in the upper-left corner of the dialog box, click either the CSV or HTML icons.

11.2.9 - Policy Paths

This page shows high-level statistical information pertaining to your policies, their
corresponding target paths, and size and free space information.
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Policy Paths Report

Identity-Driven Target-Driven Cross-Empire Data Migration Configuration

v B Rl B @ OE 3 EE & O W

Statistics | Identity Policies Action Management Pending —Consistency Management Poliq Worklog — Global Statistics  Global — Anomaly

Objects Blocks Actions Events Check Actions Paths Collector Statistics  Reports
Management Reports Global Statistics
=0 . User: DOM\ocaladmin Engine Address: app1.dom.cctec.org
ETi Policy Paths i -
Engine Version: 6.5.0.53

Policy =  Path Total Size Size In Use Free Space Percent Free
Atlanta Team Share \\dom.cctec.org\DFS\Atlanta\Atlan...
Atlanta Users Wfs1.dom.cctec.org\Shares\Atlanta... 60 GB 5GB 55 GB
Atlanta Users Larger Quota \\fs1.dom.cctec.org\Shares\Atlanta... 60 GB 5GB 55 GB
HQ Managed Storage ‘\dom.cctec.org\DFS\HO\hgshare\... 60 GB 5GB 55 GB
HQ Users \fs1.dom.cctec.org\Shares\HQ\Users 60 GB 5GB 55 GB
HR Users \\dom.cctec.org\DF5\HQ\hgshare\... 60 GB 5GB 55 GB
London Users \\fs1.dom.cctec.org\Shares\Llondo... 60 GB 5GB 55 GB
Munich Users \Wfs1.dom.cctec.org\Shares\Munich... 60 GB 5GB 55 GB
NYC Marketing Wdam.cctec,arg\DFS\NYO\NYCShar... | 60 GB 5GB 55 GE
NYC Users \\dom.cctec.org\DFS\NYC\Wsers 60 GB 5GB 55 GB
Training Courses ‘\dom.cctec.org\DFS\NYC\NYCShar... 60 GB 5GB 55 GB

Version: 6.5.0.59

11.2.10 - Work Log

Click Work Log to build Work Log reports. For details and procedures for doing so, see
Building Work Log Reports (page 141).

11.2.11 - Global Statistics Collector

The Global Statistics Report (GSR) Collector is a multi-purpose mechanism that collects data
for storage usage statistics and policy-based storage redistribution, generates reports on
anomalies such as a user with a non-existent home folder, and catalogs objects and their
paths for historical purposes.

The data collected by the GSR Collector has four primary uses:

GSR Collector Anomaly Analysis
Global Statistics

e History
¢ Policy-based Path Redistribution

Your usage of the GSR Collector data may be specific to all of these or some subset. You
should analyze your needs of the feature set it provides and weigh them with the frequency
and scope that best suits your needs.

For example, Anomaly Analysis may be an important tool for helping you determine the state
of your unmanaged data when you have no configured policies or when you’re initially
implementing File Dynamics. Thereafter, you may not need to examine the reports on a daily
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basis. In this case, after your policies are configured and users are managed, you might opt to
change the schedule of the GSR Collector to run weekly.

GSR Anomaly Analysis is discussed in Anomaly Reports (page 196).

The Global Statistics provided by the GSR Collector offer insight into how your storage is
being consumed by the supported categories of objects (e.g. user and collaborative) but it
comes at a price. It can be expensive to run if you do not have quotas enabled via File Storage
Resource Manager (FSRM) or your managed storage resources primarily consist of NAS
devices.

Alternatively, you might find that the Global Statistics are less important in lieu of your need for
a finer granularity of historical data. The same size data used for the Global Statistics is also
used for Policy-based Path Redistribution. Depending on the policies for which you plan to
redistribute data, you might configure the GSR Collector to perform a Complete Inspection on
the paths for a specific policy. Thus eliminating the need to wait for Complete Inspection to be
performed needlessly against all storage resources.

The GSR Collector is designed to be run on a scheduled interval so that you can collect the
appropriate data to provide the necessary granularity for your needs. By default, the GSR
Collector will not run unless you run it manually or configure it to run based on a schedule.

Performance Caveats

Due to the number of objects, amount of data to scan, and your configuration, the GSR
Collector can be resource intensive and long running. By default, it will collect data on all
objects and accessible shares in Active Directory. This default configuration is not ideal for
most File Dynamics deployments. However, the configuration of the GSR Collector allows you
to scope it according to your needs. You are encouraged to scope it according to the objects
and shares that will be managed by File Dynamics. You should be careful when running the
GSR Collector during peak traffic load on the Engine.

Global Statistics Collector Interface

The GSR Collector interface is the means of running and scheduling the GSR Collector, as
well as viewing the results of when it was run previously.
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i B O B3 FE & O
5 | = = = [LL[=1
e & i R O % I i 3 Lo
Statistics  Identity Policies Action Management Pending = Consistency Management Poliy Worklog — Global Statistics  Global  Anomaly
Objects Blocks  Adions  Events Check Actions  Paths Collector  Statistics  Reports
Management Reports Glohal Statistics
User: DOMocaladmin  Engine Address: app1.dem.cetec.or
@ Global Statistics Collector 9 Pe ?
- Engine Version: 6.5.0.53
P Run (O Schedule ' Refresh
start Time = state Processed DS Objects | DS Total Time Processed FS Objects | F5 Total Time Total Scan Time
Run Statistics
W TI/152018 335:01 PM Complete 303 o001z 3 o008 oD:00:22
Directory Services " 11/15/2019 3:30:46 PM | Complete 303 | 00:00:12 34 | 00:00:08 00:00:22
| 11/15/2019 32801 PM | Complete 303 | 0012 34| 00:00:08 o0:00:22
Enumerated: 0
Processed: o | 11/15/20193:25:52 PM | Complete 303 | 00012 17| o:00:08 00:00:21
Enumeration Time:  00:00:00 W | 117152018 315:09 PM | Complete 303 | 000013 17| on:o0:08 00:00:23
DS Total Time 00:00:00 o
W | 117152018 25110 PM | Complete 303 | ono0:12 16| D0:00:08 00:00:22
Fite System | 11/15/2019 2:45:46 PM | Complete 303 | oo:i0D:12 16 | 00:00:08 00:00:22
| 11/15/2019 24515 PM | Complete 302 | 00012 15 | D:00:08 o0:00:22
Enumerated: 0 —
Processed. o | 11/15/2019 24235 PM | Complete 302 | 000013 15 | D0:00:08 00:00:24
Enumeration Time:  00:00:00 W | 117152018 241:52 PM | Complete 93 | 00:00:06 15 | on:00:08 00:00:16
ESlotaiine Ly | 11/15/2019 2:36:31 PM | Complete 93 | 00:00:06 15 | 00:00:08 00:00:15
| 117152019 23213 PM | Complete 94 | 00:00:08 16 | D0:00:08 00:00:16
i, 117152019 22833 PM | Failed 0| ooo:00 0| o:00:00 WA
Total Run Time:  00:00:00
i 1171520122752 PM | Failed 0| o000 0| o:00:00 WA
| 17018 %1347 AM | Complete 2102 | 00:06:37 2,000 | 00:00:46 00:07:41
W | 77162019 11:08:36 AM | Complete 2000 | 00:02:37 2,000 | 00:00:23 00:0%:04
| T/15/2019345:57 PM | Complete 1,999 | 00:02:30 1,999 | 00:00:25 00:03:00

Version: 6.5.0.59

Run: Runs the GSR Collector according to the current GSR Collector configuration. For
information on the GSR Collector configuration, see Global Statistics Configuration (page

229).

Schedule; Lets you schedule when the GSR Collector is run.

Refresh: Refreshes the list of GSR Collector runs listed in the right pane of the page.

Run Statistics: Displays statistics as the GSR Collector is being run. Once the GSR Collector
has completed its run, the statistics are appended to the top of the list in the pane on the right
side of the page.

11.2.12 - Global Statistics

This page displays a variety of statistics according to the findings of the GSR Collector.
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v B Rl B B E 3 EE & O W

Statistics | Identity Policies Action Management Pending = Consistency Management Poliy  Worklog | Global Statistics  Global  Anomaly
Objects Blocks Actions Events Check Actions Paths Collector Statistics  Reports
Management Reports Global Statistics
User: DOM\localadmin Engine Address: app1.dom.cctec.or
0 Global Statistics 9 Pe ?
Engine Version: 6.5.0.53
Filters a Storage Counts By Class o Data Size By Class a Quota Commitment By Class o

Servers

User Home Falder User Home Falder User Home Folder
de2.dom2.cctec.org Y Y Y

v | fs1.dom.cctec.arg f
100.00% 100.00% 100.00%

Shares

\Wde2.dom2.cctec.org\Shares

User and Group Count Distribution O Userand Group Data Size Distribution O Home Folders o
| \Wfs1.dom.cctec.org\Shares
"y, Managed Users "y, Managed User Data =y Users with HF
"y, Unmanaged Users "y, Users without HF
G ithout HF
Paths 100.00% "%, Groups withou
\Wde2.dom?.cctec.org\Shares 520 ‘
76.12% 30.13%
] \Wst.dom.cetec.org\Shares
] \Wfs1.dom.cctec.org\Shares\Atlanta\Users
| \Wist.dom.cctec.org\Shares\HQWsers v || ServerStatistics O Share Statistics o
Path Types Storage Counts Per Server | Storage Data Sizes Per Server Starage Counts Per Share | Storage Data Sizes Per Share
] User Home User Profile 100 100
User TS Home User TS Profile
Ausiliary Group Home 0 0
0 0

Version: 6.5.0.59

The Global Statistics page is laid out in a way that you can set the parameters for display on
the left-hand portion of the page and then see the results on the right.

11.2.13 - Anomaly Reports

The GSR Collector performs Anomaly Analysis that generates data for Anomaly Reports.
These reports are designed to help you evaluate the state of your storage infrastructure.
Additionally, they can be used in preparation for using File Dynamics to bring storage under

management by policy. Anomaly data will be produced for each object and path type specified
in the GSR Collector configuration.
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v B Rk R 2 EH BERE @ OR
i "2t use * = i i H =
Statistics | Identity Policies Action Management Pending = Consistency Management Poliy  Worklog | Global Statistics  Global  Anomaly
Objects Blocks Actions Events Check Actions Paths Collector Statistics  Reports
Management Reports Global Statistics
User: DOM\localadmin Engine Address: app1.dom.cctec.or
f'_'“o Anomaly Reports . re N
Engine Version: 6.5.0.53
[ Fome Folder
[l Group Home Folder
100
m II
1 I
L]
| wbuteVaueMisng  OrphenPathCanddate  ObjectMotMenaged  NameMemath  PathMemath

To see further detail about a specific anomaly report, single-click on the column.

A detailed summary of each of the GSR Anomaly reports follows in the sections below.

Attribute Value Missing

This Anomaly report indicates that the respective path attribute (e.g. home folder) does not
have a value for a given object in Active Directory.

The graphic below is an example of an Attribute Value Missing Anomaly report. The Object
FDN and Object SAM Account Name columns display the respective attributes. The Managed
Path column does not have a value because this object is not yet managed by File Dynamics.
These objects are reported because they do not have homeDirectory attribute values. This
report can be used to identify objects that should be managed. It can also identify objects that
have had their respective path attribute cleared accidentally or erroneously by an identity
management system.
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ion: 6.5.0.59

= = = = =
w & Rl B B B B AE & O
Statistics ~ Identity Policies Adion Management Pending Consistency Management Poliy Worklog =~ Global Statistics  Global — Anomaly
Objects Blocks Actions Events Check Actions Paths Collector Statistics  Reports
Management Reports Global Statistics
@A“maly Reports User: DOM\localadmin Engine Address: app1l.dom.cctec.org
Engine Version: 6.5.0.53

(© Attribute Value Missing - User home folder | [gy CSV [, Workload [ HTML
Object FDN = Object SAM Account Name Managed Path
CH=Administratar, CN=Users, DC=dom,DC=cctec, DC=arg Administrator -
CN=Administrator, CN=Users, DC=dom2,DC=cctec, DC=org Administrator
CN=Alex Martin,OU=Employees,OU=London,OU=dom,DC=dom,DC=cct.. | amartin
CHN=Alice Rooney, OU=Employees, 0U=NYC,0U=dom,DC=dom,DC=cctes,... | arooney
CH=Amanda Cox,OU=Emplayees, 0U=HQ, OU=dom,DC=dom, DC=cctec,.. | acox
CN=Amelia Taft,OU=Employees, OU=HQ,0U=dom,DC=dom,DC=ccter,DC... | ataft
CN=Barry Davenport,OU=Employees,OU=London,OU=dom,DC=dom,DC... bdavenport
CN=Ben Cagney,OU=Employees, OU=NYC,0U=dom,DC=dom,DC=cctec,.. | bragney
CH=Brenda Streisand, OU=Emplayees, OU=NYC,0U=dom,DC=dom,DC=c...  hstreisand
CH=Bret Lambardi, OU=Emplayees, OU=NYC,0U=dom DC=dom,DC=ccte.. = blombardi
CN=Brian Clark,OU=Employees,0U=HQ,0U=dom,DC=dom,DC=ccte,DC... | belark
CN=Carl Lawson,0U=Employees,0U=HQ,0U=dom,DC=dom,DC=cctec,D... | clawson
CH=Charles Lindley,0U=Employees,0U=HQ,OU=dom,DC=dom, DC=ccte... | clindley
CH=Charles Reeve,OU=Employees, 0U=NVC,0U=dom,DC=dom,DC=ccte... | creeve
CN=Dale Rodgers, OU=Employees,OU=London,OU=dom,DC=dom,DC=c... | drodgers
CN=Danny Mendez,OU=Employees,0U=London,OU=dom,DC=dom,DC... | dmendez
CH=David Stanwyck, OU=Employees,OU=NYC,0U=dom,DC=dom,DC=cct... = dstanwyck
CH=DOMS, CN=Users, DC=dom2,DC=cctec,DC=org DOMS
CN=DOM25,CN=Users,DC=dom,DC=cctec, DC=arg DOM2S
CN=Edward Brown,OU=Employees,0U=HO,0U=dom,DC=dom,DC=ccte... = ebrown
CN=Elaine Clapton,OU=Employees,0U=HQ,0U=dom,DC=dom,DC=ccte... | edapton

Elizabeth Ferris, OU=Employees, OU=London,OU=dom,DC=dom,DC... | eferris v
" Record10of 77 + W W+ — &« x

Path Missing on Disk

This Anomaly report indicates that the respective path attribute value (e.g. home folder) for a
given object cannot be found on disk.

The graphic below is an example of a Path Missing on Disk Anomaly report. The Object FDN
and Object SAM Account Name columns display the respective attributes. The Path column is
the value of the homeDirectory attribute. The Managed Path column does not have a value
because this object is not yet managed by File Dynamics. This object is reported because the
path specified by its homeDirectory attribute does not exist on disk or could not be found. This
report can be used to identify objects whose respective path attribute value no longer exists at
that location because of accidental deletion or being moved manually.
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R 4

M

@ Anomaly Reports

(© Attribute Value Missing - Group home folder
Object FDN =
CH=Access-Denied Assistance Users,CN=Users,DC=dom,DC=cctec, DC=org
CN=Accounting-RO,0U=Managed Storage, 0U=HQ,0U=dom,DC=dom, ...
CN=Accounting-RW,0U=Managed Storage,OU=HQ,0U=dom,DC=dom,...
CH=Allowed RODC Password ion Group,CH=Users,DC=dom,DC...
ion Group, C=Users,DC=dom2,D...
CN=app1-lacaladmin-grp,0U=admin accounts, OU=dom,DC=dom,DC=c...

CH=All d RODC Password

CN=Atlanta Building Access,0U=Groups,OU=Atlanta, 0U=dom,DC=dom...
CN=Atlanta Employees,OU=Groups,OU= Atlanta,OU=dom,DC=dom,DC=...
CN=Atlanta Engineers,0U=Groups, 0U=Atlanta,0U=dom,DC=dom,DC=...
Cl=Atlanta Helpdesk,OU=Groups,0U=Atlanta, 0U=dom,DC=dom,DC=c...
CN=Atlanta Larger Quota,OU=Groups,OU=Atlanta,0U=dom,DC=dom,D...
CN=Atlanta Marketing, 0U=Groups,OU=Atlanta,0U=dom,DC=dom,DC=...
CN=Atlanta Sales,OU=Groups,OU=Atlanta,0U=dom,DC=dom,DC=cetec, .
CN=Cert Publishers,CN=Users,DC=dom,DC=cctee,DC=org
CN=Cert Publishers,CN=Users,DC=dom2,DC=cctec, DC=0rg
CN=Cloneable Domain Controllers,CN=Users,DC=dom,DC=cctec,DC=0rg
CN=Cloneable Domain Contrallers,CN=Users,DC=dom2,DC=cctec,DC=org
CN=Denied RODC Password Replication Graup,CN=Users,DC=dom,DC=...
CN=Denied RODC Password Replication Group, CM=Users, DC=dom2,DC...
CN=DnsAdmins, CN=Users, DC=dom,DC=ccte, DC=org
CN=DnsAdmins, CN=Users, DC=dom2,DC=cctec DC=0rg

sUpdateProxy, CN=Users,DC=dom,DC=cctec, DC=org
Record10f92 + W w4+ — 7 o/ %

Statistics | Identity Policies Action Management Pending —Consistency Management Poliq  Work Log
Objects Blocks  Actions Events Check Actions Paths
Management Reports

@ CSV [ Workload [y HTML

Object SAM Account Name

Access-Denied Assistance Users
Accounting-RO

Accounting-RW

Allowed RODC Password Replication Group
Allowed RODC Password Replication Group
app1-localadmin-grp

Atlanta Building Access

Atlanta Employees

Atlanta Engineers

Atlanta Helpdesk

Atlanta Larger Quota

Atlanta Marketing

Atlanta Sales

Cert Publishers

Cert Publishers

Cloneable Domain Controllers

Cloneable Domain Controllers

Denied RODC Password Replication Group
Denied RODC Password Replication Group
DnsAdmins

DnsAdmins

DnsUpdateProsy

@ O &
s =
Global Statistics ~ Global ~ Anomaly
Collector Statistics  Reports
Global Statistics
User: DOM\localadmin Engine Address: app1.dom.cctec.org
Engine Version: 6.5.0.53
Managed Path
.
‘\dom.cctec.org\DFS\Atlanta\AtlantaShare\Common Share‘\Atlanta Emplo...
.

Name Mismatch

This Anomaly report indicates that the leaf path name of the respective attribute value (e.g.
home folder) does not match that of the respective object’s name.

The graphic below is an example of the Name Mismatch report. The Object FDN and Object
SAM Account Name columns display the respective attributes. The Path column is the value
of the homeDirectory attribute. The Path column contains the current respective path attribute
value obtained from Active Directory. The Managed Path column contains the path value
when the object was last managed. This object is reported because the leaf path name
specified by its homeDirectory attribute does not match the sAMAccount name attribute. This
report can be used to identify objects whose respective path might have been changed

manually.
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= = = = =
w B Rk R O 2 HE & O 4
Statistics ~ Identity Policies Adion Management Pending Consistency Management Poliy Worklog =~ Global Statistics  Global — Anomaly
Objects Blocks Actions Events Check Actions Paths Collector Statistics  Reports
Management Reports Global Statistics
@A“maly Reports User: DOM\localadmin Engine Address: app1l.dom.cctec.org
Engine Version: 6.5.0.53
(© Name Mismatch - User home folder | [z, CSV [, Workload  [78 HTML
Object FDN Object SAM Account Name Maming Attribute MName Path = Managed Path
CH=Peter Utz, OU=Employees,OU... | putz \\fs1.dom.cctec.org\Shares\Munic... -
CN=Heidi Belheim,0U=Employees... hbelheim \Wfs1.dom.cctec.org\Shares\Munic...
CN=ZSCHADT,OU=users,QU=Col... | ZAYLEESCHADT \Wdc2 dom2 cctec.org\Shares\Colu...
CN=YBEATIE,OU=users,OU=Colu... = YIBEATIE Wwdc2 dom2 cetec.org\Shares\Colu...
CHN=WMCGRANN,OU=users,OU=... = WALIACMCGRANN Wwde2 dom2. cctec.org\Shares\Colu...
CN=VZETZER,OU=users,OU=Colu... = VIVIANZETZER \\dc2. dom2.cctec.org\Shares\Colu...
CN=VKLANG,OU=users,OU=Colu... = VIVIANKLANG \Wdc2 dom2 cctec.org\Shares\Colu...
CN=VGANS,OU=users,0U=Colum... =VIVIANGANS \Wdc2 dom2 cctec.org\Shares\Colu...
CN=VRAFUSE,OU=users,0U=Col... = VERNONRAFUSE Wwde2 dom2. cctec.org\Shares\Colu...
CN=USECKMAN,OU=users, OU=C... = ULYSSISECKMAN Wwde2 dom2. cctec.org\Shares\Colu...
CN=TELLENBEE, OU=users,0U=Co...  TRISTAELLENBEE \Wdc2 dom2 cctec.org\Shares\Colu...
CN=TSEESE,OU=users,0U=Colum... = TRILBYSEESE \Wdc2 dom2 cctec.org\Shares\Colu...
CN=TBOEBINGER,OU=users,OU=... = TRICIABOEBINGER Wwde2 dom2. cctec.org\Shares\Colu...
CHN=TVANDINTER,OU=users,OU=... = TRENTVANDINTER Wwde2 dom2. cctec.org\Shares\Colu...
CN=TSLEZAK,OU=users,OU=Colu... = TOCCARSLEZAK \Wdc2.dom2.cctec.org\Shares\Colu...
CN=TOLUP,OU=users,OU=Colum... = TERAQLUP \Wdc2 dom2 cctec.org\Shares\Colu...
CHN=TWORLAND,OU=users,OU=C... = TATIANWORLAND \wdc2 dom2.cctec.org\Shares\Colu...
CN=TGHRAMM,OU=users,0U=Co... TALISHGHRAMM Wwde2 dom2. cctec.org\Shares\Colu...
CN=TBUSUTTIL, OU=users,0U=Col... = TABITHBUSUTTIL \\dc2. dom2.cctec.org\Shares\Colu...
CN=SREDRICK,OU=users,0U=Col... = SPARKLREDRICK \Wdc2 dom2 cctec.org\Shares\Colu...
CN=5POLLACK,OU=users,0U=Col... = SOFIEPOLLACK ‘wdc2. dom2 cctec.org\Shares\Colu...
SPOOSCHKE, OU=users,0U=C... SIOBHAPOOSCHKE Wwde2 dom2. cctec.org\Shares\Colu... v
e Record 1020102 + » Wi+ = 7 x

ion: 6.5.0.59

Path Duplicate Value

This Anomaly report indicates that two or more objects have been detected that contain the
same value for the respective path attribute (e.g. home folder).

The graphic below is an example of the Path Duplicate Value report. The Object FDN and
Object SAM Account Name columns display the respective attributes. The Path column is the
value of the homeDirectory attribute. The Path column contains the current respective path
attribute value obtained from Active Directory. The Managed Path column does not have a
value because these objects are not yet managed by File Dynamics. These objects are
reported because they have the same value for their homeDirectory attribute. This report can
be used to identify objects who erroneously share the same path for the respective path
attribute.
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Bk G O ERENE
EX R ) E = g
e & i R O % I i 3 Lo
Statistics ~ Identity Policies Adion Management Pending Consistency Management Poliy Worklog =~ Global Statistics  Global — Anomaly
Objects Blocks Actions Events Check Actions Paths Collector Statistics  Reports
Management Reports Global Statistics
User: DOM\localadmin Engine Address: app1.dom.cctec.or
f'_'“o Anomaly Reports 9 re N
Engine Version: 6.5.0.53
(© Path Duplicate Value - User home folder [ CSV [, Workload  [h HTML
Object FDN =  Object SAM Account Name Path Managed Path
CH=Elaine Claptan, OU=Employees, OU=HQ,OU=dom,... eclapton \\fs1.dom.cctec.org\Shares\HC\Users\eclaptan YWfs1.dom.cctec.org\Shares\HO\Users\eclapton
CN=Gregory Allman,0U=Employees,0U=HQ,0U=dom... gallman \Wis1.dom.cctec.org\Shares\HQ\Users\eclapton \WWis1.dom.cctec.org\Shares\HO\Users\galiman
144 Recordiof2 * M oM E = & X

Version: 6.5.0.59

Path Parent Crosstalk

This Anomaly report indicates that the object’s respective path attribute value (e.g. home
folder) has been detected as being the parent of another object’s path attribute value (e.g.
home folder).

The graphic below is an example of the Path Parent Crosstalk report. The Object FDN and
Object SAM Account Name columns display the respective attributes. The Path column is the
value of the homeDirectory attribute. The Path column contains the current respective path
attribute value obtained from Active Directory. The Managed Path column does not have a
value because these objects are not yet managed by File Dynamics. This object is reported
because the value for its homeDirectory attribute has been detected as being the parent of
another object’s homeDirectory attribute. This report can be used to identify objects whose
respective path attribute is set to the wrong location and might impact another object’s
storage.
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Bk G O ERENE
EX R ) E = g
e & i R O % I i 3 Lo
Statistics ~ Identity Policies Adion Management Pending Consistency Management Poliy Worklog =~ Global Statistics  Global — Anomaly
Objects Blocks Actions Events Check Actions Paths Collector Statistics  Reports
Management Reports Global Statistics
User: DOM\localadmin Engine Address: app1.dom.cctec.or
f'_'“o Anomaly Reports 9 re N
Engine Version: 6.5.0.53
(© Path Parent Crosstalk - User home folder | [gy €SV [, Workload [ HTML
Object FDN =  Object SAM Account Name Path Managed Path
CH=Gregary Allman,0U=Employees, 0U=HQ,OU=dom... gallman \\fs1.dom.cctec.orgiShares\HC\Users Yfs1.dom.cctec.org\Shares\HO\Users\galiman
Wt 4 Recordiofl b W ml b = 2 v X

Version: 6.5.0.59

Path Child Crosstalk

This Anomaly report indicates that the object’s respective path attribute value (e.g. home
folder) has been detected as being the subordinate of another object’s path attribute value
(e.g. home folder).

The graphic below is an example of the Path Child Crosstalk report. The Object FDN and
Object SAM Account Name columns display the respective attributes. The Path column is the
value of the homeDirectory attribute. The Path column contains the current respective path
attribute value obtained from Active Directory. The Managed Path column does not have a
value because these objects are not yet managed by File Dynamics. This object is reported
because the value for its homeDirectory attribute has been detected as being the child of
another object’s homeDirectory attribute. This report can be used to identify objects whose
respective path attribute might be impacted by another object’s storage.
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Statistics

M

Identity  Policies
Objects

Adion

Blocks Actions

Management

f'_'“o Anomaly Reports

(© Path Child Crosstalk - User home folder

Ch=Amelia Taft,0U=Employees,0U=HQ,OU=dom, DC...

CN=Randy Coleman,OU=Emplayees,0U=HQ,0U=do...
CN=5Susan Barnes, 0U=Employees, 0U=HQ,0U=dom, ..
CN=Wilson Picket,0U=Employees, 0U=HQ,0U=dom, ..

Pt = 2 R

Record 1 of 18

Management

-
S Csv
Object FDN =
Ch=Amanda Cox,0U=Employees,0U=HC, OU=dom,D...

CN=Brian Clark, 0U=Employees,0U=HQ,0U=dom,DC...
CN=Carl Lawson,0U=Emplayees, 0U=HQ,0U=dom,D...

CN=Charles Lindley,0U=Employees, OU=HQ, OU=dom...
CN=Edward Brown, OU=Emplayees, QU=HQ OU=dom,...
CN=Elaine Clapton,OU=Employees,0U=HG,0U=dom,..
CN=Frank Lankston,0U=Employees,0U=HQ,0U=dom...
CN=Frank Nichols, OU=Employees,OU=HQ,0U=dom,...
CN=Frank Richards, OU=Employees,0U=HQ 0U=dom,...
CN=Gary Nance,0U=Employees,0U=HQ,0U=dom,DC...
CN=Jack Sanders,0U=Employees,0U=HQ,0U=dom,D...
CN=Julia Baker,OU=Employees,OU=HQ,0U=dom,DC...
Ch=Kevin Morgan,0U=Employees,0U=HQ,0U=dom, .
CN=Larry Conner,0U=Employees,0U=HQ,0U=dom,D...

B &

@ Ok

Pending =~ Consistency Management Poliy Worklog = Global Statistics  Global — Anomaly

Events Check Actions Paths Collector Statistics  Reports
Reports Global Statistics

Te Workload [ HTML

Object SAM Account Name
acox
ataft
belark
dawson
dindley
ebrown
eclapton
flankston
tnichols
frichards
gnance
jsanders
Jbaker
kmorgan
Iconner
realeman
sbarnes

wpicket

Path
\Ws1.dom.cctec.org\Shares\HQ\Users\acox
Ws1.dom.cctec.org\Shares\HQ\Users\ataft
\Ws1.dom.cctec.org\Shares\HQ\Users\bclark
Ws1.dom.cctec.org\Shares\HQ\Users\clawson
Ws1.dom.cctec.org\Shares\HQ\Users\clindley
Wfs1.dom.cetec.org\Shares\HQuUsersiebrown
\Ws1.dom.cctec.org\Shares\HQ\Users\eclapton
\Ws1.dom.cctec.org\Shares\HQ\Users\flankston
Ws1.dom.cctec. orgiShares\HQ\Users'fnichols
\Ws1.dom.cctec.org\Shares\HQ\Users\frichards
\Ws1.dom.cctec.org\Shares\HQ\Users\gnance
\Ws1.dom.cctec.org\Shares\HQ\Users\jsanders
\Ws1.dom.cctec. orgiShares\HQ\Users'jbaker
Ws1.dom.cctec. orgiShares\HQ\Users\kmargan
‘\Ws1.dom.cctec.org\Shares\HQ\Users\lconner
\Ws1.dom.cctec.org\Shares\HQ\Users\rcoleman
Ws1.dom.cctec.org\Shares\HQ\Users\sbarnes

Ws1.dom.cctec.orgiShares\HQ\Users\wpicket

User: DOM\localadmin

Engine Version: 6.5.0.53

Managed Path
\\fs1.dom.cctec.org\Shares\HQ\Users\acox
\Wfs1.dom.cctec.org\Shares\HQ\Users\ataft
WWfs1.dom.cctec.org\Shares\HQ\Users\bclark
\Wfs1.dom.cctec.org\Shares\HQ\Wsers\clawson
\\fs1.dom.cctec org\Shares\HO\Users\clindley
\Wfs1.dom.cctec.org\Shares\HQ\Users\ebrawn
\Wfs1.dom.cctec.org\Shares\HQ\Users\eclapton
WWfs1.dom.cctec.org\Shares\HQ\Users\flankston
\\fs1.dom.cctec.org\Shares\HO\Users\fnichols
\\fs1.dom.cctec org\Shares\HO\Users\frichards
Wfs1.dom.cctec.org\Shares\HQ\Users\gnance
WWfs1.dom.cctec.org\Shares\HQ\Users\jsanders
\\fs1.dom.cctec org\Shares\HO\Users\jbaker
\\fs1.dom.cctec.org\Shares\HQ\Users\kmargan
\\fs1.dom.cctec.org\Shares\HQ\Users\lconner
\fs1.dom.cctec.org\Shares\HQ\Users\rcoleman
\\fs1.dom.cctec.org\Shares\HO\Users\sbarnes

\\fs1.dom.cctec org\Shares\HO\Users\wpicket

Engine Address: appl.dom.cctec.org

To see which object is a parent of this object’'s homeDirectory attribute value, see Path Parent

Crosstalk (page 201).

Orphan Path Candidate

This anomaly report indicates that the path is directly subordinate to a path at which other DS-
associated paths have been found, but has not been detected as being associated with any
DS object via a path attribute (e.g. home folder).

The graphic below is an example of the Orphan Path Candidate report. The Path column is
any path that is directly subordinate to a path at which other DS-associated paths have been

found. However, the path is not associated with any object via a path attribute. This report can
be used to identify folders that don’t belong to objects or are considered unmanaged.
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Orphan Path Candidate

Identity-Driven Target-Driven Cross-Empire Data Migration Configuration
=T e =l = = =
= E ESR ) S = in L.
|_‘/ 3t msm = 05 & i - )
Statistics ~ Identity Policies Adion Management Pending Consistency Management Poliy Worklog =~ Global Statistics  Global — Anomaly
Objects Blocks Actions Events Check Actions Paths Collector Statistics  Reports
Management Reports Global Statistics
User: DOM\localadmin Engine Address: app1.dom.cctec.or
f'_'“o Anomaly Reports 9 re N
Engine Version: 6.5.0.53
(© Orphan Path Candidate - User home folder | [ CSV [ Workload [, HTML
Path = Path Size
\fs1.dom.cctec org\Shares\Atlanta\Users\Larry Hanson 0 bytes
\fs1.dom.cctec.org\SharestAtlanta\Users\Nestar_Ahsan 0 bytes
Wfs1.dom.cctec.org\Shares\HQ\hgshare 0 bytes
Wfs1.dom.cctec org\Shares\HO\Users\gallman 0 bytes
Wfs1.dom.cctec org\Shares\HO\Users\sjones 0 bytes
WeW 4 RecordSofS b wom b = 2 v %

Version: 6.5.0.59

11.3 - Target-Driven Tab

The Target Driven tab is the means of enabling and establishing Target-Driven policies.
Policies (page 204)

Policy Schedules (page 222)

Action Blocks (page 223)

Jobs (page 223)

Security Notifications (page 224)
11.3.1 - Policies

All Target-Driven policies in File Dynamics are managed through this page.
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Target-Driven Policies Page

18- Home Identity-Driven Target-Driven Cross-Empire Data Migration Configuration
=5 e = éz
= am B
i @ s 0 £
Policies  Polig  Action  Jobs Security
Schedules  Blocks Motifications
Management Notification Data
=0 - User: DOM\ocaladmin Engine Address: app1.dom.cctec.org
B Target Policies

Engine Version: 6.5.0.53
New~ # Edit Rename J{ Delete B Execute~ ' Refresh
Drag a column header here to group by that column

Hame = | Poligy Type Path
o = o0

125k Security Lockdown Policy Security Lockdown \Wfs1.dom.cctec.org\Shares\Atlanta\Data\ 125k

T3 | Atlanta 20k Fencing Policy Security Fencing \Ws1.dom.cctec.org\Shares\Atlanta\Data\20k

(g | Atlanta 50k Notification Palicy Security Notification \Ws1.dom.cctec.org\Shares\Atlanta\Data\50k

@  Atiants Data EP Epoch Data Protection \fs1.dom.cctec.org\SharesiAtlanta\Data

3 | Atlanta Engineering Fencing Policy Security Fencing \\dom.cctec.org\DFS\Atlanta\AtlantaShare\Engineering

[y | Copy User Apps from Helpdesk to London Data Copy \\dom.cctec.org\DFS\HOQ\hgshare\Departments\T Dept\Applications

COLOFOOL 8L
a

Finance HVT Data Epach Data Protection \dom.cetec.org\DFS\HQ\hgshare\Departments\Finance
3 | Ainance Lockdown Policy Security Lockdown <

(& | Finance Security Notfication Security Notification \idom. cctec.org\DFS\HOjhgshare\Departments\Finance
[ | HR Documents Warkload

(@ | Sales Security Notification Policy Security Notification \\dam.cctec.org\DFS\HO\hgshare\Departments\Sales
[E | workioad Data Waorkload

Version: 6.5.0.59

For procedures on creating and managing Target-Driven policies, refer to Creating Target-
Driven Policies (page 105).

Left Pane: This region displays all Target-Driven policies according to classification. If you

click a classification such as Copy, only Copy policies will be listed in the Right Pane. If you
click a named Target-Driven policy such as Main Groom Policy for Atlanta Users, the policy
settings appear in the Right Pane.

You can right-click listed policies and policy classifications in the Left Pane to create new
policies, delete policies, and execute policies.

Right Pane: Depending on what is selected in the Left Pane, this region either lists specific
Target-Driven policies, or displays the policy settings for a selected Target-Driven policy.

Manage: Use this menu to create, delete, or execute Target-Driven policies.
Refresh: Updates the list of Target-Driven policies.

Copy Policy (page 206)

Move Policy (page 207)

Groom Policy (page 209)

Security Notification Policy (page 210)

Security Lockdown Policy (page 212)

Security Fencing Policy (page 214)
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Workload Policy (page 220)

Copy Policy
A discussion of fields and settings specific to a Copy policy follows.

Copy Policy Page

Target Policy Editor - New Copy Policy

@GE”E'E” MName | Mew Copy Policy
. Source Browse Clear
Description
Destination Browse Clear
(T_-)Schedule
Job Cleanup
Remove completed jobs older than 0 day(s)
Copy Options

~" | Owewrite Existing Data

Always

® | Only If Newer
~" | Copy Security

#® | Merge Permissions

Owerwrite Permissions

~' | Copy Quota

Skip Open Files

I, Changes to this policy have not been saved. oK Cancel Apply

General Tab

Name: Use this field to specify a name for the Copy policy.

Source: Displays the location in the file system from where the files will be copied.

Destination: Displays the location in the file system where all copied files for this policy will be

relocated.

Remove completed jobs older than: Lets you specify the number of days that a Copy task
from this policy is listed on the Jobs list before it is purged.
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Overwrite Existing Data: With the default setting, File Dynamics will overwrite an existing file
on the target destination only if the same file from the source location is newer. You can adjust
this setting to your preferences.

Copy Security: When selected, this maintains the file permissions from the source location to
the destination location.

Copy Quota: If the destination supports quota management, it will maintain the disk quota
settings from the source location to the destination location.

Skip Open Files: Skips all of the files that are opened from the source folder.

With Copy policies, File Dynamics does not attempt to copy skipped files later. You might want
to therefore schedule the policy to run during a time when users are logged out. For
procedures on scheduling a Copy policy to run, see Create a Copy Policy (page 111).

Description Tab

The Description box indicates when the policy was created. It also lets you write notes
pertaining to the policy. The Description box allows up to 255 characters.

Schedule Tab
Displays the schedule for the Copy policy.
For procedures on scheduling a Copy policy, see Create a Copy Policy (page 111).

Move Policy

A discussion of fields and settings specific to a Move policy follows.
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Move Policy Page

Target Policy Editor - New Mowve Policy

@ General Mame | Mew Move Policy
. Source Path Browse Clear
Description
Destination Path Browse Clear
(T_-)Schedule
Job Cleanup
Remove completed jobs older than C day(s)
Copy Options
~" | Owewrite Existing Data o Always
Only If Mewer
I, Changes to this policy have not been saved. oK Cancel Apply

General Tab

Name: Use this field to specify a name for the Move policy.
Source Path: Displays the location in the file system from where the files will be moved.

Destination Path: Displays the location in the file system where all moved files for this policy
will be relocated.

Remove completed jobs older than: Lets you specify the number of days that a Move task
from this policy is listed on the Jobs list before it is purged.

Overwrite Existing Data: With the default setting, File Dynamics will overwrite an existing file
on the target destination only if the same file from the source location is newer. You can adjust
this setting to your preferences.
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Description Tab

The Description box indicates when the policy was created. It also lets you write notes
pertaining to the policy. The Description box allows up to 255 characters.

Schedule Tab
Displays the schedule for the Move policy.

For procedures on scheduling a Move policy, see Create a Move Policy (page 115).

Groom Policy
A discussion of fields and settings specific to a Groom policy follows.

Groom Policy Page

Target Policy Editor - New Groom Policy

@ General Mame | New Groom Policy
. Filter Action Block Filter Action Block
Description
Target Path Erowse Clear
G)SChedule Vault Path Browse Clear
Job Cleanup
Remove completed jobs older than C day(s)
Security Options
Copy Security
Merge Permissions
Owverwrite Permissions
I, Changes to this policy have not been saved. oK Cancel Apply
General Tab

Name: Use this field to specify a name for the Groom policy.
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Filter Action Block (field): Specifies the name of the Filter Action Block with the groom rule
specifications for this policy.

Filter Action Block (button): Clicking this button brings up the Action Block Selector dialog
box where you can select from all available Groom Rule Action Blocks.

Target Path: Displays the location in the file system where files will be groomed.

Vault Path: Displays the location in the file system where all groomed files for this policy will
be relocated.

Remove completed jobs older than: Lets you specify the number of days that a Groom task
from this policy is listed on the Jobs list before it is purged.

Copy Security: Selecting this check box will allow users to access groomed files from the new
vault location.

* Merge Permissions: Merges permissions from the source to the target if the target
contains permissions that are not present in the source. This applies to all folders and
files in the source folder structure.

e Overwrite Permissions: Overwrites permissions in the target with those found in the
source. This applies to all folders and files in the target folder structure.

Description Tab

The Description box indicates when the policy was created. It also lets you write notes
pertaining to the policy. The Description box allows up to 255 characters.

Schedule Tab
Displays the schedule for the Groom policy.

For procedures on scheduling a Groom policy, see Create a Groom Policy (page 107).

Security Notification Policy

A discussion of fields and settings specific to a Security Notification policy follows.
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Security Notification Policy Page

Target Policy Editor - Mew Security Notification Policy — O X
‘ @ General MName |New Security Motification Policy | Policy Enabled
Description Target Path | | | Browse | | Clear |
(O schedule
Notification and Report Options
O oata
Email Recipients | | | Clear |
Security Change Events
Share Permissions Inherited ACEs (Target Path only)
Owner Directly assigned ACEs
Group Membership
Data Cleanup
Retain Notification Data for days
Retain Job Entries for days
Data Owners
o Add == Remove
| Name
1. Changes to this policy have not been saved. oK | | Cancel | | Apply
General Tab

Name: Use this field to specify a name for the Security Notification policy.

Target Path: Indicates the folder or share that will be analyzed for access permission
changes.

Browse: Click to access the File System Browser where you can select the folder or share for
the Security Notification policy.

Clear: Click to clear the path specified in the Targetfield.

Email Recipients: Specify the email addresses of each user you want notified when access
permissions to the selected folder or share are changed. Email addresses can be separated
by a comma, semicolon, or a space.

Clear: Click to clear the email addresses specified in the Email Recipients field.

Security Change Events: This region displays options for notifications. For example, if the
Group Membership check box were selected, data owners would be notified whenever there
was a change to a group that has access to the target path.
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Data Cleanup: Options for specifying how long you want scan job information to remain in the
database.

Retain Notification Data for: Lets you specify how long the Security Notification data will
remain in the database.

Retain Job Entries for: Lets you specify how long you want scan job information to remain in
the database. If you do not select the check box, the scan job stays in the database
indefinitely.

Data Owners: This region lets you specify the data owners for the target path. The data
owners will receive security notifications based on changes to the selected options in the
Security Change Events region.

Description Tab

The Description box indicates when the policy was created. It also lets you write notes
pertaining to the policy.

Schedule Tab

Displays the schedule for the Security Notification policy.
Data Tab

This page displays the properties of the CouchDB database.
Security Lockdown Policy

A discussion of fields and settings specific to a Security Lockdown policy follows.
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Security Lockdown Policy Page

Target Policy Editor - New Security Lockdown Policy — O x

Policy Enabled [ |
Descripﬁon Target Path | || Browse || Clear |

(O schedule

otz

@ General MName |New Security Lockdown Policy

Notification and Report Options

Email Redpients | | | Clear |

Indude Security Events

Security Change Events

Share Permissions Inherited ACEs (Target Path only)
Owner Directly assigned ACEs
Group Membership

Data Cleanup

Retain Notification Data for days
Retain Job Entries for days

Data Owners
=k Add == Remove

| Name Can Enable Policy

1. Changes to this policy have not been saved. oK | | Cancel | | Apply

General Tab

Name: Use this field to specify a name for the Security Lockdown policy.

Policy Enabled: Once the access permissions to the specified target path are the permissions
you want enforced, select this check box to enable the policy. Otherwise, come back and
select the check box after you have updated the access permissions to the target path.

Target Path: Indicates the folder or share that will be analyzed for access permission
changes.

Notification and Report Options: This region includes the settings specific to who is notified,
what is reported, and how long the report information remains accessible.

Email Recipients: Specify the email addresses of each user you want notified when access
permissions to the selected folder are changed (and subsequently reverted back through the
Lockdown policy). Email addresses can be separated by a comma, semicolon, or a space.

Include Security Events: When this check box is selected, all specified recipients listed in the
Email Recipients field will also receive security notifications according to the options selected
in the Security Change Events region. Deselecting this option limits the notifications to only
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changes in access permissions to the target path (and subsequently reverted via the
Lockdown policy).

Security Change Events: This region displays options for notifications. For example, if the
Group Membership check box were selected, data owners would be notified whenever there
was a change to a group that has access to the target path.

Data Cleanup: Options for specifying how long you want scan job information to remain in the
database.

Retain Notification Data for: Lets you specify how long the Security Lockdown data will
remain in the database.

Retain Job Entries for: Lets you specify how long you want scan job information to remain in
the database. If you do not select the check box, the scan job stays in the database
indefinitely.

Data Owners: This region lets you specify the data owners for the target path.

Can Enable Policy: Select this option if you want the selected data owner to be able to enable
the Lockdown policy

Description Tab

The Description box indicates when the policy was created. It also lets you write notes
pertaining to the policy. The Description box allows up to 255 characters.

Schedule Tab

Displays the schedule for the Security Lockdown policy.
Data Tab

This page displays the properties of the CouchDB database.
Security Fencing Policy

A discussion of fields and settings specific to a Security Fencing policy follows.
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Security Fencing Policy Page

Target Policy Editor - Mew Security Fending Policy — O X
‘ @ General MName |New Security Fending Policy | Policy Enabled I:‘
Rules Target Path | | | Browse | | Clear |
Description
Notification and Report Options
(O schedule
Email Recipients | | | Clear |
O oat
Indude Security Events
Security Change Events
Share Permissions Inherited ACEs (Target Path only)
Owner Directly assigned ACEs
Group Membership
Data Cleanup
Retain Notification Data for days
Retain Job Entries for days
Data Owners
o Add == Remove
| Name
1. Changes to this policy have not been saved. oK | | Cancel | | Apply
General Tab

Name: Use this field to specify a name for the Security Fencing policy.

Policy Enabled: Once the access permissions to the specified target path are defined the way
you want enforced, select this check box to enable the policy. Otherwise, come back and
select the check box after you have updated the access permissions to the target path.

Target Path: Indicates the folder or share that will be analyzed for access permission
changes.

Notification and Report Options: This region includes the settings specific to who is notified,
what is reported, and how long the report information remains accessible.

Email Recipients: Specify the email addresses of each user you want notified when access
permissions to the selected folder are changed. Email addresses can be separated by a
comma, semicolon, or a space.

Include Security Events: When this check box is selected, all specified recipients listed in the
Email Recipients field will also receive security notifications according to the options selected
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in the Security Change Events region. Deselecting this option limits the notifications to only
changes in access permissions to the target path.

Security Change Events: This region displays options for notifications. For example, if the
Group Membership check box were selected, data owners would be notified whenever there
was a change to a group that has access to the specified target path or one of its subfolders.

Data Cleanup: Options for specifying how long you want scan job information to remain in the
database.

Retain Notification Data for: Lets you specify how long the Security Fencing data will remain
in the database.

Retain Job Entries for: Lets you specify how long you want scan job information to remain in
the database. If you do not select the check box, the scan job stays in the database
indefinitely.

Data Owners: This region lets you specify the data owners for the target path.

Rules Tab

On this page, you specify the policy’s “fence” for inclusion and exclusion. A Security Fencing
policy can be very detailed in its inclusion and exclusions. For example, you can include an
Active Directory container, but exclude a group within the container. Additionally, your list for
inclusion or exclusion can specify unresolved or well-known Security Identifiers (SIDs). In
many cases, you will need to include unresolved or well-known SIDs, or the policy will prevent
access for those identities.

You can access a list of Windows well-known SIDs at: https://learn.microsoft.com/en-
US/windows-server/identity/ad-ds/manage/understand-security-identifiers.
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Security Fencing Policy Rules Page

Target Policy Editor - Atlanta Engineering Fending Policy — O X
@ General + Included Identities
P
. = Add ~ == Remove " Edit
Description | Name Scope Applies To
CM=Users,DC=sp,DC=cctec,DC=or Subtree | Grou

(O schedie T ,DC=sp, ,DC=0rg p

fe | OU=Groups,OU=Atlanta,0U=5P,DC=sp,DC=cctec,DC... Subtree | Group
Data

o .I!- CN=IT Administrators,OU=Groups,OU=HQ,0U=5F,DC... Base | Group
e BUILTIN‘\Administrators Base | Group
© | NT AUTHORITY\SYSTEM Base Computer
e 5-1-5-21-3648517610-2711151581-1220673217-1107 Base | Unknown
(@) Excluded Identities

o Add - == Remove " Edit

| Name Scope Applies To

1. Changes to this policy have not been saved. | oK | | Cancel | | Apply |

In the graphic above, the Included Identities list displays containers, groups, well-known and
unresolved SIDs.

To Add or Exclude a Well-Known SID as a Built-in Account

1. Inthe Included Identities or Excluded Identities region, from the Add drop-down menu,
select Built-in Accounts.
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Builtn Accounts X
|Name A |SID |
2 | Interactive 5-1-5-4 [+]

&L sk 5-1-5-17

2L Local 5-1-2-0

2 Local Service 5-1-5-1%

Local System 5-1-5-18

2L Network 5-1-5-2

2&  Network Configuration Operators 5-1-5-32-556

2 Network Service 5-1-5-20

& NTLM Authentication 5-1-5-64-10

.IJ- Performance Log Users 5-1-5-32-559

.I.pl Performance Monitor Users 5-1-5-32-558

2A Power Users 5-1-5-32-547

2A | Pre Windows 2000 Compatible Access 5-1-5-32-554

.IJ- Print Operators 5-1-5-32-550

& rroxy 5-1-58

.IJ- Remote Desktop Users 5-1-5-32-555

E Remote Interactive Logon 5-1-5-14 |Z|
| oK | E Cancel i

2. Hold down the Control key and select the Built-in SIDs.
3. Click OK.

To Add or Exclude an Unknown SID

1. Inthe Included Identities or Excluded Identities region, from the Add drop-down menu,
select Add Security Identifier.

Security ldentifier Selector

Security ldentifier: | Example: 5-1-5-32-544 Resolve

Enter a 510 in SDDL format, such as 5-1-5-32-544

NT Account:
Object Type:

Cancel
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2. Refer to the unresolved SID listed on the Security tab of the Properties dialog box.

3.

Engineering Properties
Previous Versions Customize Classification
General Sharing Security

Ohbject name:  E:\Shares \Atlanta*Atlartashare' Engineering

Group or user Names:

SR SYSTEM A
52 fz1ocaladmin-grp (DOM s 1docaladmin-gm)

52 Domain Admins {DOM\Domain Admins)

k 5-1-5-21-3191093876-396737396-2981135909-5747

52 Administrators (FS 1% Administrators) =
< >

To change permissions, click Edit.

Pemissions for
5-1-5-21-3191093876-39673735¢€ Allow Deny

Full control

Modify W
Read & execute vy
List folder conterts vy
Read vy
White W
Special pemissions W

For special permissions or advanced settings,
click Advanced. Advanced

[ ok | Ccance | pph

x

In the Security Identifierfield of the Security Identifier Selector dialog box, enter the SID
in SDDL format and click Resolve.
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4. Click OK.

Fencing Rule for "5-1-5-21-3191093876-396737396-2981135909-5747T

Rule Type: +«" Include for Assignment

Distinguished Mame:
GUID:
NT Account Name: 5-1-5-21-3191093876-396737396-20811359059-5747
SID: 5-1-5-21-3191093876-3967373096-20811350909-5747

Close

Included Identities: Use to display, add, and remove objects for inclusion in the Security
Fencing policy.

Excluded Identities: Use to display, add, and remove for exclusion in the Security Fencing
policy.

Description Tab

The Description box indicates when the policy was created. It also lets you write notes
pertaining to the policy. The Description box allows up to 255 characters.

Schedule Tab

Displays the schedule for the Security Fencing policy.

Data Tab

This page displays the properties of the CouchDB database.
Workload Policy

A discussion of fields and settings specific to a Workload policy follows.
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Workload Policy Page
Target Policy Editor - MNew Workload Policy — O X
‘ @ General MName |New Workload Policy
Description
Workload Paths
1 Create Action Block & Link Action Block ¢ Unlink Action Block
Path -
Identity List
2% Create Action Block & Link Action Block 5 Unlink Action Block
| Data Owner -
1. Changes to this policy have not been saved. oK | | Cancel | | Apply
General Tab

Name: Use this field to specify a name for the Workload policy.

Workload Paths: This region displays the Workload path for this policy, as well as provides
the means of linking, unlinking, and viewing Action Blocks pertaining to the path.

Paths: Displays the selected Action Block for this Workload policy.
Link Action Block: Lets you specify an Action Block for this policy.
Unlink Action Block: Removes a selected Action Block from the Path list.

Action Block Editor Link: Located in the upper right-hand corner of the Workload Paths
region, clicking this opens the Action Block Editor dialog box and lets you add new Workload
paths.

Identity List: This region displays the Data Owners for the policy, as well as provides the
means of linking, unlinking, and viewing Data Owners pertaining to the Workload policy.

Data Owner: Displays the Data Owners for this policy.
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Link Action Block: Lets you specify an Action Block for this policy. This will display the Data
Owners specified in the Action Block.

Unlink Action Block: Removes the listed Data Owners.

Data Owners Link: Located in the upper right-hand corner of the I/dentity List region, clicking
this opens the Action Block Editor dialog box where you can edit the list of Data Owners for
this policy.

Description Tab

The Description box indicates when the policy was created. It also lets you write notes
pertaining to the policy. The Description box allows up to 255 characters.

11.3.2 - Policy Schedules

Use this page to view and schedule all Target-Driven policy schedules.

Identity-Driven Target-Driven Cross-Empire Data Migration Configuration
=0 e = =
= ) §=——
STaw @ ssn O E)
Policies  Poliy  Action  Jobs Security
Schedules  Blocks Motifications
Management Notification Data

. User: DOM\localadmin Engine Address: app1.dom.cctec.org
@ Target Policy Schedules
Engine Version: 6.5.0.53

Enter text to search... <] Fina Clear e e = = = S = R A e e
Bolicies = | Policy Type 4 » | November 17, 2019 - November 23, 2019 < November * < 2018 *
~ [ Policies Sun, Nov 17 1/18 Tue, Nov 19 11720 Thy, Nov2l | Fri,Nov22  Sat Nov23 * SU MO TU WE TH PR SA
+ Security “l 27 28 29 30 51 1 2
53 4 5 6 7 8 9
(3 Atlanta 20k Fencing Policy  Security Fencing P... 1 o0 510 1 12 13 18 15 16
T3 125k Security Lockdown...  Security Lockdown... Bl 3
(@ Atlanta 50k Notification...  Security Notificati... “ 24 25 26 27 28 29 30
Finance Security Notficati... | Security Notificati... 2% _ _ B L pL= L pe—
I, Sales Security Notificatio... _Security Notificati...
! Financetnckdn.‘. 3w December 2019
(3 Atlanta Engineering Fenc... Security Fencing P... U MO TU WE TH FR A
(B Epoch Data Protection 40 s 1 2 3 4 5 6 7
Atlanta Data EP Epoch Palicy @ 8 9 10 11 12 13 14
i, Finance HVT Data Epoch Palicy 115 16 17 18 19 20 21
1, Sales Records and Projec..  Epoch Palicy 50 w2 3 2425 2627 2
: 129030 31 1 2 3 4
~ [ File Management 25 6 7 8 0 n
i, Copy User Apps from Hel... Copy Policy 6 —— —— —— — — — — Today
7 00

Version: 6.5.0.59

Left Pane: This region displays all Target-Driven policies according to classification. If you
click a classification such as Groom, only scheduled Groom policies will be displayed on the
calendar in the Middle Pane. If you click a named Target-Driven policy such as Main Groom
Policy for Atlanta Users, the schedule for that policy appears in the calendar of the Middle
Pane.

You can right-click a listed policy in the Left Pane to create new schedules, edit, schedules,
and delete schedules.

A search field at the top of the Left Pane lets you search for policies by name.
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Middle Pane: This calendar displays scheduled Target-Driven policy actions. You can display
the calendar as a single day, 5-day week, 7-day week, or as a month using the calendar
number icons above the Middle Pane.

The icons above the Middle Pane also allow you to edit the schedule, move through the
calendar, zoom in or out, group scheduled tasks, and change the time scales and captions.

Right Pane: This region displays a monthly calendar for the current and next month, which
you can change using the arrows. Clicking a date adjusts the calendar in the Middle Pane to
the selected date.

For procedures on scheduling a Target-Driven policy, see Creating Target-Driven Policies

(page 105).
11.3.3 - Action Blocks

You can use this page to locate and create Filter Action Blocks that can be used in Target-
Driven policies.

Double-clicking a selected Filter Action Block brings up the Action Block Editor where you can
view specific details about the Filter Action Block, edit rules, and more.

Manage: This menu lets you create, edit, rename, or delete a Filter Action Block.

For procedures on creating a Filter Action Block, see Creating a Filter Action Block (page 174).

Search: Clicking this provides a new field for locating a Filter Action Block. Enter a search
string in the field and click Find.

Refresh: Updates the list of Filter Action Blocks.

11.3.4 - Jobs

This page provides details on all Target-Driven jobs that have taken place or are pending.
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Jobs Page

I§-  Home Target-Driven Empire Data Migration nfiguration
C) @ v
Policies Policy Action  Jobs Security
Schedules  Blocks Notifications
Management Motification Data
a
oTarget Policy Jobs
M Abort () Detsils | 5 Refresh
Enter text to se - Find Clear
Drag a column header here to group by that column
Policy Type Target Path CreateTime &  Queue Time
125k Security Lockdow... | Security Acc.. | \fs1.dom.cctec.org\Shares\AtlantaiDa... | 11/18/2019 %:0... | 11/18/2019 9:0,
Atlanta 50k Notificatio.. Security Acc..  \\fsl.dom.cctec.org\Shares\Atlanta\Da.. | 11/18/20194:0... | 11/18/2019 4:0..,
Atlanta 20k Fencing Po...  Security Acc..  \\fsl.dom.cctec.org\Shares\Atianta\Da.. | 11/18/2019 3:0... | 11/18/2019 3:0..,
Atlanta Engineering Fe.. Security Acc..  \\dom.cctec.org\DFS\Atlanta\Atiantas... | 11/18/2019 11/18/2019 1
125k Security Lockdow... ~ Security Acc.. | \\fs1.dom.cctec.org\Shares\Atlanta\Da... | 11/17/20199:0... | 11/17/2019 %:0..
Atlanta 50k Notificatio..  Security Acc..  \\fsl.dom.cctec.org\SharesiAtianta\Da.. | 11/17/20194:0... | 11/17/2019 4:0..,
Atlanta 20k Fencing Po...  Security Acc.. | \Wfsl.dom.cctec.org\Shares\Atlanta\Da.. | 11/17/2019 3:0... | 11/17/2019 3:0..,
Atlanta Engineering Fe... Security Acc..  \\dom.cctec.org\DFS\Atlanta\Atiantas... | 11/17/2019 1:0... | 11/17/2019 1:0..,
125k Security Lockdow... ~ Security Acc.. | \\fsT.dom.cctec.org\Shares\Atlanta\Da... | 11/16/20199:0... | 11/16/2019 %:0..
Atlanta 50k Notificatio.. Security Acc... \\fs1.dom.cctec.org\Shares\Atlanta\Da... = 11/16/20194:0... | 11/16/2019 4:0.
Atlanta 20k Fencing Po...  Security Acc..  \\fsl.dom.cctec.org\Shares\Atlanta\Da.. | 11/16/2019 3:0... | 11/16/2019 3:0..,
Atlanta Engineering Fe...  Security Acc..  \idom.cctec.org\DFS\Atlanta\Atiantas... | 11/16/2019 1:0.. | 11/16/2019 1:0..,
Atlanta Engineering Fe...  Security Acc..  \idom.cctec.org\DFS\Atlanta\Atiantas... | 11/15/2019 1:2... | 11/15/2019 1:2..,
Atlanta Engineering Fe.. Security Acc..  \\dom.cctec.org\DFS\Atlanta\Atiantas... | 11/15/2019 1:2... | 11/15/2019 1:2..,
Atlanta Engineering Fe... Security Acc..  \\dom.cctec.org\DFS\Atlanta\Atiantas... | 11/15/2019 1:1.. | 11/15/2019 1:
Atlanta Engineering Fe...  Security Acc..  \idom.cctec.org\DFS\Atlanta\Atiantas... | 11/15/201912.. | 11/15/2019 12,
125k Security Lockdow... = Security Acc...  \\fs1.dom.cctec.org\Shares\Atlanta\Da... | 11/15/2019%:0.. = 11/15/2019 %:0...
Atlanta 50k Notificatio..  Security Acc..  \ifsl.dom.cctec.org\Shares\Atianta\Da... | 11/15/20194:0... | 11/15/2019 4:
Atlanta 20k Fencing Po... | Security Acc..  \\fsl.dom.cctec.org\SharesiAtianta\Da.. | 11/15/2019 11/15/2019 3

Attempts

o oo o oo o000 o000 oos o a0

User: DOM\localadmin

Last Error
0) Operation successtul.

0) Operation successtul.

0) Operation successful,

0) Operation successful,

0) Operation successful.

0) Operation successful.

0) Operation successful,

0) Operation successful,

0) Operation successful.

(0} Operation successful.

0) Operation successful,

0) Operation successful.

0) Operation successful.

0) Operation successful,

0) Operation successful,

0) Operation successful.
(0) Operation succassful.
(0) Operation successful.

0) Operation successtul.

Engine Address: app1.dom.cctec.org

Engine Version: £.5.0.53

+ Processing Jobs

Status  Next Attempt Job ID
Com... = Mever 10207 ~
Com... = Mever 10206
Com... = Mever 10205
Com... = Mever 10204
Com... = Mever 10203
Com... = Mever 10202
Com... = Mever 10201
Com... = Mever 10200
Com... = Mever 10199
Com... | Never 10198
Com... = Mever 10197
Com... = Mever 10196
Com... = Mever 10195
Com... = Mever 10194
Com... = Mever 10193
Com... = Mever 10192
Com.. | Mever 10191
Com... = Mever 10190
Com... = Mever 10189 *

The page lists completed and pending jobs. You can maximize the list by clicking the
Maximize icon in the upper right corner of the Jobs region.

11.3.5 - Security Notifications

This page provides a graphical summary of changes in security access permissions and group
memberships for high-value targets managed through security policies. Using the information
you ascertain from the graphs, you can in-turn run a Detail Report to view the details of the

changes.
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Security Notifications Page

Identity-Driven Target-Driven Cross-Empire Data Migration Configuration

=L e = 5

= as B

[=F‘ @ san O e}
Policies  Policy  Action  Jabs Security

Schedules  Blocks Notifications
Management Notification Data
= . e User: DOM\ocaladmin Engine Address: 172,17.2.21
% Security Notifications

Engine Version: 6.5.0,53
P Run Detail Report = () Reload Policies <73 Refresh

Policy: Medical Lockdown Policy * Policies
Target Path: \\dom.cctec.org\DFS\HQ\hqshare\Departments\Medical rame
0 Medical Lackdown Poli
Events @ o
@ Actors (* Finanace Lockdown Palicy
15 (3 | Atlanta Engineering Fencing Policy
o (g | Sales Security Notification Policy
(3 | IMDepartment Security Lockdown Policy
5
0 -—J‘ -
8/18/2019 9/1/2019 9/15/2019 9/2/2019 10/13/2019 10/27/201 11/10/2019
8/25/2019 o/8/2019 9/22/2013 10/6/2013 10/20/2018 1132018
Events )
- ~ Filters
Access Control Entry I Il Actions
Counts
Total Policy Events: 16,787
= S
Total Policy Actions: 6
0 2000 4000 5000 8000 10000 12000 14000 16000 (A ] AR ©

Version: 6.5.0.58

Run Detail Report: This drop-down menu is the means of generating detail reports for either
file system events or group membership events. Reports are generated according to the

selected policy, filter settings, and date range settings located on the right-hand portion of the
page.

Reports are first generated in preview mode, where they can then be saved in a number of
different format types.
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Sample File Systems Event Report

r F‘ B E ISI E Margins ~ ‘I‘ Bl:l IEl Previous Page | EU &, Zoom Out & Page Color - & - 9

[Ey Orientation - B Hext Page ] Q Zoom -

Find  Thumbnails Bookmarks Editing  First

Open  Save | Print  Quick Parameters | Scale B Watermark @ - | Close
- IO Size ~ Fields Page Pl Last Page =

Many Pages

& Zoom In
Documen t Print Page Setup o avigation Zoom Page Background
Document Map X

~ Security Notifications

Parameters

M report Data

v 20181118

\dom.cctec.orgiDF...

Security Notifications
Report

File System Events by Date

Report Date: Monday. November 18, 2019

Generated by: DOMilocaladmin

Reload Policies: Adds to the list of policies, any new security policies that have been created
since the Security Notification page was opened.

Refresh: Refreshes the Security Notifications page.

Upper Graph: According to the specifications on the right-hand side of the page, displays a
graph of the number of events and actions in a timeline from the first security scan, to the most
recent. Placing the pointer on lines of the graph provides additional numerical information.

Lower Graph: According to the specifications on the right-hand side of the page, displays a
graph of the totals for the specified data range.

Policies: Select from this list to display the policy-specific data in the graphs and in the Detail
Report.

Filters: Lets you specify what criteria and date range to include in the graphs and in the Detail
report.

Counts: Based on the selected policy, criteria, and date range, displays the total count of
policy events, filtered events, policy actions, and filtered actions.

11.4 - Configuration Tab

Use this page to establish configurations and set preferences for an extensive set of File
Dynamics tools.

General Preferences (page 227)

Global Statistics Configuration (page 229)

Work Log Configuration (page 233)

Target-Driven Configuration (page 235)
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Client Preferences (page 236)

11.4.1 - General Preferences
This page lets you view and set Engine configuration settings.

General

The Generaltab includes proxy and management access settings. Each of the fields is
described below.

The General Tab of the Configuration Page

Proxy Rights Group: Displays the Proxy Rights Group that you established when you
installed File Dynamics.

Admin Users Group: Displays the Admin Users Group that you established during the
installation of File Dynamics.

HTTPS Port: Displays the HTTPS port that you chose when you installed File Dynamics.

HTTP Port: If you chose to use an HTTP port during the installation of File Dynamics, the
HTTP port is displayed here.

User Session Timeout: Indicates the number of minutes the Admin Client can be left dormant
before you need to reauthenticate.

Proxy Home Path: This path was established during the installation of the Admin Client. If you
need to, you can change the path by using the Browse button.

Reapply Rights: Clicking this button reestablishes the ability of the Proxy Rights group to
manage the Proxy home share. It also reestablishes the group Everyone with the Read right
so that its members can read contents. The Read right is needed in case the Proxy home
share is being used as the managed path attribute while storage is being moved.

Copy Template: Clicking this button recopies default proxy home template files to the location
specified by the share.

Engine Logs
The Engine Logs tab includes settings specific to log files.

Each of the fields is described below.
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The Engine Logs Tab of the Configuration Page

18- Home

EE

General  Global Statistics ~ Work Log
Preferences  Configuration  Configuration

Identity-Driven

’ General Preferences

General

Identity-Driven Target-Driven

-
Target-Driven
Configuration

Target-Driven

Engine Logs | Advanced Options

Log Management
Default Logging Level | Informational
Log Rollover Type | Size
Advanced Logging

Enable Advanced Logging

Identity-Driven Event Proces [Default]

Target-Driven Job [Default]

Policy Management | [Default]

Agent Manager | [Default]

Event Monitor Manager |

Quota Manager | [Default]

Log Access

View Current Engine Log Download

Version: 6.5.0.59

Cross-Empire Data Migration

e

Client
Preferences

Client

Log File Retention Limit

Log File Retention Count

Ul Session Manager

[Default]

Global Statistics Collector

RESTAPI | [De

Configuration

10
0

User: DOM\localadmin

files

[Default]

Default]
[Default]

HTIP Client | [Default]

Engine Address: appl.dom.cctec.org
Engine Version: 6.5.0.53

Apply

Default Logging Level: By default, the log records warning level details. You can change the
log to record the level you want. Be aware that some settings, such as debug or verbose,
record much more information and can potentially make the log file much larger.

Log File Retention Limit: This field appears only when you select Size from the Log Rollover
Typefield. You need to enter the size limit in MB for the log file before it creates a new file.

Log Rollover Type: You can choose whether to have log files roll over daily, hourly, when the
log has reached a set size limit, or have no rollover setting. If you select None, the same log
file is opened each time you start the Engine, and log entries are appended to it.

If you delete the log file while the Engine is not running, a new log file is created the next time

you start the Engine.

Log File Retention Count: By default, File Dynamics retains the 10 most recent log files,
according to the Log Rollover Type setting. For example, if the Log Rollover Type setting is set
to Daily, the retained log files are from the last 10 days.

Enable Advanced Logging: Selecting this check box activates the Advanced Logging region
of the page. This region allows you to specify the output of the log file according to the setting
you indicate in each of 13 categories.

Advanced Options

The Advanced Options tab lets you view or reconfigure the thread count settings allocated for
the actions that File Dynamics performs.
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The Advanced Options Tab of the Configuration Page

I§-  Home Identity-Driven Target-Driven Cross-Empire Data Migration Configuration

£ & @ L =

General  Global Statistics ~ Wark Log Target Driven Client
Preferences  Configuration  Configuration | Configuration  Preferences
Identity-Driven Target-Driven Client
User: DOM\ocaladmin Engine Address: app1.dom.cctec.org
General Preferences
Engine Version: 6.5.0.53
General | Enginelogs | Advanced Options
Work Queue
User Event Thread Count. 10 2 Generic Event Thread Count 10 2
Collabarative Event Thread Count 0 2 Management Action Thread Count 10
Auiliary Event Thread Count 5 3
Event Processing
Pracess Group Moves [+
Event Cache Log Purge 30 2| dayls)
Clear Statistics After 30 dayls)

Apply

Version: 6.5.0.59

Work Queue: These settings are optimized for a normal File Dynamics workload.
Process Group Moves: Click this box to enable File Dynamics to move collaborative storage.

'Event Cache Log Purge: By default, File Dynamics keeps the most recent 30 days of event
entries in cache. You can adjust the setting in the Days field.

The event cache can be helpful in providing you a recent history of all of the events that were
sent from the Event Monitor.

Clear statistics after: This option specifies how long statistics are kept for the graphs
displayed on the Statistics page.

11.4.2 - Global Statistics Configuration

The default configuration of the GSR Collector forces it to behave in a manner consistent with
legacy versions of the product. However, it is not optimal for most deployments.

The GSR Collector can be scoped by file system and directory service parameters.
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File System Configuration Settings for the GSR Collector

I§-  Home Identity-Driven Target-Driven Cross-Empire Data Migration Configuration
— -
FF & L4 L =
General  Global Statistics ~ Work Log Target-Driven Client
Preferences  Configuration  Configuration | Configuration  Preferences
Identity-Driven Target-Driven Client

User: DOM\ocaladmin Engine Address: appl.dom.cctec.org

@ Global Statistics Configuration
Engine Version: 6.5.0.53

File System | Directory Service

Scope Paths
All Storage Resources — [z

+ | Policy Target Paths Path

Specified Storage Resources [F \\dom.cctec.org\DFS\Atianta\AtlantaShare\Commeon Share

m.cctec.org\DFS\HClhasharet HRD eptiActive Employees
Size Gathering m.cctec.org\DFS\HCRhashareiManaged Storage

m.cctec.org\DFS\NYC\NYCShare\Departments\NYC Marketing
@) Complete Inspection m.cctec.org\DFS\NYC\NYCShare\Departments\Training\Courses
Limit to Storage Resources that have quota enab m.cctec.org\DFS\NYC\Users
No Size Collection .dom.cctec.orgiSharesiAtlanta\Users

\\fs1.dom. cetec.argiShares\HQUsers
Anomaly Analysis | Full \Wfs1.dom.cctecorg\Shares\London\Users
[Zr Wfs1.dom.cctec.argiShares\Munich\Users

Apply

Version: 6.5.0.59

File System Tab

Scope: The file system scope provides the means for you to determine which shares should
be scanned by the GSR Collector. The file system scopes are:

« All Storage Resources: This is the default option and mutually exclusive of Policy
Target Paths and Specified Storage Resources. This will cause the GSR Collector to
scan the root of all shares that appear in Storage Resources for size and anomaly data.
This can take a significant amount of time to complete depending on the share type,
contents, and the chosen Size Gathering option. In large environments, this is not the
recommended configuration.

¢ Policy Target Paths: This option can be checked separately or combined with
Specified Storage Resources for greater flexibility. This will cause the GSR Collector to
only scan paths defined as policy target paths for size and anomaly data. After you have
your storage managed by policy, use this option to limit the scope and provide
meaningful size and anomaly analysis data for the storage resources that matter most.

» Specified Storage Resources: This option can be checked separately or combined
with Policy Target Paths for greater flexibility. This will cause the GSR Collector to only
scan paths defined by you for size and anomaly data. When running the GSR Collector
for the first time, this option serves as the best choice because it allows you to target
specific paths and storage resources.

Size Gathering: The size gathering options allow you to control the method by which
aggregate size data for global statistics and policy-based path redistribution is collected.
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» Complete Inspection: This is the default option. To collect size data, folders are
checked for quota. If quota is determined to be supported by the hosting server and the
folder has a quota, FSRM is queried to obtain the relevant data. In the case where the
folder does not have a quota managed by FSRM or it simply has no quota at all, the
folder is traversed to collect size data of all files.

 Limit to Storage Resources that have quota enabled: If quota is determined to be
supported by the hosting server and the folder has a quota, FSRM is queried to obtain
the relevant data. The folder must have a quota set to eliminate brute force enumeration
to collect size data.

* No Size Collection: No size data collection is attempted.

Anomaly Analysis: The file system anomaly analysis provides the means for you to determine
the level of anomaly analysis. The options are:

¢ None: Anomaly analysis will not be performed.

e Simple: This is the default option and sufficient for most purposes. The following
anomalies are reported:

Attribute Value Missing: The respective path attribute (e.g. home folder) does
not have a value.

Path Missing On Disk: The respective path attribute value cannot be found on
disk.

Path Validation Issue: Attempting to retrieve or verify the existence of the
respective path attribute value failed.

Name Mismatch: The respective leaf path value does not match the object’s
name value.

Path Mismatch: The respective path attribute value does not match the last
known managed path database entry.

DS Path Duplicate Value: Two or more objects have been detected that contain
the same path for the respective path attribute.

DS Path Crosstalk Parent: The object’s respective path attribute has been
detected as being the parent of another object’s path attribute.

DS Path Crosstalk Child: The object’s respective path attribute has been
detected as being the subordinate of another object’s path attribute.

Orphan Path Candidate: The path is directly subordinate to a path at which other
DS-associated paths have been found, but has not been detected as being
associated with any DS object via a path attribute.

¢ Full: Reports additional policy related anomalies.

Policy Not Found: The respective auxiliary policy attribute entry references an
auxiliary policy that was not found in the database.

Policy Object Not Managed: Effective policy calculations indicate that a policy is
effective for the respective object and path type, but the object is not known to be
managed.
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¢ Policy Mismatch: The respective path is indicated as being managed in the
database, but the policy under which it is currently managed does not match what
effective policy calculation indicates it should be.

¢ Policy Validation: An error occurred while attempting to calculate effective policy
for the object and respective path type.

Directory Service Tab

Container Scope: The directory service container scope provides the means for you to
determine which containers should be enumerated by the GSR Collector for Anomaly
Analysis, Global Statistics, and History. The container scopes are:

< All Containers: This is the default option and mutually exclusive of Policy Associated
Objects and Specified Containers. This will cause the GSR Collector to enumerate all
object types specified by the Object Scope for size and anomaly data.

» Policy Associated Objects: This option can be checked separately or combined with
Specified Containers for greater flexibility. This will cause the GSR Collector to only
enumerate and evaluate objects that are associated to policies. After you have your
objects managed by policy, use this option to limit the scope and provide meaningful
anomaly analysis data for the objects that matter most.

» Specified Containers: This option can be checked separately or combined with Policy
Associated Objects for greater flexibility. This will cause the GSR Collector to only
enumerate and evaluate objects defined by you for size and anomaly data. When
running the GSR Collector for the first time, this option serves as the best choice
because it allows you to target specific objects for analysis.

The containers specified in the container scope are searched recursively for object types
configured in the Object Scope.

Object Scope: The directory service object scope provides the means for you to determine
which object types and path types should be enumerated by the GSR Collector for Anomaly
Analysis, Global Statistics, and History. The object scopes and path types are:

e Users
¢ Home Folder
Profile Path

¢ Remote Desktop Services Home Folder

* Remote Desktop Services Profile Path
¢ Auxiliary (ccx-FSFAuxiliaryStorage)
¢ Groups - Collaborative managed path (ccx-FSFManagedPath)

* Containers - Collaborative managed path (ccx-FSFManagedPath)
GSR Collector Configuration Scenarios
Configuration scenarios for the GSR Collector are detailed in the sections below.

All Storage Resources + Complete Inspection

This default configuration will cause the GSR Collector to enumerate all shares found in
Storage Resources. During the enumeration, child folders at the root of shares are inspected
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for anomaly analysis and checked to determine if they have a quota applied to them via File
Server Resource Manager (FSRM). If they have a quota, FSRM is queried to obtain it. In the
case where a server hosting a share does not support quota (e.g. FSRM is not installed, the
server is a NAS device) a brute force enumeration of the child directories is performed to
collect size data for statistics and policy-based storage redistribution. Depending on the
number of directories and their contents, this is a time consuming and resource intensive
operation. While it ensures that all of the available shares are scanned, it is not the most
efficient use of the GSR Collector.

All Storage Resources + Limited to Storage Resources that Have Quota Enabled

This configuration will cause the GSR Collector to enumerate all shares found in Storage
Resources. During the enumeration, child folders at the root of shares are inspected for
anomaly analysis and checked to determine if they have a quota applied to them via FSRM. If
they have a quota, FSRM is queried to obtain it. This configuration is more efficient than
Complete Inspection. However, if you have folders that do not have quota, there will be size
data missing from Global Statistics and Policy-based Path Redistribution that would skew your
results.

All Storage Resources + No Size Collection

This configuration will cause the GSR Collector to skip enumeration of all shares found in
Storage Resources for size related data. If Global Statistics are not needed on a regular basis
or you have a need for finer granularity in your historical data, this option may be best suited
for your goals. However, if you choose this option, there will be no size data to drive Global
Statistics and Policy-based Path Redistribution.

11.4.3 - Work Log Configuration

This page lets you establish the Work Log Database Settings in the Admin Client. For detailed
procedures, see Establishing the Work Log Database Settings in the Admin Client (page 140).
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Work Log Configuration Page

18- Home

Identity-Driven

EE

Work Log
Configuration

General  Global Statistics
Preferences  Configuration

Identity-Driven

A
= Work Log Configuration

Configuration

+ | Enable Work Log

Target-Driven

Cross-Empire Data Migration Configuration

T =

Client
Preferences

Target-Driven
Configuration

Target-Driven Client

a Database Information

P Database Version: 2.3.1
Database Host | 172.17.2.11 Port:| 5984 Database Vendor: The Apache Software Foundation
Database Name | fstworklog_db Database Name: fsfworklog_db
Admin Username
Database Size: 4 ME
Admin Password
Live Data Size: 2 MB
Reprovision
Document Count: 2,175
Options Deleted Document Count: 0
Database Compaction: Mot Running

User: DOM\ocaladmin Engine Address: appl.dom.cctec.org

Engine Version: 6.5.0.53

Store discarded entries
Clear entries after 1 2| dayis)

Apply

Version: 6.5.0.59

Database Settings: Fields in this region are specific to the CouchDB database.
For information on setting up the CouchDB database, see Installing CouchDB.

Database Host: Specifies the IP address or DNS hostname of the server hosting the
CouchDB database.

Port: Specifies the port number utilized by the CouchDB database.
The default number is 5984.

Database Name: The established name for the CouchDB database instance for the Work
Log.

Admin Username: The administrator username you established when you installed the
CouchDB database.

Admin Password: The password you established when you installed the CouchDB database.

Reprovision: Once you have entered the username and password, clicking this button re-
provisions the user and database for the Work Log.

Options: Fields in this region are specific to the File Dynamics Work Log.

Enable Work Log: Once this option is selected, events will be recorded as entries in the Work
Log.

Store Discarded Entries: Store Work Log entries for events where no action is ultimately
taken, such as a user created outside the scope of any policy.
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Clear Entries After: Select this option to specify the number of days before an entry is cleared.
Once cleared the entry will not be listed in the Work Log.

Apply: Click to apply the settings in the Options region.
11.4.4 - Target-Driven Configuration

Use this page to establish the CouchDB database settings for all security-based Target-Driven

policies, as well as for Workload policies.

Target-Driven Configuration Page

Home Identity-Driven Target-Driven Cross-Empire Data Migration Configuration

& & = =
5 § =
General Global Statistics Work Log Target-Driven Client

Preferences  Configuration  Configuration | Configuration  Preferences

Identity-Driven Target-Driven Client

-
~ |r Target-Driven Configuration

Target-Driven Policy Database Configuration

Database Host | (EPREIR Port 5984
Admin Username
Admin Password
Reprovision
‘Workload Database Configuration
Database Host | 172.17.2.11 Port 5984
Admin Username
Admin Password
Reprovision

Version: 6.5.0.59

Database Version:

Epoch Database Count:

Security Policy Database
Database Size:

Live Data Size:

Document Count:

Deleted Document Count:
Database Compaction:

Database Version:
Database Name:
Database Size:

Live Data Size:

Document Count:
Deleted Document Count:

Database Compaction:

User: DOM\localadmin Engine Address: appl.dom.cetec.org

Engine Version: £.5.0.53

231
3

fsf_security_notify
96 MB

26 MB

130,613

o

Mot Running

231
fsf_workload_database
137 KB

3KB

2

o

Mot Running

Target-Driven Policy Database Configuration: This region is specific to the CouchDB

database instance for security-based Target-Driven policies.

Database Host: Enter the IP address or DNS host name or the server hosting CouchDB.

Port: Set the port address to 5984.

Admin Username: Enter the username for the previously-installed CouchDB instance.

Admin Password: Enter the password for the previously-installed CouchDB instance.

Provision: Click to provision the database instance.

Workload Database Configuration: This region is specific to the Couch DB database

instance for Workload policies.

The results of Workload actions are stored in a CouchDB instance and can be accessed via

the Data Owner Client.

Database Host: Enter the IP address or DNS host name of the server hosting Couch DB.
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Admin Username: Enter the username for the previously-installed CouchDB instance.
Admin Password: Enter the password for the previously-installed Couch DB instance.

Provision: Click to provision the database instance.

11.4.5 - Client Preferences

Use this page to set preferences specific to the File Dynamics Admin Client.

Client Preferences Page

I§-  Home Identity-Driven Target-Driven Cross-Empire Data Migration Configuration

£ & BF L =

General  Global Statistics ~_ Work Log Target-Driven Client
Preferences  Configuration  Configuration | Configuration  Preferences

Identity-Driven Target-Driven Client
. User: DOM\localadmin Engine Address: appl.dom.cctec.org
EI Client Preferences
=s Engine Version: 6.5.0.53

Application Startup and Close

{Always start this application with elevated privileges, ) Requires application restart

/| Check for updates after login

Prompt for confirmation when closing

Directory Object Selector Settings

Enable Caching Cache Timeout in minutes

Client Data Path

Default Data Path | C:\Users\localadmin\Documents Browse

Logging Options

View Log Open Folder

Version: 6.5.0.59

Application Startup and Close: This region provides preference settings for when the Admin
Client is launched and closed.

Always start this application with elevated privileges: When selected, this option allows you
to run the Admin Client as the Administrator, enabling you to view settings that are not visible
to non-administrators. For example, Server Share properties can only be seen when someone
is logged in as an administrator.

Check for updates after login: Selecting this check box allows the Admin Client to notify you
of the availability of newer File Dynamics components.

Prompt for confirmation when closing: When selected, this option specifies that you want a
confirmation prompt before closing the Admin Client.

Directory object Selector Settings: This region lets you establish caching settings specific to
the Admin Client.

Enable Caching: Selecting this check box enables the Admin Client to maintain the area of
the directory tree that is visible in the right pane of the Objects page, if you move from the

236



11 - Reference

Objects page to another. For example, if you locate a Group object in a container and then
need to move to another page, when you return to the Objects page, you do not need to
navigate the directory tree to locate the Group object again.

Cache Timeout in minutes: In large enterprises, it can take a long time to build up the
directory services cache. In these type of environments, consider increasing this setting so
that you can use the cache, instead of querying directory services again for information.

Default Data Path: This field specifies the location where all exported reports are stored. For
example, if you were to export a Consistency Check report as a CSV or HTML file, it would be
saved in this location.

Browse: Locate the destination where you want exported reports stored.
Logging Options: This region enables you to access the Admin Client’s log files.
View Log: Clicking this button opens the log file.

Open Folder: Clicking this button opens the folder where the Admin Client’s compressed log
files are stored.
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Appendix A - Security Specifications

This section provides details on the necessary security settings needed for the File Dynamics
components .

A.1 - Firewall Requirements
A.1.1 - Windows Firewall

The Windows Firewall has different default configurations based on the version of Windows
Server.

In most cases, the File Dynamics installation enables the following firewall settings. In the rare
circumstances where it does not, you will have to establish these manually.

Engine
¢ The Engine must be permitted to make outbound connections.

e The Engine must be able to listen on port 3009. This is the default port choice presented
during the installation and configuration.

¢ The default firewall rule for the Engine allows access to the application on any port it
listens on.

File System Agent

¢ The Agent must be permitted to make outbound connections.

e The Agent must be able to listen on port 3011. This is the default port choice that is
presented during the installation and configuration.

e The default firewall rule for the Agent allows access to the application on any port it
listens on.

Phoenix Agent

¢ The Phoenix Agent must be permitted to make outbound connections.

¢ The Phoenix Agent must be able to listen on port 3013. This is the default port choice
that is presented during the installation and configuration.

¢ The Phoenix Agent makes use of the Windows http.sys HTTP listener, so firewall rules
must specify a port and not an application.

¢ If you use the Phoenix Agent Configuration utility, it will adjust the listening port and the
associated firewall rule.

Event Monitor

¢ The Event Monitor component must be permitted to make outbound connections.
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Data Owner Web Service
¢ The Data Owner web service must be permitted to make outbound connections.

¢ The Data Owner web service must be able to listen on port 3079. The is the default port
choice that is presented during the installation and configuration.

¢ The default firewall rule for the Data Owner web service allows access to the application
on any port it listens on.

Admin Client
e The Admin desktop client must be permitted to make outbound connections.
Resource Servers

¢ On each Windows server hosting user or collaborative storage with managed quota,
you must enable the Remote File Server Resource Manager Management -
FSRM Service (RPC-In) firewall rule.

A.1.2 - Other Services

The following services may run on Windows or Linux, so firewall rules management may vary
depending on the service host.

SQL Server Database

e The associated SQL Server instance hosting the File Dynamics database must listen on
TCP/IP.

e Currently only IPv4 addresses are supported.

¢ The listening TCP/IP port (default port 1433) must be enabled for access in the firewall
where SQL Server is running.

e The Admin Client, Engine, and Phoenix Agents must all have access to the IP address
and TCP port where SQL Server is listening.

CouchDB

¢ The host where CouchDB is installed must allow inbound access for TCP port 5984
which is the default port for CouchDB.

¢ The Engine, Data Owner Client web service, Phoenix Agent, and Admin Client must all
have access to to the IP address and TCP port where CouchDB is listening.

A.2 - LSA Rights and Privileges

The following table identifies the security principals, sets of rights and privileges and the
computers on which the rights and privileges must be granted for File Dynamics to function

properly.

Each component's configuration utility will setup the required privileges and group
membership for the host server on which it is installed.
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IMPORTANT: Changes to a given User Rights Assignment in a server's Local
Security Policy or in applicable Group Policy Objects (GPOs) can interfere with
the expected assignments for the BUILTIN\Adminstrators group or the File
Dynamics Admins and Data Owners groups.

In particular, if you use GPOs for managing User Rights Assignments you may
need to add the group assignments listed below to applicable Group Policies.

A.2.1 - Engine Server

Security Principal User Rights Assignment Notes

e Backup
¢ Batch Logon

¢ Change Notify

« Impersonate Provided by membership in
Proxy Rights Group BUILTIN\Administrators local

¢ Network Logon group.

¢ Restore

e Security

e Take Ownership

Setup as part of Engine

Admins Group Batch Logon . .
configuration.

Setup as part of Engine

Data Owners Group Batch Logon A .
configuration.

A.2.2 - Event Monitor Server

Security Principal User Rights Assignment Notes

« Batch Logon . .
Provided by membership in

Proxy Rights Group ¢ Impersonate BUILTIN\Administrators local

roup.
e Backup group

241



Appendix A - Security Specifications

Security Principal User Rights Assignment Notes

e Restore
e Security

o Take Ownership

A.2.3 - Agent Server

These permissions apply to servers hosting either the File System Agent or Phoenix Agent.

Security Principal User Rights Assignment Notes

e Backup
« Batch Logon

e Change Notify

« Impersonate Provided by membership in
Proxy Rights Group BUILTIN\Administrators local

e Network Logon group.

» Restore

o Security

e Take Ownership

A.2.4 - File Share Server

Security Principal User Rights Assignment Notes
e Backup
e Change Notify
« Network Logon Provided by membership in
Proxy Rights Group BUILTIN\Administrators local
e Security

o Take Ownership
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A.3 - Proxy Rights Group Permissions

The Proxy Rights Group is responsible for holding permissions and privileges necessary for
the File Dynamics Proxy user account.

A.3.1 - Windows Servers

File Shares

Each file share managed by File Dynamics must have the Proxy Rights Group assigned with
Full Control to the share itself.

Built-in Administrators Group

Some system calls used by File Dynamics require membership in each managed Windows
server's BUILTIN\Administrators local group. This group membership also provides a number
of user rights and privileges required by the proxy account for proper operation with each
managed Windows server.

When you install and configure the Engine or Agent components from File Dynamics on a
domain member server, the configuration tools grant the Proxy Rights group membership in
the built-in Administrators group on that member server.

For other servers in the domain that are hosting storage managed by File Dynamics, you must
grant Proxy Rights group membership in the built-in Administrators group.

A.3.2 - NAS File Servers

See NAS Device Considerations (page 245) for details on the Proxy Rights Group
permissions and group memberships requirements for NAS devices.

A.3.3 - Active Directory

Proxy Rights Group Permissions

The Proxy Rights Group requires the following access at the root of each domain in the forest:

Access Applies To Notes

Read

(Read all properties, This object and all Required for basic management
Read permissions, List = descendants and navigation

contents)

Replicating Directory | ;¢ object only Required for Event Monitor !
Changes

Read/Write cex- Descendant cex- Required for management of File

Dynamics Auxiliary policy schema

FSFAuxiliaryStorage FSFManagedPathAttributes . 2
extensions
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Access Applies To Notes

Required for management of File

Read/Write ccx- Descendant ccx- . . .
Dynamics Collaborative policy

FSFManagedPath FSFManagedPathAttributes . 2
schema extensions
Required for managing auxiliary
Read/Write Descendant user, group fclass cui\torr.:.schem; extensions
objectClass objects or user Auxiliary and group
Collaborative storage management
2
Read/Write Required for management of home

Descendant user objects

homeDirectory directory attributes

Required for management of home

Read/Write homeDrive | Descendant user objects . :
directory attributes

1. This permission only applies to the domain root. Additionally, it is only needed if the File
Dynamics Event Monitor for AD is installed.

2. These permissions only apply when using User Auxiliary or Collaborative storage
policies and the custom schema extensions have been applied.

Delegated Administration

For environments requiring delegated administration in Active Directory, apply the previous list
of rights to the specific containers where management by File Dynamics is allowed to operate.

You can then remove any assigned permissions from the domain root as necessary.

l:&ﬂ NOTE: The Replicating Directory Changes permission only works on the
| | domain root and cannot be delegated to any subcontainers.

A.4 - Windows Clustering

File Dynamics supports clustering of Windows Server through Proxy Agents. Configuring a
cluster to be managed through a Proxy Agent is similar to configuring an individual server to
be managed by a Proxy Agent. In particular, the Proxy Rights group must be granted
membership in the built-in Administrators group and it must also be granted all of the LSA
rights and privileges that are granted at each cluster node. When this is done, the folder share
permissions that are required must be granted to the Proxy Rights group for all shares that will
be managed by File Dynamics.
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Appendix A - NAS Device Considerations
A.5 - NetApp Filer

For a NetApp Filer device, the configuration is very simple because the device does not fully
emulate

a Windows Server at the operating system level.

1. Use the NetApp Filer administration utility to join the NAS device to a domain where File
Reporter can report.

2. Grant the proxy rights group membership in the NAS device’s built-in Administrators
group.

3. Grant the proxy rights group the folder share permissions that are required to access
the storage.

There are no LSA privileges to grant on a NetApp Filer NAS device.

A.6 - PowerScale OneFS

Perform the following steps to integrate a PowerScale OneFS device (formerly EMC Isilon).
You can use these same steps to see if other NAS devices integrate with File Reporter.

1. Rebuild the storage resources and verify that the NAS device is displayed on the list.

2. Perform any needed steps for giving the proxy rights group access to the desired
shares and folders on the NAS device.

A.7 - Other NAS Devices

Perform the following steps to see if other NAS devices integrate with File Reporter.

1. Inthe associated Computer object in Active Directory, add the following text
somewhere in the description attribute for that object:

***SRGenericNASDevice***
2. Rebuild the storage resources and verify that the NAS device is displayed on the list.

3. Perform any needed steps for giving the proxy rights group access to the desired
shares and folders on the NAS device.
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Appendix B - Distributed File System (DFS)

This section provides guidance for configuring DFS namespaces to work with File Dynamics.

IMPORTANT: File Dynamics only supports domain-based DFS namespaces.
H DFS in standalone mode is not supported.

B.1 - Configuring DFS Folders

File Dynamics requires definite paths in its policies. Because namespaces can provide
multiple targets for DFS links and thereby introduce ambiguity, a DFS namespace must be
configured with one of the following three options linked below.

B.2 - Providing Only One Target Per DFS Link

The simplest way to guarantee that File Dynamics has unambiguous DFS paths is to give
each DFS link a single target.

In the following graphic, there is just one target path and it is enabled.

One Target Path

-?5 DFS Management

- O X
-?‘: File Action View Window Help - &8 %
LK ANl
o LFS Management IR [ ctions
N %g?&?z:;.mgwubuc Folder Targets | Replication flome -
wv ] Atlanta 1 entries Add Folder Target...
N & \\;;%ct'-a':’:reg\shares Typi | Referral Status | Site : | Path 4 Rename Folder...
y @ Replication = Enabled Def autt-First-Site-Name “are-m1.sp.cctec.org\Sh... Move Folder...
Replicate Folder...
View [3
New Window from Here
‘g Cut
x Delete
@ Refresh
Properties
H Help
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B.3 - Disabling All But One Target Per DFS Link

If a DFS namespace is used for high availability, such as ensuring that users can access a
replicated copy of their data, it might be appropriate to create multiple targets in a DFS link and
disable all but one. If the enabled link target becomes unavailable, an administrator can
disable the downed target and enable a replication target. As long as only one target is
enabled for a given DFS link, File Dynamics can successfully provision and manage storage
through the DFS path.

In the following graphic, there are multiple target paths, but only one is enabled.

Multiple Target Paths with One Enabled

17 DFS Management - O X
i File Action View Window Help -8 %

e | nm HE

v ;j MNamespaces

— Home 3
v o \isp.cctec.org\Public Folder Targets | Replication
w [ Atlanta 2 entries Add Folder Target...
—
. ElHome Type | Referral Status | site | Path 4 Rename Folder...
» & \\sp.cctec.orgishares -
= Enabled Def ault-First-Site-Name “ars-am1.sp.cctec.orghSh... Move Folder...
> % Replication =
&= Disabled Default-First-Site-MName “hsrs-md sp cotec.orgsha. .. Replicate Folder...
View »
New Window from Here
géj Cut
x Delete
|4 Refresh
Properties
Help

B.4 - Enabling Multiple Target Paths

File Dynamics can parse the description field on a DFS folder to determine which of several
enabled targets is the primary, unambiguous target. This allows File Dynamics to manage
namespaces with multiple enabled targets in a DFS link.

To do this, the description for the DFS link must enclose the complete UNC path of the path
File Dynamics should use in double curly braces. For example, {{\\Server\Share\ Path}}.
This must be identical to the UNC path in the target link; it cannot be a subdirectory.

In the graphic below, there are two target paths enabled.
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The Home Properties dialog box is accessed by double-clicking the listing in the DFS
Management console.

Two Target Paths Enabled

oK || canced || Awply

24 DFS Management - >
3_‘: File Action View Window Help - &8 %
S ke A W Nl
v 4 Mamespaces | T e |
— Home -
v 3t \isp.cctec.org\Public Folder Targsts | R |
v [ Atlanta 2 entries Home Properties Add Folder Target...
rm
&\\s%ﬁe:r:re\shares Gonol (Eetiaad e Rename Folder.
: P 19 Move Folder..,
> a Replication == A H
= Disable ‘Eﬁ_‘l ome Replicate Folder...
View >
Folder: |Hcme New Window from Here
Namespace path: |\\5p.cdec.org\Pub\icWIarrta\Home ‘g Cut
x Delete
Description
@ Refresh
Properties
Help
\\srs-m1 -
Open in Explorer...
Disable Folder Target
Properties
x Delete
Help
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Appendix C - File Server Resource Manager

Microsoft File Server Resource Manager (FSRM) is a suite of tools from Microsoft that allows
administrators to better understand, control, and manage the quantity and type of data stored
on their servers. File Dynamics uses File Server Resource Manager to enable quota
management.

You must install FSRM on all servers where File Dynamics will be managing quotas, including
the server that will host the Engine. Even if the Engine host does not contain shares that will
be managed, FSRM is still required because the FSRM COM interfaces must be present for
the Engine to call them remotely on other servers.

C.1 - Installing File Server Resource Manager

Quotas for user and collaborative storage can be managed through File Dynamics on all
versions of Windows Server from 2008 and beyond. You need to install FSRM on every server
or active node that will be hosting user or collaborative quota-managed storage.

These procedures are specific to Windows Server 2022. Procedures vary for each version of
Windows Server.

Launch Server Manager.

Click Add roles and features.

This launches the Add Roles and Features Wizard.
Click Next.

AL nh o=

fE Add Roles and Features Wizard — O X

DESTINATION SERVER

Select installation type srs-m3 sp.actecorg

Select the installation type. You can install roles and features on a running physical computer or virtual

Before You Begin : ype. -
machine, or on an offline virtual hard disk (VHD).

Installation Type

Server Selection (® Role-based or feature-based installation
Configure a single server by adding roles, role services, and features.
Server Roles
) Remote Desktop Services installation
Install required role services for Virtual Desktop Infrastructure (VDI) to create a virtual machine-based

or session-based desktop deployment.

Features

e | -~
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5. Verify that Role-based or feature-based installation is selected and click Next.

Before You Begin

Installation Type

Server Roles

Features

f=, Add Roles and Features Wizard — |
Select destination server e

Select a server or a virtual hard disk on which to install roles and features.

(®) Select a server from the server pool
O Select a virtual hard disk

Server Pool

X

Filter:

Name IP Address Operating System

srs-m3.sp.cctec.org 172.17.3.103,1... Microsoft Windows Server 2019 Standard

1 Computer(s) found

This page shows servers that are running Windows Server 2012 or a newer release of Windows Server,
and that have been added by using the Add Servers command in Server Manager. Offline servers and
newly-added servers from which data collection is still incomplete are not shown.

[ <previous | [ Net> | | instal | [ Cancel

6. Select the server where you are going to install the Engine and click Next.

7. From the list of roles, expand File and Storage Services.
8. Expand File and iSCSI Services.
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9. Select the File Server Resource Manager check box.

10.
11.
12.
13.

Before You Begin To install the following roles, role services, or features on selected server, dlick Install.

Installation Type [] Restart the destination server automatically if required

Server Selection Optional features (such as administration tools) might be displayed on this page because they have
been selected automatically. If you do not want to install these optional features, click Previous to clear

Server Roles their check boxes.

Features

& Add Roles and Features Wizard — O x
Confirm installation selections Sl

File and Storage Services
File and 15CSI Services

File Server Resource Manager

Remote Server Administration Tools
Role Administration Tools
File Services Tools

File Server Resource Manager Tools

Export configuration settings
Specify an alternate source path

< Previous | | Next » | | Install | | Cancel

Click Add Features.
Click Next.

Click Next.

Click Install.
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Appendix D - Active Directory Schema
Extensions

File Dynamics extends the Active Directory schema by adding new attributes and classes.

D.1 - Attributes

The following are new attributes added to the Active Directory schema.

D.1.1 - ccx-FSFAuxiliaryStorage
A list of one or more paths pointing to managed auxiliary storage associated with this object.

ccx-FSFAuxiliaryStorage Specification

Active Directory Attribute Property Value

Name
LDAP Display Name

Admin Display Name
Admin Description

ASN.11D

Syntax

Sized - Lower Limit
Sized - Upper Limit
Single Valued

Schema ID GUID
Search Flags

System Flags

Link ID

Attribute Security GUID

Partial Attribute Set Member

ccx-FSFAuxiliaryStorage
ccx-FSFAuxiliaryStorage
ccx-FSF-Auxiliary-Storage

List of one or more paths pointing to managed
auxiliary storage associated with this object

1.3.6.1.4.1.35052.1.1.100.1.1

ADSTYPE_CASE_IGNORE_STRING

False

c4bacb95-075e-11df-bcab-eee40b817f62

cd55682f-3987-446d-a18e-cfd8d53b95f2

False
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D.1.2 - ccx-FSFManagedPath

The managed path attribute for objects (such as groups and containers) that do not inherently
have a home folder attribute.

ccx-FSFManagedPath Specification

Active Directory Attribute Property Value

Name ccx-FSFManagedPath

LDAP Display Name ccx-FSFManagedPath

Admin Display Name ccx-FSFManagedPath

Admin Description Managed path attribute for collaborative objects
ASN.11D 1.3.6.1.4.1.35052.1.1.100.2.1

Syntax ADSTYPE_CASE_IGNORE_STRING

Sized - Lower Limit -

Sized - Upper Limit -

Single Valued True

Schema ID GUID c4bacb96-075e-11df-bcab-eee40b817f62
Search Flags -

System Flags -

Link ID -

Attribute Security GUID cd55682f-3987-446d-a18e-cfd8d53b95f2

Partial Attribute Set Member | False

D.2 - Classes

The following are new attributes added to the Active Directory schema.

D.2.1 - ccx-FSFManagedAttributes

An auxiliary class holding common attributes managed by File Dynamics.

ccx-FSFManagedAttributes Specifications
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Active Directory Class Property Value

Name
LDAP Display Name

Admin Display Name
Description

ASN.11D

Schema ID GUID

Class Type

Parent Class

Default Object Category
Naming Attribute

Mandatory Attributes

Optional Attributes

Possible Superiors

System Possible Superiors

System Flags

Default Security Descriptor

ccx-FSF-Managed-Attributes
ccx-FSF-Managed-Attributes
ccx-FSF-Managed-Attributes

Auxiliary class for managed storage
attributes

1.3.6.1.4.1.35052.1.1.2.1.1
c4bacb93-075e-11df-bcab-eee40b817f62
Auxiliary

top

ccx-FSFManagedAttributes

ccex-FSFAuxiliaryStorage
ccx-FSFManagedPath
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Appendix E - Managed Path Naming Attribute
Specifications

File Dynamics traditionally uses the sAMAccountName attribute values for naming managed
paths for user and group collaborative policies. The Managed Path Naming Attribute (MPNA)
provides more granular control over how managed paths are named for user and group
collaborative policies. Each MPNA Action Block applies to either a User/User Auxiliary policy
type or a Group Collaborative policy type. You can link one or more policies to an appropriate
MPNA Action Block to control which attribute applies for naming the managed path as well as
the Groom and Vault paths.

The MPNA doesn't apply to Dynamic Template Folders that are created as part of the
collaborative template processing. These folders are not managed per se and will continue to
be named based on the sAMAccountName attribute.

As with the sAMAccountName attribute, values should be unique for the attribute you choose
for an MPNA Action Block or policy in order to avoid naming collisions in the file system as you
manage storage with File Dynamics. If you choose an attribute other than sAMAccountName
for a MPNA Action Block or policy, ensure that the process used to populate the attribute’s
values can guarantee unique values for the storage objects being managed by that policy. If
duplicate values occur for the policy, it is possible for related storage management events to
go pending because the target path is not available.

E.1-Rules

The following are rules specific to managed path naming attribute specifications.

E.1.1 - General

The MPNA is configured through an MPNA Action Block. For procedures on creating an
MPNA Action Block, see Creating a Managed Path Naming Attribute Action Block (page 175).

 If you do not configure an explicit MPNA Action Block, a private Action Block applies in
which the sAMAccountName is used for user and group collaborative policies.

¢ An MPNA Action Block can be linked only to policies that match its type. An MPNA
Action Block can be one of the following policy types:

¢ User/User Auxiliary
¢ Group Collaborative

» After you link an MPNA Action Block to one or more policies, you cannot change the
block's policy type without first removing the policy links.

The list of available attributes for an MPNA Action Block depend on its associated policy
type. The User/User Auxiliary policy type displays only attributes for the User object
class. The Group Collaborative policy type displays only attributes for the Group object
class.

e Only single-valued domain-replicated, stored attributes are eligible to be chosen as the
MPNA.
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¢ Multi-valued domain-replicated, stored attributes are not eligible to be chosen as the
MPNA. One example is the Description attribute:

https://msdn.microsoft.com/en-us/library/ms675492(v=vs.85).aspx

¢ Constructed and non-replicated attributes are not eligible to be chosen as the MPNA.
See Attributes:

https://msdn.microsoft.com/en-us/library/ms675155(v=vs.85).aspx

¢ A constructed attribute has values that are computed from normal attributes for
read, or affects the values of normal attributes for writes. For example,
canonicalName and allowedAttributes are non-stored, constructed
attributes.

¢ Non-replicated attributes are stored on each domain controller, but are not
replicated. For example, badPwdCount, Last-Logon, and Last-Logoff are
non-replicated attributes.

¢ MPNA does not support auxiliary classes and their attributes.

E.1.2 - Groom and Vault Paths

A Groom or Vault path follows the MPNA for the policy's managed path. For example, if Policy
1’s MPNA is the emp1oyeeNumber attribute, the attribute's value is used in the managed path
and in the path for a Groom or Vault action.

e Policy 1 Managed Path for user Keith whose employeeNumber attribute is
“123456789”: \\Serverl-dns-name\Sharel\Users\123456789

¢ Policy 1 Vault or Groom Path for user Keith whose employeeNumber attribute is
“123456789”: \\ Server9-dns-name\Vault\Users\123456789

E.2 - Event Processing

The MPNA is retrieved from Active Directory during Create events and when it is time for an
event to calculate the best target path based on the MPNA and other policy leveling and
distribution criteria. If the MPNA has not yet been populated (such as if the MPNA value is
blank or the attribute doesn’t exist), the event will go pending until the MPNA has a value.

The Event Monitor watches for changes to the MPNA. When the attribute’s value changes, a
Rename event is generated.

If you unlink a policy from an MPNA Action Block, and link it to a different MPNA Action Block,
you will need to issue the Enforce Paths Management Action to enforce policy compliance.

E.3 - Management Actions

If you modify the MPNA Action Block to use a new attribute, you must run an Enforce Paths
management action to bring the affected objects’ managed paths into compliance with the

policy.
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Action Block: A feature of File Dynamics that allow the sharing of specific policy options
between multiple policies.

Admin Client: The management interface for File Dynamics.

Associated policy: A policy specifically assigned to a container, group, or user through the
Associations settings in the Policy Editor.

Auxiliary policy: A policy associated with a User Home Folder policy that creates auxiliary
storage for a user (along with the user home folder that is created from a user home folder
policy) when a new user is created in Active Directory.

Auxiliary storage: Home folders associated to a user in addition to the regular network home
folder. Depending on the storage policy, auxiliary storage can be made accessible or
unaccessible to the associated user.

Blocking policy: A policy designed to block other File Dynamics policies from affecting
members of organizational units, members of groups, or even individual users.

Consistency check: This Management Action notifies you of inconsistencies or potential
problems pertaining to user and group storage being managed through File Dynamics. These
potential problems might be missing storage quotas, inconsistent directory attributes, missing
home directories, inconsistent file paths, and more.

Container: A synonym for organizational unit in the File Dynamics documentation.

Content Control policy: Similar to identity-driven file grooming, Target-Driven Content Control
policies remove files according to file type, age, size, last accessed date, and more. From any
file path, you can either vault files to a new location or delete the files altogether.

Collaborative storage: A shared storage area where a group of people in an organization can
collaborate by accessing files. File Dynamics lets you easily create collaborative storage
areas through collaborative storage policies that you can assign to Group objects or to an
organizational unit.

Data Location policy: These policies are the means of copying folders and their contents to a
target parent folder. There is an option to remove the files from the source location after they
have been copied.

Data Owner: An individual assigned by a network administrators to be notified of access
permission changes, perform data recovery, or perform remediation of data located on high-
value targets. Data Owners are normally assigned based on a user’s association with a folder
or share that is classified as a high-value target.

Deferred delete event: The scheduled deletion of a managed path, but has not yet taken
place because the number of days in the Cleanup Storage parameter of the policy has not
been met.

Dynamic Template Processing: Within File Dynamics, the process that creates personal
folders in a collaborative storage folder.
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Effective policy: A policy that is applied by default to a group, user, or subcontainer when no
associated policy is specifically assigned.

High-Value Target: A file system directory deemed to hold valuable information.
Administrators or Data Owners in an organization can classify a folder as a high-value target
based on appropriate evaluation.

Identity-Driven Policies: Automated storage management tasks that are enacted through an
association with Active Directory users and groups.

Managed Path: A location that File Dynamics manages in an automated fashion for any of the
following: Home folder, Profile path, Remote Desktop Services Home folder, Remote Desktop
Services Profile path, Collaborative storage (group and container), and Auxiliary storage.

Management Action: A manual action that allows you to enact a setting from a policy on
existing users.

Nearline: An intermediate storage location that provides fast access to the data, but is nota
generally accessible storage location on the network. Nearline storage inherently provides
some level of security and data integrity.

Personal folder: A user-specific folder in a collaborative storage area.
Phoenix Agent: An agent that assists with Target-Driven policy management actions.

Policy: Rules and settings within File Dynamics that indicate what storage-specific actions to
enact when an event in Active Directory takes place. These actions include creating user
storage when a new user is added to Active Directory, moving storage when a user is moved
from one organizational unit to another, and archiving or deleting storage when a user is
removed.

Policy weight: When a user is a member of multiple groups and each group has a separate
policy, File Dynamics uses this setting to determine which policies to apply. File Dynamics
applies the policy with the largest numerical weight.

Quota Manager: A web browser-based management interface for designated users such as
help desk administrators or support personnel that enables them to adjust quota on user home
folder or collaborative storage areas without needing rights to the file system. Quota Manager
can also provide select storage information such as total number of files and file types in a
home folder.

Security Fencing Policies: Target-Driven policies that let you set limits on how access
permissions can change over time by specifying containers, groups, or users that can be given
access permissions and others that should never be given access permissions.

Security Lockdown Policies: Target-Driven policies that let you establish the baseline
permissions for a high-value target. When unauthorized access permissions are made, the
new permissions are removed and the baseline permissions are restored.

Security Notification Policies: Policies that allow you to analyze and be notified of the
changes in security permissions for a selected target path. Notifications are sent via email and
specify the added, modified, or removed permissions for users and groups.

Target-Driven Policies:Policies that manage and perform tasks through direct association
with a network share or folder. Target-Driven policies include Data Location policies, Content
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Control policies, Workload policies, Security Notification policies, Security Lockdown policies,
and Security Fencing policies.

Target Path: The path to the network share where managed paths are hosted.

Template: If you want to have subfolders and documents provisioned in a home folder,
auxiliary storage folder, or collaborative storage folder when they are created, you can use an
existing path in the file system as a template.

Work Log: An optional mechanism that maintains a history of File Dynamics events. The Work
Log contains summary records for events that have reached the processed state; in other
words, those for which an effective policy has been calculated and run to completion or have
been aborted by administrative action.

Workload Policy: Policies that provide the ability to import externally-generated files and be
enacted through a Data Owner via the Data Owner Client.
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